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Foreword

This book is written by programmers for programmers. Although
technical books are usually difficult to understand and very practical,
this book is different. Amiga Advanced System Programmers
Guide is similiar to working with the Abacus book Amiga C for
Advanced Programmers. We have tried to write a book that helps
the programmer with programming but doesn't contain too much
theory. Our goal was to provide information about large subjects with
many example programs.

We wrote this book with more information than any other book on this
subject. This book contains complete information about the parameter
statements in programs through the CLI and the Workbench, about all
of the devices of the Amiga, complete with example programs, about
the IFF format from Electronic Arts, and about the basic structures of
the Amiga operating system.

Bruno Jennrich spent three months working with all of the devices and
thoroughly documented them so that anyone can begin to use them.

Wolf-Gideon Bleek concentrated on the parameter transfer and collected
information on programming style. So, you as a programmer can not
only program, but also develop a good programming style. He also
worked with Intuition and placed all of the information from
Preferences together.

Peter Schulz explained the complicated keymaps and math libraries in
simple terms. This has made calculations, even with complicated
functions, much simpler.

All of the authors contributed to the documentation of all of the
libraries and the IFF format, with each writing about the library and the
format that he knows best.

You should have a complete collection of information when this book
is used in conjunction with a reference book. So this book should
always be next to your computer.

W. Bleek, B. Jcnnri&h, P. Schulz
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1. INTRODUCTION

1.

Introduction

Advanced System Programmer's Guide—an impressive title. The name
Amiga Advanced System Programmer's Guide tells you exactly what
you get: Information about the Amiga operating system, how the
system routines function, which of these functions are executable by
you, and how the hardware works. This book looks at the Amiga
system from an expanded viewpoint.

Chapter 2 of the Amiga Advanced System Programmer's Guide
discusses programming style. This chapter builds a base for good style
in program development. It thoroughly explains the division, organiza—
tion and composition of a program. It describes the anatomy of the
version number, how to call libraries and how to document your
program clearly so that it can be understood by others.

Chapter 3 contains a description of the arguments which appear at the
beginning of a program. This explains how to read values that are
entered in the CLI, as well as arguments entered through the
Workbench. Most commercial Amiga applications use Workbench
access instead of the CLI. This chapter also shows which functions are
read by the . info structures, and shows you how to set the
corresponding routine at the beginning of a program. This chapter also
shows the two ways to start a program: From the CLI and from the
Workbench.

Chapter 4 describes all the Amiga devices available. Devices execute all
data exchanges between external or simulated internal devices, this book
describes device usage in detail. You'll find explanations for each
device's mode and command, as well as demonstration programs. With
the help of this book, you can address the Amiga’s output and input
devices correctly with a minimum of hassle.

Chapter 5 discusses Interchange File Format (IFF), in simple ILBM
format as well as the more complex music and text formats. You'll find
lists and tables for the music and text formats. Chapter 5 concludes
with an explanation of the Anim format from Aegis. This represents a
complex mixture of ILBM data and the Anim format's own chunks.

Chapter 6 comprises the bulk of this Guide. Here you find descriptions
of the Amiga library functions, along with documentation for each
library. This documentation can be used by both assembly language and
C programmers. In addition to general syntax and arguments, each
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Example:

ADVANCED SYSTEM PROGRAMMER'S GUIDE

description includes definitions for C variables, which make it easier for
the beginner to spot source code errors. Cross referencing makes it
possible to quickly find functions dealing with the same subject.

You need information about the function which closes a window, but
you can't remember the function's name. You know that it's part of the
Intuition library, since Intuition controls all windows. You'd take the
following steps:

1. Check the table of contents for the first page of the Intuition
library chapter. This chapter contains a listing of Intuition
functions.

2. Now look in the group of window functions. Here you'll find
CloseWindow () and the number of the page describing the
function.

3. Turn to the page to find that information.

Rule of thumb: Look in the beginning of the library chapter to find
what you need about each function.

Chapter 7 describes the basic structures of the Amiga operating system.
These structures are often short but are still needed by every program.
Do you use keymaps when you check the keyboard? Do you always
have to set Preferences for your program? How is your output formatted
when no Amiga fonts are present? The operating system structures take
care of all of this and more. This information is presented in
demonstration programs.



ABACUS

o

2. GOOD PROGRAMMING STYLE

2.

Good Programming
Style

We live together on this planet under many rules and conventions.
There are conventions of dress, language, and more. Many of these
standards are basic, common sense rules. For example, most states
consider driving through a red light illegal.

Communicating with a computer must be done under certain rules as
well. There are more obvious rules you should follow in programming
(e.g., don't hit the Amiga when the system crashes). However, some
smaller conventions are very valuable to the user and developer alike.

Think about the Amiga's graphic user interface, Intuition. Certain icons
represent certain tools (applications) and projects (files run from
specific tools). Some icon designs have become standards, and it's best
to keep the standard icon design (e.g., AmigaBASIC projects).

This chapter looks at some helpful rules that you can follow in writing
elegant, stylish source code, as well as some hints for better program
development.

2.1

Comments and formatting

Comments in source code plays a special role in the field of
professional programming. Imagine a company that develops and
markets several application programs for the Amiga. After several
months Commodore announces a new improved Amiga operating
system—which is incompatible with all this company's Amiga
applications. Unfortunately, the company's original developer forgot to
place comments in the source code, and he now works for another firm.
This means that revisions to the program will take much longer than
they would have taken with commented code. No one except the
original developer knows where anything is in the program, or how
crucial routines work.

The same thing cén happen to you. Say you develop a large program
and put no comments into the source code. You set the program aside
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Program header

for a few weeks and come back to it later. Without comments you have
no idea of what works when in the program. The only solution is to
analyze the program from the beginning and figure out what it does.

Comment programs carefully, for your own information as well as for
others who might study the program later.

You'll usually find information about the program's name, purpose,
author, last date of revision and other information in the program
header. Look at the following example, which was taken from the
Abacus book Amiga C for Advanced Programmers:

/***************************************

* *
* Program: Window local definition *
* *
* *
* Author: Date: Comments: *
N ecmcemae eccceoeeececee cccoomamomee— *
* Wgb 10/16/1987 first test *
* window *
* *

***************************************/

The header starts with a brief description of the program. This C
program defines a window locally, which means that the data belongs
to one function instead of more than one function. The header also lists
the author's initials and the date when he/she wrote the program. This
program header can be expanded by the author, or by someone who
revised this program for his or her own needs.

The program header is the easiest way to ensure that programmers
know of any changes, improvements or deletions that have been made
to this program. Program headers can contain much more vital
information. Here's another program header, taken from the Abacus
book Amiga Tricks & Tips:

¥ 3k 3 dk % ok % ok kK ok Kk ok ke ko ok ok ok ok ok ok ok ok ok ok ok ke ok ok
1% *

'* Open window through Intuition *

LIE S —— -

*

%

'* Author : Wolf-Gideon Bleek
'* Date : May 22, 1988

'* Greetings: Denis "Angle™

'* Version : 1.1

'* Operating system: V1.2 & V1.3

"k

* % % % % ¥ %

Thkhkkhkhkk kA hkkkk kA kkkkkkkkkkkkkkkkkx
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Here we also find information about the program's version and the
operating system versions. Both values have different meanings. The
operating system version may dictate how the program must be
compiled. The values are important for BASIC programs because the
libraries must be loaded during program execution.

The greeting entry is optional; it can add a personal touch to the code.
If you wish to thank someone for their efforts in helping write a
program, the program header is the place to insert the note of thanks.

The version number of the program should be in the program text so
you can differentiate easily between two similar versions of a program
by looking at the version number. This number should also appear in
the program itself for the same reason. In other words, the version
number should appear twice: Once in the program header, and once in
the program itself so that the user can easily find it.

You should specify the operating system version. This is the only way
error free use can be guaranteed for the user. You can also use this to
recognize if the program uses features that are implemented with the
new version. For example, a program which is compatible with
Kickstart 1.1 cannot support an auto boot from the hard disk since
KickStart 1.1 does not support this feature. On the other hand, a
program will only be compatible with every Amiga if it correctly
accesses the operating system functions.

More about version numbers

Version numbers follow certain conventions in Amiga development. A
version number helps the user and developer quickly recognize the
current version of the program. Most version numbers appear as two
digits, separated from one another by a decimal point:

Version X.Y

The number to the left of the decimal point represents the major
version. This number is a zero if the program is still in the
development phase (e.g., Version 0.1 for an early design). The first
fully functional program version appears as version 1.0.

The Y parameter represents the minor version number. The Y usually
begins at zero (e.g., version 1.0) and goes up to nine (e.g., version
1.9). The .Y parameter can also be notated in tenths or hundredths.
These smaller notations indicate lesser changes to a program such as
minor error corrections.

It is up to the programer to change the version number when updating
the program. The programmer must decide the extent of the version
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number change. For example, imagine that you're developing a
program. You would assign the first testing version a number of 0.1
(no preceding version numbers exist). If you correct existing errors
without adding any new real data, the version numbers can increase
from 0.11 to 0.19 (note the added decimal place). If you add a new
function to a program, the version number could then be changed to
version 0.2,

Let's assume that version 0.7 of your program is completely executable
and needs no more expansion. Then you can change the version number
to 1.0. The Amiga operating system is a good example of version
number changes. Version 1.0 was the first executable version of that
system, but required major revisions because of errors found after its
release. The next version (1.1) contained these changes. Revisions by
the European divisions of Commodore-Amiga resulted in version 1.2.
Version 1.3 contained many more improvements. The version in
development (1.4) includes special graphic chip support.

Version numbers don't usually go beyond the second or third decimal
place. It would be inhuman and impractical to assign the main version
of a program a version number of 1.279. This could result in a program
package stating the following: "This program runs with all operating
system versions of 1.2623 and up, but not with intermediate versions
1.2758 and 1.296." That's why a final version exists—to help users to
differentiate between versions easily.

You can find the current Kickstart and Workbench versions by selecting
the Version item from the Workbench menu. Version 1.2 of Kickstart
displays the number 33.180. This number indicates the library version
in use: 33 is the library version number. Later in this chapter you will
read about how this can affect the libraries. The Workbench uses
version number 33.57, but Kickstart 1.3 increases this version number
to 34.7.

The function header

Function headers list information about the function which follows it.
The information here is different from that contained in the program
header. The function header describes syntax, parameters that are
transferred or returned and variables that are changed by a subroutine.
Here is an example:
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/***********************************i***

Function to erase an already
existing Lexicon structure:
Freelexicon ()

Additions:
- support of entries
- select, if saved

Input parameters:
Lexicon - pointer to best structure

Return parameters:
none

Date: April 3, 1988
Author: Wolf-Gideon Bleek
Greetings: Christian

* % % % % % % % % % % H % % ¥ ¥ ¥ * *
* % % % % % % % % % % % % % % X ¥ ¥ *

**************************t************/

The first lines of text in the function header clearly define the function's
purpose. The third line of text states the C function's name. These
items are most important to the majority of programmers.

The Additions lines prove to be very useful in the development phases
of a function. Changes may be started during a programming session
and not completed at the end of that particular session. These additions
tell the programmer where development left off for the next session.

The input parameters specify any values needed by the function. C,
AmigaBASIC and other languages allow long parameter names. We
recommend that you use names that clearly describe the variable
whenever possible.

The return parameters describe the results of this routine. Functions
often have only one return parameter, if any. If a parameter name is
required, use names that clearly describe the variable.

The example above includes the date of completion, the author's name
and a personal greeting. This can be expanded as needed.
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2.2

Development and multitasking

There are several rules that should be kept in mind when designing your
program to work with a multitasking operating system. These rules
ensure that your program does not conflict with other programs.
Opening and closing communication channels causes the most
problems. This refers to communication with the user, the devices and
the system routines. Management systems regulate these devices—no
direct access takes place.

A communication channel must be opened before communication takes
place. This is similar to a door leading to a room: You can't exchange
information with people in the next room if the door is closed. Once
you open the door, you can communicate with anyone in the adjacent
room. When you close the door, communication ends. '

One rule suggests that you close a door when you don't need to enter a
room. The same goes for the computer: Close all of the data channels
when you no longer need them.

The telephone offers another illustration of communication channels.
When you want to call someone, you pick up the receiver and dial a
number. One of two things happens: Either you make the connection
and the telephone on the other end starts ringing, or you hear a busy
signal. The only option when a busy signal occurs is to hang up the
telephone and dial again. The Amiga also returns a busy signal if it
cannot currently open a library or something similar. One of two
things occurred: Either there was no memory available, or the channel
was non-existent.

Let's look at the processes used for opening and closing libraries,
devices or data channels. We need a routine which opens a library. All
it requires is the library's name and version number. When we try to
open a library, the routine either returns the base address of the library
or a zero (=error). The routine must constantly check for errors, since
the possibility of errors always exists. The following routine performs
this error check:

Library = OpenLibrary("LibName", Version);
IF (Library == Null)
Cancel();

Version specifies the version number that your program needs. You can
find the version number by entering the AmigaDOS Version command
from the CLI. Stating a Version value of zero allows program access to
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all the libraries, even those not normally accessible through command
words. The following line combines the opening and the error check
into one short routine:

IF (!(Library = OpenLibrary("LibName", Version)))
exit (FALSE);

Closing a library is very simple. You must never try to close an
unopened library, otherwise a system crash occurs. The following
checks a pointer which ensures that the library can be closed:

IF (Library) Closelibrary(Library);

The closing procedure becomes much more complicated if a program
must execute multiple file accesses. All of the open libraries must be
closed. We need a routine which can find all open libraries and close the
open libraries only.

Let's look at an example. Your program needs two system libraries, a
window and multiple blocks of memory. The program displays an error
message when you try to open the window. A poor programmer would
simply stop the program at this point, but this creates problems for the
multitasking system. Remember that the two libraries reserved for the
program take up memory. Tasks running at the same time slow down
because of low available memory and active library access.

We can limit memory loss and open access using the Open_A1l1 ()
and Close_All () functions listed in the program below. These
functions open and close the necessary channels as needed. When an
error occurs while opening any area of memory, the program jumps to
the Close_All routine and ends the program. The Close_all
routine knows what is open and what is not. The following
demonstrates how this works:

/*****************************************

* Function: Open Libraries and Window *
* *
* *
* Author: Date: Comments: *
K mm—me——— - *
* Wgb 06/15/1988 also memory *
* *

*****************************************/
Open_All()
{
void *Openlibrary();
struct Window *OpenWindow();

if (!(IntuitionBase = (struct IntuitionBase *)
Openlibrary("intuition.library®", 0L)))
{
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printf (“No Intuition library found!\n");
Close_All();
exit (FALSE) ;
}
if (! (GfxBase = (struct GfxBase ¥*)
OpenlLibrary ("graphics.library", OL)))
{
printf ("No Graphics library found!\n");
Close_All();
exit (FALSE) ;
}
if (! (FirstWindow = (struct Window *)
OpenWindow (4FirstNewWindow)))
{
printf ("Window will not open!\n");
Close_All();
exit (FALSE) ;
}

UndoBuffer = AllocMem(512L, MemoryType);
if (!UndoBuffer)
{
printf ("Problems with Undo buffer!\n"):;
Close_All();
exit (FALSE) ;
}

FileBuffer = AllocMem(30L, MemoryType):;
if (!FileBuffer)
{
printf ("Problems with File buffer!\n");
Close_All();
exit (FALSE);
}
}

/*****************************************

* Function:Close everything that is open*

* *

* *

* Author: Date: Comments: *

N ccmmeme —ecomcmcccomee e e-————--—— *

* Wgb 15.06.1988 Intuition, Window *

* Graphics & Mem *

*****************************************/

Close_All()

{
if (FirstWindow) CloseWindow (FirstWindow) ;
if (IntuitionBase) Closelibrary(IntuitionBase);
if (GfxBase) Closelibrary (GfxBase);
if (UndoBuffer) FreeMem (UndoBuffer, 512L);
if (FileBuffer) FreeMem(FileBuffer, 30L);

}

10
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The Close_All () function fulfills all of the requirements that we
set for ourselves. It can be accessed from any place in the program, and
it closes anything that it knows is open. Anything unopened is
ignored, decreasing the odds of fatal errors.

The use of the functions as listed here is tightly structured. You may
want to move all Open_Al1 () calls to the beginning of the program
to save some program memory.

You could place the Close_Al1l () routine at the end of the Main ()

function, but that would require a got o whenever an error occurs. This
is not highly structured C programming, but it is a legitimate and
practical solution. In addition, placing Close Al1l () ‘after Main ()

saves a few bytes of program memory.

11
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2.3

Register Tabula

Assembly language
programming

Assembly language offers much more freedom in programming than
the C language. Assembly language code can be executed directly,
without the compiler and linker needed by C source codes. Higher level
languages and assembly language must be able to handle certain
services called registers. The Amiga's microprocessor has eight data
registers and seven address registers in addition to the address counter,
the two stack pointers and the status register.

All of these registers can be accessed from a program. However, there
are some rules that you must heed if you want to correctly use the
Amiga's operating system. Each library function assumes that you
know which register is used and which registers remain unused.

rasa ("forbidden registers"):

The first forbidden register is in address register A7. It usually acts as
the stack pointer (SP), and cannot be loaded with its own data. Like
SP, you cannot load the user stack pointer (USP) and the supervisor
stack pointer (SSP) with their own data. Changing these three registers
requires a high level of system knowledge, and even then any changes
to these registers should be avoided. Changing these registers disables
multitasking, which defeats one of the Amiga's biggest features.

Using registers in conjunction with libraries

12

Several factors must be considered when using the library routines in a
program. First and foremost is specifying the base address register.
Calling the library routine places the base address of the library in
register A6. This address could then be passed to another register. The
library routines also use internal variables that are addressed through
this register. Each function assumes that it finds its base address in
register A6. You can also execute a call that always stands at the base
value.

Next, look at the first two address and data registers (A0, Al & DO,
D1). Almost every function uses these registers at some time or
another. The contents of these four registers are neither saved nor
restored. As you program, remember that these registers do not contain
important data throughout the entire program, or even during a longer
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function. These registers work best for small data transfers and
calculations.

The dos.library uses the D2 and D3 registers constantly because of a
constant need for buffer memory. Keep these registers in mind when
accessing the dos.library from a program. In addition, notice that all of
the other registers called by the function are saved.

We wish to comment here about saving of registers. When you write
your own functions in your programs, state in the function header
which registers are saved and which are not saved. This makes it much
easier in later development. Hold to the library conventions of register
listing to avoid confusion.

Save registers while within a function—not before the function call.
Clearly format these register saves, and never try to cross registers.

13
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Accessing system directories

Many programs on the Amiga won't run without system support. This
support comes from data already in the system (fonts, printer drivers,
libraries, etc.). Where do you find the data when you want to use it?

The system directories contain most of the additional files and programs
needed for system support. These directories always exist under one
general name to minimize the time spent by the program searching for
system files.

Let's look at the existing directories. If you enter the Assign
command from the CLI the following list appears (your list may look
slightly different from this one, since our Workbench disk is named
Wgb):

Directorys:

ENV RAM DISK:Env

T RAM DISK:T

FONTS Workbench 1.3 Wgb:fonts
S Workbench 1.3 Wgb:S

L Workbench 1.3 Wgb:L

C Workbench 1.3 Wgb:c
DEVS Workbench 1.3 Wgb:devs
LIBS Workbench 1.3 Wgb:libs
SYS Workbench 1.3 Wgb:

The directories in this list can be addressed under a generally known
name. This general name carries through each directory to the actual
device and its directory.

Here's an example. You've developed a program that sends any text to a
printer. The user can select an alternate Amiga font. The program takes
this font from the Workbench diskette in drive DFQ:. The syntax would
look something like this:

DFO:fonts/name
This command sequence raises some questions:

. The DFO: tells the system to look in the internal disk drive.
What about users who have two disk drives, and place the
Workbench disk in an external drive?

. How can the user tell the program to look on the hard disk for
fonts?
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. The program will look specifically for the fonts directory.
What if the user wants to change the name of the fonts
directory to something else and still have the program access
it?

. All fonts must be on the Workbench disk. What about the
user who wants a font not in the fonts directory?

You can see that this solution is not ideal. The Amiga's operating
system accesses the directory with the desired contents through the
abovementioned name. The Assign command allows you to assign
the fonts directory, but the program will still access the fonts directory,
whatever drive this directory is on.

The developer should know what exists in which directory. The
following list describes the contents of each system directory.

Workbench 1.3 Wgb:fonts:

The fonts directory contains all the available fonts. This directory is
primarily addressed by the diskfont.library. You can add new fonts or
delete existing fonts.

Workbench 1.3 Wghb:s:

The S directory contains script files. Versions of the operating system
up to and including 1.2 contain only the script file named startup-
sequence. Version 1.3 includes a second startup-sequence for the CLI
and the Shell, as well as a demo version of the HardDisk startup
sequence. This directory is useful because the AmigaDOS Execute
command searches this directory for script files if they cannot be found
in the current path. This saves the user some typing, and keeps all of
the script files in one directory. The system searches the S directory
during booting and executes the file named startup-sequence.

Workbench 1.3 Wgb:l:

The L directory contains the handlers for all of the non-resident
libraries. A new library can be included using the
OverlayCodeSegments.

Workbench 1.3 Wgb:c:

The C directory contains all of the CLI commands. As soon as a
command is entered from a Shell or CLI window, the CLI searches this
directory for the command. The command list can be expanded using a

path.

15
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Workbench 1.3 Wgb:devs:

The devs directory contains many devices. Not all of the Amiga's
devices are implemented in the operating system, since some are only
used infrequently. The operating system searches the devs directory after
an OpenDevice () call if the device is not already present in
memory. You can write your own devices and store them here if
desired.

Workbench 1.3 Wgb:libs:

The libs directory contains many libraries. You can write your own
libraries and store them here if desired.

Workbench 1.3 Wgb:

SYS represents the label on the system disk used for booting. The user
can access this disk by entering SYS: instead of the drive specifier.
This is especially useful when you must change your Workbench disk
from drive DF0 to another drive. When you enter SYS: from the CLI
or Shell, the Amiga automaically changes Workbench disk access.

Many applications access the T directory, which is used for storing
backup and temporary files. Version 1.3 of the operating system
renames the device in T: so that all of the advantages that we have
learned about can be used. When developing a program never place this
directory in the RAM disk. Even though access is faster in a RAM
disk, all of the information is lost after a reset.
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2.5

Menus

Shortcuts

Requesters

Intuition

A big factor in program development lies in writing for the end user.
Intuition offers us an alternative to using the Shell and CLI for access.

Menus allow the user to select different items. We're going to look at
the menu display for now, instead of programming menus. No matter
how helpful the menus may be, poor presentation can ruin the menus.
Here are some rules to help you when developing menu routines.

Write out a list of all the menu titles and items you want to include in
the program. The menu line can contain up to ten menu titles, which
appear on the menu line when you press the right mouse key. Choose
menu titles carefully—make sure that these titles clearly explain the
items below the titles.

The menu titles should be placed starting with the most important (or
most used) title farthest to the left. The titles should decrease in
importance from left to right. Most often the left menu title is the File
menu title.

Include keyboard shortcuts for frequently used menu items (e.g.,
<Amiga><s> for Save from the File menu). Remember that the Amiga
is case sensitive (i.e., <Amiga><s> and <Amiga><S> can represent
two separate shortcuts). Special characters are also allowed.

Menu items should be placed in the most logical order possible. For
example, a File menu should display its New, Load and Save items
first, followed by items for file deletion and other file maintenance.

If more than one option is available for an item (e.g., Save and Save
As), a submenu or requester can be added. For example, if the program
offers a choice of formats in which the data can be saved (ASCII, IFF,
protected format), you can add a submenu listing the ASCII, IFF and
PROTECTED items to the Save item. This eliminates the need for a
requester and saves you some programming time.

Display a requester as a last warning to the user that something
important is about to happen (e.g., deleting a file).

Requesters are smaller windows which request information of
confirmation from the user. Requesters can contain gadgets displaying
words such as YES, OK and CANCEL, or string gadgets into which
the user can type text.

17
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Sketch out the way you want the requester to appear. The requester
must appear organized and clear. For example, a requester appearing to
confirm execution of an important function (e.g., deleting a file) should
contain at least two gadgets to allow positive or negative feedback from
the user. A simple YES and NO gadget will serve this purpose, or even
OK and CANCEL.

Include a gadget for alternate selection in a requester. For the
abovementioned requester used to confirm file deletion, you could have
a YES gadget, a NO gadget and even a BACKUP ONLY gadget to
allow the user to delete only the backup copy of the file.

Some gadgets let the user select a gadget from the keyboard instead of
the mouse. The keyboard is not supported from Intuition like the
menus. Intuition handles the keyboard as a gadget specifically assigned
to one of the gadgets in the requester.For example, BeckerText from
Abacus surrounds this gadget with a bold red border. When the user
presses the <Return> key while in an active requester, the reading
routine reads the <Return> key as the specified gadget.

Choose this keyboard actuated gadget carefully (e.g., do not make the
YES gadget of a Delete file requester accessible from the keyboard).
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Getting user
data

Data Transfer

Sometimes user interaction with a program begins before the program
even runs. This early interaction involves the entry of arguments
(parameters), which may not take effect immediately. For example, if
you enter the following from the CLI, the text editor ED loads into
memory, then a file loads into ED and appears on the screen:

ed filename

This same process can be used from the Workbench. You can move the
mouse pointer onto the icon of a text file created by a word processor
(e.g., BeckerText) and double-click on the text file icon. The word
processor loads first (assuming it is readily available), then the
operating system loads the selected file into the word processor.

The programmer can use these two methods to get data from the user.
Some programs cannot operate without additional arguments. Many
Shell and CLI commands require arguments to operate correctly.

We've just seen how some programs require certain data to execute
correctly. This chapter views the transfer of data from two sources.
First we'll examine how the CLI accepts arguments from the user when
invoking a command. C programming for arguments is very simple,
thanks to the way the C compiler processes data. Then we'll see how
data is transferred by the Workbench.

19
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CLI arguments

Many CLI commands require additional arguments. The syntax can
look something like this:

cli_command argument

The invoked CLI command reads and confirms the arguments, then
executes the command based on these arguments if possible.

The main () function of the C language has two arguments that are
seldom used but are very helpful. The first argument specifies the
number of arguments needed. The second argument represents a pointer
to a string array into which all of the arguments are placed. The
following routine reads the input line, from which we can read the
individual entries.

/****************************************

* *
* Subroutine: Read the input line *
* *
* Inputsub.c *
* Author: Date: Comments: *
* *
* Wgb July 1988 Aztec Routine *
; .

KAKKKKKKKKKK KA KKK AR KK KR KA Ak ARk K KA KKK Kk Kk /

#include <libraries/dosextens.h>
extern int _argc, _arg_len;
extern char **_argv, * arg lin;
_cli_parse(pp, alen, aptr)
struct Process *pp;

long alen;

register char *aptr;

{

register char *cp; /* Character Pointer */
register struct CommandLineInterface *cli;
register int c; /* Characters at Pointer Position */

void * AllocMem();

cli= (struct CommandLineInterface *) ((long)pp->pr CLI << 2);
cp = (char *)((long)cli->cli_CommandName << 2);

_arg len = cp[0]+alen+2; /* Length + PrgName + Null-Bytes */
if ((_arg_lin = _AllocMem((long)_arg len, OL)) == 0)

return;
strnepy (_arg_lin, cp+l, cp[0]); /* Program name */
strcpy (_arg lin+cp(0], ™ "); /* spaces */
strncat (_arg lin, aptr, (int)alen); /* Parameter */

for (_argc=0,aptr=cp=_arg_lin;; argc++)
{
while ((c=*cp) == ' "' || ¢ == "\t || ¢ = "\f' ||
¢ =="\r' || ¢ == "\n')
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cpt+;
if (*ep < ' ')
break;
if (*Cp = lnl)
{
cpt+;
while (c = *cp++)
{
*aptr++ = ¢;
if (c == 1u1)
{
if (*cp == '"1)
cptt;
else
{
aptr[-1l] = 0;
break;
}
}
}
}
else
{
while((c=*cp++) && c != "' ' && c != '\t' && c!= "\f' &&
c !='"\r' && c != '\n')
*aptr++ = ¢;
*aptr++ = 0;
}
if (¢ = 0)
-=cp;
}
*aptr = 0;
if((_argv= _AllocMem((long) (_argc+l) *sizeof (*_argv),OL))== 0)
{
_argc = 0;
return;
}
for (c=0,cp=_arg_lin;c<_argc;c++)
{
_argv(e] = cp;
cp += strlen(cp) + 1;
}
_argv(e] = 0;
}

The program takes the length of the input line from the CLI, then
allocates memory for the argument tables. When these are not present,
it means that no arguments were given in the command line. The
program name, spaces and arguments are then copied into the argument
table memory. This serves as the base for the following loop.

The loop checks the entire list for any separator characters (i.e., spaces,
tabs, form feeds, carriage returns and ends of lines). When the loop
finds one of these characters, it determines how the characters are
handled, and whether a command character is found. If one of the
command characters is encountered, it is determined in many
comparisons which characters are handled or if a quotation mark is

21
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encountered. This quotation mark tells the loop to look after the
quotation mark for additional separators.

After this test, the loop treats the character string between the quotes as
if no separating characters are found. Then the program loop places a
null byte after the text to end it. This operation repeats until the entire
text has been checked. Then another memory function allocates new
memory for the pointer tables (more on this later). All of the pointers
to the individual texts are entered in this block of memory.

The last entry in the pointer table is set to zero to make the end
recognizable without number variables. To see how this routine works,
here is a program that displays the number of parameters given as CLI
arguments, then lists all of the values in table form.

/***************************************

* *
* Program: Display CLI arguments *
* *
* DisplayCli.c *
* Author: Date: Comments: *
* *
* Wgb June.1988 only listing *

***************************************/

main(ArgC, ArgV)
int ArgC;
char *ArgvV([];

{

int i;

printf ("Number of arguments: $%d\n", ArgC);

for (i=0; i<ArgC; i++)
printf ("CLIArg %d: >%s<\n", i, ArgV[i]);
}

The main () function handles the ArgC and ArgV arguments. AxrgC
(Argument Counter) represents a counter variable which contains the
total number of assigned arguments. The program name is considered
one of these arguments within the entire input line. This input line is
assigned to a text table. The program name can include a disk path, if
such a path is needed. Program names are included as arguments, even
when a program is started from the Workbench (more on this later).

ArgV (Argument Vector) is the pointer to the text table mentioned
previously. It is handled as a one-dimensional array of char elements
(characters). The routine created from the entries of this table recognizes
spaces between two words as a break between two arguments. There
may be times when a space is required in a text (e.g., file name
instead of £ilename). If you wish to read two words as one
argument, then the desired text must be placed within quotation marks.
For example:
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Wrong: execute file name
Right: execute "file name"

This program is intended to show you a simple application of the
routine. Enter the program and save it under the name
DisplayCLI.C. Compile and link normally according to your
compiler's instruction manual (e.g., Aztec C uses the 32 bit optio).

Let's execute the program a few times to test it out. Enter the CLI and
enter the following (add your own path names as needed):

DisplayCLI

The program displays the following on the screen:

Number of arguments: 1
CLIArg 0: <DisplayCli>

Let's execute the program with some arguments. Enter the following:

DisplayCLI 1. DF0: Hello Wally

The program displays the following on the screen:

Number of arguments: 5
CLIArg 0: <DisplayCLI>
CLIArg <1>.

CLIArg <DF0:>
CLIArg <Hello>
CLIArg <Wally>

S W o
e s ee es

Earlier we discussed adding quotation marks to make multiple words
into one argument. Let's see if the program accepts this type of input.
Enter the following:

DisplayCLI "DFl:1. Test Run"

The program displays the following on the screen:

Number of arguments: 2
CLIArg 0: <DisplayCLI>
CLIArg 1l: <DFl:1. Test Run>

Let's take a closer look at arguments. Programs should always have an
argument template available. An argument template tells the user
which arguments are acceptable to a command. You can display an
argument template from the CLI by entering the command name, a
space, a question mark and the <Return> key.

AmigaDOS has argument templates available for almost all of its
commands. For example, if you wanted to see the argument template

23
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for the dir command, you would enter the following in the CLI
command line:

dir ?<Return>

Our own program should have the ability to test for a question mark. It
should also test for the proper number of arguments. If it detects an
incorrect number of arguments, the program should display an
appropriate error message.

The following program executes this task. We made this the main ()
function of the program. You may wish to follow this style in your

own programming.

/% Je % 3k vk vk k3 3k ok 3k 3k ok ok ok 3k ok ok ok ok ok ok ok ok ok ok ok ok ok k ok

* Program: Read CLI arguments *
* *
* ReadCLI.c *
* Author: Date: Comments: *
* *
* Wgb 06/20/1988 also "?" Option *

****i’************‘k*********************/

#include <exec/types.h>
main(ArgC, ArgV)
int ArgC;
UBYTE *ArgV[];
{

int i;
if (ArgC == 1)
printf("No parameters from the CLI!\n");
else
printf ("$d Parameter, that can be evaluated\n", ArgC-1);
if ((ArgC == 2) && (*ArgV[l] == '?'))
printf("Format: %s [...] [...]\n", ArgVv([0]);

}

The program displays the number of arguments given. If no arguments
were entered, the program displays this fact. The program also checks
for <Space><?>. If the user entered the request for the argument
template, the program displays the argument template on the screen.

The argument template may take up more than one screen line. Our
program reads the first entry in the text table, rather than the program
name itself. This allows the user to rename programs and assign
different paths as needed, thus keeping the program open to change.

Remember that the above program listing shows only a few aspects of
argument template output. You've probably seen programs that react to
too few arguments, too many arguments, or even incorrect arguments.
The single disadvantage of the " ?" function is that the entire program
must be loaded before the argument template can be displayed.
Sometimes the argument template may not appear because of
insufficient memory.
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The .info file

The DisplayCLI program listed above demonstrated a method of
making the CLI easier to use. However, programmers and developers
are the most frequent users of the CLI. The average user accesses
programs through the Workbench. This user interface ensures simple
access for the user who just wants to use the computer with a
minimum of computer literacy.

How can the user enter arguments in an application started from the
Workbench? Let's look at what happens when we start a program from
Workbench. The program receives information from a startup routine
determined by the main () function. This startup routine replaces the
argument table given by text entered in the CLI, while assigning values
from the Workbench. We'll now look more closely at these values.

The first data received is a list of files and locks available to this
program. The files refer to a list of files invoked when you double-click
a program icon. The locks are pointers to the directories, supplying the
program with pure filenames. Look at the following program:

/***************************************
*

* Program: List out WBMessage
*

WBMessage.c

*

* Author: Date: Comments:
* -
*
*
*

Wgb 06/20/1988 only Locks and
File names

* % % % ¥ % ¥ %

*
******t********************************/
#include <exec/types.h>
#include <workbench/startup.h>
#include <stdio.h>
extern struct WBStartup *WBenchMsg;
main()

{

int i;

struct WBArg *Arg;

for (i=0, Arg=WBenchMsg->sm ArgList; i<WBenchMsg->sm NumArgs;
i++, Arg++)
{
printf("WBArg %d: Lock=0Ox%lx Name = $s\n",
i, Arg->wa Lock, Arg->wa Name);

}
print £ ("PRESS <Return> TO EXIT\n");
Delay (5*60L) ;
}
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This program assumes that it was started from the Workbench. Later
you will see an example of a program that can be started either from the
CLI or the Workbench. It displays the message WBenchMsg, which
contains all of the applicable filenames and corresponding locks. These
are listed in table format in the for () loop.

Compile and link the program, then assign it a tool icon. Once you've
done that, we can begin experimenting. Open the Workbench screen and
select the icon of this program. Select the Workbench function Info
item from the Workbench menu. The ToolTypes string gadget
should contain the following:

WINDOW=CON:0/0/600/80/TestWindow

Immediately after starting the program, the startup routine mentioned
automatically opens the window as defined in the Too1Types string
gadget. The short routine listed below performs this task:

/********************************************

* *
* Program: Read ToolTypes in window *
* *
* ReadToolTypes.c *
* Author: Date: Comments: *
* *
* Wgb July 1988 Aztecs Routine *
. .

******t*********************t**********t***/

#include <libraries/dosextens.h>
#include <workbench/workbench.h>
#include <workbench/startup.h>
#include <workbench/icon.h>
void *IconBase = 0;
_wb parse (pp, wbm)
register struct Process *pp;
struct WBStartup *wbm;
{
register char *cp;
register struct DiskObject *dop;
register struct FileHandle *fhp;
register long wind;
void *_OpenLibrary();
long Open();
if ({IconBase = OpenLibrary("icon.library", OL)) == 0)
return;
if ((dop = GetDiskObject (wbm->sm ArgList->wa_Name)) == 0)
goto closeit;
if (cp = FindToolType (dop->do_ToolTypes, "WINDOW"))
{
if (wind = _Open(cp, MODE_OLDFILE))
{
fhp = (struct FileHandle *) (wind << 2);
pp->pr_ConsoleTask = (APTR) fhp->fh Type;
pp—->pr_CIS (BPTR) wind;
pp->pr_COs (BPTR) _Open ("*", MODE OLDFILE);
}
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}
FreeDiskObject (dop) ; ¢
closeit:
Closelibrary (IconBase);
IconBase = 0;

}

This routine tries to open the Icon. library to determine whether a
ToolType WINDOW appears in the program file. Then the .info
structure is accessed by means of GetDiskObject (), and
FindToolType examines the structure. If an entry named WINDOW
is present, the routine attempts to open an output window using the
definition following WINDOW. If this is-successful, the window opens
and the routine informs the structure that execution was successful.

After opening the window, DiskObject releases the library. We
click on the program icon and our program starts. The window appears
in the predefined location and displays an entry from the table. We also
see the directory lock, which contains the program and the program
name.

You can access more than one .info file from the Workbench, just as
you can call multiple programs in the CLI. Click on another icon,
press the <Shift> key and double-click the program's icon: Another
entry appears in the list.

Let's examine another way to do this. Create a Notepad text and copy it
to the disk which also contains WBMessage. Select the Info item
from the Workbench menu. When the Info screen appears, look at the
string gadget labeled Default tool. It should contain the text:

SYS:UCtD:ilities/Notepad

Click on this gadget and delete this text. Enter the following in its
place:

DF0:WBMessage

Click on the Save gadget to exit. Now double-click on the Notepad
text. The window reappears. This time, the Notepad text tried to access
a non-existent Default Tool (i.e., WBMessage). The lock entry displays
no value, and the program lists the name of this tool as it appears in
the Default Tool string gadget. We find the lock and the
corresponding name under the text entry.

We can also determine whether a Tool (an application) was started
directly or through a Project icon. Add the following data to the above

program code:

printf ("WBArg %d: Lock=0x%lx Name = %s\n",
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i, Arg->wa_Lock, Arg->wa_Name);
if ((1 == 0) && (Arg->wa_Lock == 0))
{
printf ("Started without program. This was loaded
afterwards!\n");

}

Compile and link the source, then assign it an icon. Click on the
Notepad text you created in the last example and select the
Duplicate item from the Workbench menu. Press the <Shift>
key and click on both Notepad text icons. Now double-click the
program icon. We get a longer list with more locks and filenames.
What sense does it make to use all of the filenames? Each filename
looks to the data in the .info file. We can read this data, examine it and

even process it.
The GetDiskObject () function, which lies within the
icon.library, reads the data from the .info file. We can set a new

current directory using the lock, then read the .info file:. Look at the
following program code:

/***************************************

* *
* Program: List out ToolTypes *
* *
* ListToolTypes.C *
* Author: Date: Comments: *
* *
* Wgb 06/20/1988 Access to .info *
* file only *
* Compile options *
* cc +L listtooltypes.c *
*

1n listtooltypes.o -1c32 *
***************************************/
#include <exec/types.h>
#include <workbench/workbench.h>
#include <workbench/startup.h>
#include <workbench/icon.h>
#include <stdio.h>
extern struct WBStartup *WBenchMsg;
extern struct IconBase *IconBase;
void *OpenLibrary();
main()
{
int i, J;
char **ToolArray, *Value;
LONG OldDir;
struct DiskObject *Lock;
struct WBArg *Arg;
if (!(IconBase = (struct IconBase *)
OpenLibrary(®"icon.library®, OL)))
{
printf ("Library not received!\n");
exit (FALSE);
}
for (i=0, Arg=WBenchMsg->sm ArgList; i<WBenchMsg->sm NumArgs;
i++, Argt++)
{
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printf("WBArg %d: Lock=0x%lx Name = %s\n",
i, Arg->wa_Lock, Arg->wa_Name);
if ((i == 0) && (Arg->wa_Lock ==0))
{
printf ("Started without program. This was loaded
afterwards!\n");
}
else
{
OldDir = CurrentDir(Arg->wa_Lock);
Lock = GetDiskObject (Arg->wa_Name) ;
if (Lock != NULL)
{
FreeDiskObject (Lock) ;
}
CurrentDir (0ldDir);
}
}
printf ("\nWAIT A MOMENT!\n");
CloseLibrary(IconBase);
Delay (5*60L) ;
}

All this routine does is release the DiskObject and then return to the
current directory. When we first access the text array contained in
ToolTypes, we can see which values were assigned. Now let's
replace the display routine:

ToolArray = Lock->do_ToolTypes;

j=0;
o
{
printf("%d. Entry: %s\n", j, ToolArray([jl):;
J++;
}
while (ToolArray (3] != Null);

Create multiple Too1Types in an .info file for the next test. After
saving, compiling and linking, return to the Workbench. Click on one
of the Notepad texts and select the Info item from the Workbench
menu. Click on the ToolTypes string gadget. ToolTypes are
entered in the following manner:

TYPE = FLAGS

The word TYPE represents a keyword, which certain functions can
access later on. You saw another example above in the form of a
keyword named WINDOW:

WINDOW = CON:0/0/640/80/TestWindow

Keywords can consist of any alphanumeric characters.
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Flags supply specific information about execution and other processes.
The Notepad uses some flags that indicate whether the text uses one or
more fonts (more on this later). When you wish to set more flags,
separate each flag using the <I> character. This character is alternately
known as the Or character.

So far we can read data using the above code. How can we display and
edit this data? First we must see what the current values are in a
program's .info file. Next, we must check for an additional icon that
represents a Tool (application) or Project (data file). Project data takes
precedence over Tool data.

The procedure is as follows. First we read the ToolType. For
example, if we have FILETYPE present, it searches for the known
types that our program also processes. We also compare to see if it is
handled as an ASCII file that can be loaded from the corresponding
routine. If it is not an ASCII file, the program must determine whether
it can process the other format.

The following program examines the FILETYPE and displays a
corresponding message. That is why you must prepare an .info file for
this program, Use the-notepad icon you created in the previous
examples, remember to chage the default tool in the info window. This
.info file has a WINDOW entry. Instead of the text output you can
insert your own program name in the appropriate subroutines, or
supply just the flags with values. This is especially advisable if more
arguments are expected than just the file types.

/***************************************

* D) *
* Program: Evaluate ToolTypes *
* *
* EvalToolTypes.c *
* Author: Date: Comments: *
* - *
* Wgb 06/20/1988 tests FILETYPE *
. ;

***************************************/

#include <exec/types.h>
#include <workbench/workbench.h>
#include <workbench/startup.h>
#include <workbench/icon.h>
#include <stdio.h>
extern struct WBStartup *WBenchMsg;
extern struct IconBase *IconBase;
void *OpenLibrary ();
main()

{

int i, j, Test;

char **ToolArray, *Value;

LONG OldDir;

struct DiskObject *Lock;
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struct WBArg *Arg;
if (! (IconBase = (struct IconBase *)
OpenLibrary(®icon.library®, OL)))

{
printf (“Library not received!\n");
exit (FALSE) ;.

}
for (i=0, Arg=WBenchMsg->sm ArgList; i<WBenchMsg->sm NumArgs;
i++, Arg++)

{
printf ("WBArg $d: Lock=0x%$1x Name = $s\n",
i, Arg->wa_Lock, Arg->wa_Name);
if ((1 == 0) && (Arg->wa_Lock ==0))
{
printf (“Started without program. This was loaded

afterwards!\n");

}
else
{
0ldDir = CurrentDir (Arg->wa_Lock) ;
Lock = GetDiskObject (Arg->wa_Name);
if (Lock != NULL)
{
ToolArray = Lock->do_ToolTypes;
Value = FindToolType (ToolArray, (char *)"FILETYPE");
if (Value)
{
printf ("ToolType FILETYPE with %s present!\n",

Value) ;

Test = MatchToolValue (Value, (char *)"TOOLTEST");
printf ("Test result $d\n", Test);
}
else
{
printf ("ToolType FILETYPE is not present!\n");
}
FreeDiskObject (Lock) ;
}
CurrentDir (01dDir);
}
}
printf ("\nWAIT A MOMENT!\n");
CloseLibrary (IconBase) ;
Delay (5*60L) ;
}

The above program doesn't fulfill the set provisions, since it is only a
short demo. Adding these features to your own programs would make
using the Amiga much simpler for the user. The last example program
makes the connection between CLI checks and .info file evaluations. It
allows the user the possibility to set three flags: a(dd), p(rint) and
i(nsert). This can occur through the CLI with a preceding hyphen (-a,
-p, -i0), or through the .info file (entering ADD, PRINT and INSERT
next to the FLAGS keyword). Here's the listing:
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/t*tt*************i***i*********i***i****

* *
* Program: Setting flags from CLI & WB *
* *
* FLAGS.C *
* Author: Date: Comment sg *
* *
* Wgb 06/20/1988 -a -p -i *
. * FLAGS= *
* ADD|PRINT | INSERT *
* *

***************************************/

#include <exec/types.h>
#include <workbench/workbench.h>
#include <workbench/startup.h>
#include <workbench/icon.h>
#include <stdio.h>
extern struct WBStartup *WBenchMsg;
extern struct IconBase *IconBase;
void *OpenLibrary();
main(ArgC, ArgVv)
int ArgC;
UBYTE *Argv(];
{
int i, 3;
int TestA = 0, TestP = 0, Testl = 0;
char **ToolArray, *Value;
LONG OldDir;
struct DiskObject *Lock;

struct WBArg *Arg;
/**********************************

* *
* Routine: CLI Reader *
* *
* *
* Author: Date: Comments: *
* *
* Wgb 06/20/1988 -a -p -i *
* *
**********************************/

if (ArgC > 0)

{
for (i=0; i<ArgC; i++)
{

if (*ArgV[i] == (UBYTE)'-')

{
if (*(ArgV[i]+1l) == 'a') TestA
if (*(ArgV[i]+l) == 'p') TestP
if (*(ArgV[i]+l) == 'i') Testl
}

[
EER

o wo we

else
/**********************************t*****
*

Program section: WB Reader

* % % %
* % % % %

Author: Date: Comments:
* *

* Wgb 06/20/1988 ADD|PRINT|INSERT *

***********************************t****/
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{
if (! (IconBase = (struct IconBase *)
OpenLibrary (“"icon.library®, OL)))

{ .
printf(*Library not received!\n");
exit (FALSE);

}
for (i=0, Arg=WBenchMsg->sm ArgList; i<WBenchMsg-
>sm_NumArgs;
i++, Arg++)

{
printf ("WBArg %d: Lock=0Ox%lx Name = $s\n",
i, Arg->wa_Lock, Arg->wa_Name);
if ((1i == 0) && (Arg->wa Lock ==0))
{
printf("Started without program. This was loaded
later!\n");
}
else
{
OldDir = CurrentDir (Arg->wa_Lock) ;
Lock = GetDiskObject (Arg->wa_Name) ;
if (Lock != NULL)
{
ToolArray = Lock->do_ToolTypes;
Value = FindToolType (ToolArray, "“FLAGS");
if (value)
{
TestA = MatchToolValue(Value, ™“ADD");
TestP = MatchToolValue (Value, "PRINT");
TestI = MatchToolValue(Value, "INSERT");
}
else
{
printf ("ToolType FLAGS is not present!\n");
}
FreeDiskObject (Lock) ;
}
CurrentDir (01dDir) ;
}

}

printf ("\nWAIT A MOMENT!\n");

CloseLibrary(IconBase);

/* Delay (5*60L); */

}
if (TestA) printf("ADD flag set!\n");
if (TestP) printf(“PRINT flag set!\n");
if (TestI) printf("INSERT flag set!\n");
Delay (5*60L) ;
}

The program is composed of two main sections. The first section
checks to see if arguments were entered from the CLI If this is the
case, these arguments are tested for the three relevant types. The flags
are set correspondingly. These flags control output once the program
ends.
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Two factors to remember: First, the program doesn't test for
unsupported flags. It simply displays an error message. In addition, we
chose not to include an argument template as described earlier in this
section. You can probably add these features later.

You can also assign values to a flag as well as assigning a flag itself.
The format for this looks like the following:

Flags -w=20

This check also represents no problem if you use the atoi ()
function, which transforms the ASCII value "20" into the integer value
20. The second large section of the program executes when the program
was started from the Workbench instead of the CLI. This routine
examines ToolTypes and sets the corresponding flags. This check is
incomplete, so it searches through only those ToolTypes affecting
our flags. Other arrangements can be added here.

Here are some tables and rules for the .info files to conclude this

chapter.

Sequence of Workbench messages:

1. Program info
2. First data file clicked on
3. Second data file clicked on

There is no info for a program if this is not clicked! That can be found
out if the lock = 0.

Sequence of ToolTypes:

34

1. The ToolTypes are supplied in the abovementioned
succession as blocks.

2. Individual blocks are transmitted in the same order as the
entries in INFO.

3. DefaultTool of the first file clicked on is always loaded

after the file; all others are ignored.
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Name Example Meaning
FILETYPE notepad Notepad text
FONT topaz.8 Global font
WINDOW 0,0,50,50  Window coordinates
FLAGS NOGLOBAL Set flags

)
Name Meaning
NOGLOBAL Disables global font function
GLOBAL Enables global font function
NOWRAP Disables word wrap
WRAP Enables word wrap
NOFONTS No font table loaded <
FORMFEED Enables form feed
DRAFT Enables normal printing
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4,

Devices

You've probably heard the word device used by other Amiga
programmers. Some of the source codes in this book access devices.
This chapter will help you understand the purpose and practical
application of devices.

4.1

What are devices?

Devices are actually nothing more than libraries containing additional
information that pertains to device drivers. These drivers can control
internal devices (e.g., disk drives, keyboard and game ports) and external
devices (e.g., printers and modems). Devices can be opened like
libraries. Here are the Exec functions used to call libraries and devices:

Libraries: OpenLibrary ()
Devices: OpenDevice ()

Libraries vs. devices

There is another major difference between devices and libraries. When
opening a library, OpenLibrary () returns the address of a
completely initialized and ready-to-enter library. OpenDevice () also
reports eventual errors to the programmer. That is why
OpenDevice () needs pre-initialized structures from the user. The
structures can be joined together and completely initialized.

Let's look at a typical OpenDevice () call:

Error = OpenDevice ("trackdisk.device", OL, DiskRequest, OL);
if (Error != 0) Closelt (“"OpenDevice() - Error");

The structure controlling the device (in this case, the internal disk drive)
is an IORequest structure:
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Offsets  struct IORequesk
------- { /* defined in "exec/io.h™ */

0 0x00 struct Message io Message;
20 0x14 struct Device *io Device;
24 0x18 struct Unit *io Unit;

28 Oxlc UWORD io_Command;
30 -Oxle UBYTE io Flags;
31 Oxif BYTE io Error;

32 0x20 } /* 32 == NumBytes of this structure */
: {

IORequest

You don't need to define the IORequest structure in your program
every time you want to use it. This structure is defined in the include
file "exec/io.h". Once called, this structure lies ready for your
declarations. For example:

struct IORequest *DiskRequest;
Device initialization

We already mentioned that the device structures must be initialized
before use, unlike the libraries. This is done using the Exec support
function CreatExtIO (). "Exec support function" means that this
function is not based in a system library. Instead, it can be found in the
linker library for your compiler (c.1ib for Aztec Cor amiga.lib
for Lattice C). Here's a simple example of how CreatExtIO()

works:
/**********************************************************/
/* CreateExtIO() (Exec support) */
/* */
/* Function: Create device block */
/* */
B /* IOReplyPort: MsgPort for WaitIO() etc. *x/
B /* Size: Size of the device block */

/**********************************************************/
struct IORequest *CreatextIO(IOReplyPort, Size)
struct MsgPort *IOReplyPort; b
LONG Size;
{ )
struct IORequest *Request;
/* no IOReplyPort? then leave CreateExtIO() */
if (IOReplyPort == NULL) return(NULL);
/* reserves memory for request */
Request = AllocMem(Size, MEMF PUBLIC | MEMF _CLEAR);
/* no memory? Then leave CreateExtIO() */
if (Request == NULL) return(NULL);
/* report of type MESSAGE */
Request->io Message.mn Node.ln Type = NT MESSAGE;
/* reports are SIZE bytes long */
/* See also DeleteExtIO(). *x/
\ Request->io Message.mn_Length = Size;
y /* give port messages */
Request->io Message.mn ReplyPort = IOReplyPort;
return (Request) ;
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CreateExtIO () allocates memory for a device request structure.
Standard device blocks such as I0StdReq, IORequest, IOAudio
and others fall under the category of device request structures. You can
store and initialize these different device blocks, which help the
communication between computer and device, using CreatExtIO().

Common ground

All of the device request structures or device blocks have one thing in
common: The first element is an IORequest structure. This means
that all of the different device blocks can be handled the same from
CreateExtIO (). The difference first appears after the first few bytes
of the IORequest structure. Let's look at the I0Audio structure
(the audio device block):

struct IOAudio
{
struct IORequest ioa_Request;/* IORequest at the beginning*/

WORD ica_AllocKey;
UBYTE *ioa Data;

ULONG ica_Length;

UWORD ioca Period;

UWORD ioca Volume;

UWORD ioa Cycles;
struct Message ioa WriteMessage;

}

The first element of the IOAudio structure is an IORequest
structure. When you assign CR=CreateExt IO () the starting address
of some I0Audio structure, this address is identical to that of an
IORequest structure. Because all structure element accesses occur
through offsets, they are automatically initialized at the beginning of
the IORequest structure of the I0Audio block. We can initialize it
using the following I/O block to open the device:

struct IOAudio *OwnIOAudio;

OwnIOAudio = (struct IOAudio *)
CreateExtIO (AudioPort, sizeof (struct IOAudio))
if (OwnIOAudio == 0) CloseIt ("CreateExtIO() - Error");

The block is then executed with the help from OpenDevice ():

OpenDevice ("audio, device", 0L, OwnIOAudio, OL));

This sample call shows the purpose of the sizeof parameter for
CreateExtIO(). It gives the size of the I/O blocks to be allocated.

IOReplyPort

The first parameter for CreateExtIO () (IOReplyPort) requires
closer examination. IOReplyPort is nothing more than a message
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port. Message ports are needed for message reports. They act as anchor
points for the devices. They hold reports to the system just as an
anchor holds a ship to the bottom of the sea. These ports must be
initialized before they can be used:

struct MsgPort *AnyOldPort;
AnyOldPort = (struct MsgPort *)
CreatePort (“anyold.port™, 0);
if (anyoldport == 0) Closelt ("CreatePort () - Error");

The routine used for this is called CreatePort (). It is also an
Exec support function:

/********************************************************/

/* CreatePort () (Exec support)*/
/* *x/
/* Function: Create MessagePort */
/* */
/* Name: Name of the MsgPort */
/* Priority: Priority of the port */

/*t**tt******************t**tt*****t*tt******************/

struct MsgPort *CreatePort (Name, Priority)
char *Name;
BYTE Priority; {
struct MsgPort *Port;
BYTE SignalBit;
if ((signalBit = AllocSignal (-1)) == =1) return(NULL);
/* no signal bit can be reserved */
Port = (struct MsgPort ¥*)
AllocMem(sizeof (struct MsgPort), MEMF_ PUBLIC|MEMF CLEAR);
/* memory allocation */
if (Port == NULL)
{
Freesignal (SignalBit);
return(NULL) ;
}

/* no memory */

Port->mp Node.ln Name = Name;
Port->mp Node.ln Pri = Priority;
Port->mp Node.ln Type = NT_MSGPORT;
Port->mp Flags = PA_SIGNAL;
Port->mp SigBit = SignalBit;
Port->mp SigTask = FindTask (01);

/* Initialization */

if (Name != OL) AddPort (Port);

else NewList (& (Port->mp_MsgList));
/* Port in new list */

return (Port);

}

When using the devices the message ports generally have no name, so
the initialization of a message port can be done by using the following
sequence:

struct MsgPort *Port;

Port = (struct MsgPort *)CreatePort (0L, OL);
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CreatePort () throws out the "anchor” on which the device secures

itself through CreateExtIO () and OpenDevice (}:

struct MsgPort *Port;
struct IORequest *Request;
Port = (struct MsgPort *) CreatePort (0L, OL):

Request = (struct IORequest *) CreateExtIO(Port, sizeof (struct

IORequest)) ;
OpenDevice; (DEVICENAME, OL, Request, 0

The three routines listed above give you the power to access any device.
Because the steps for opening a device are always the same, we'll now
list some universal routines for allocating and de-allocating device

blocks, for opening and closing devices:

/**********************************************************/

/* Device-Support Functions *x/
/* (c) Bruno Jennrich */
/* */
/* June 8 1988 */

/**********************************************************/
/**********************************************************/

/* Compile Info: */
/* */
/* */
/* cc Devs_Support */

L T T Ty
#include "exec/types.h"

#include "exec/io.h"

#include "exec/devices.h™

VOID Closelt(); /* Closelt () exists */
/* in your own program */
VOID *CreatePort(); /* Exec-Support */

VOID *CreateExtIO();
VOID DeletePort();

VOID DeleteExtIO():;
/***t****it*t**t********************************************/

/* GetDeviceBlock () */
/* */
/* Function: Device-Block open and initialization */
/* */
/* Input - Parameter: */
/* */
/* Size: Size of the Device-Blocks in bytes */
/* . */
/* Return value: */
/* *x/
/* Initialize Device-Block */

/***********************************************************/
APTR GetDeviceBlock (Size)

ULONG Size;

{
struct MsgPort *Device Port;
APTR Device Request;
/* Becasue this routine should be insertable universally*/
/* no IORequest-Structure is placed, but instead */
/* any structure that through (CASTS) can be */
/* passed to the IORequest-Structure. */

/* Tries to allocate the Device-Port. If this is not */
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/* possible , leave program. (CloseIt()). */

Device Port = (struct MsgPort *) CreatePort (0,0);
if (Device Port == 0) CloseIt ("Couldn4t get DEVICE-PORT !");

/* Tries to allocate Device-Block. If that is not */
" /* possible, give Device-Port back and leave */
/* program. *x/

Device Request = (APTR) CreateExtIO (Device Port, Size);
if (Device Request == 0)
{
DeletePort (Device Port);
CloseIt ("Couldn4t get DEVICE-BLOCK !");
}

/* Give back previously installed Device-Block */
return (Device Request);

/***********************************************************/

/*
/*
/*

FreeDeviceBlock () */
*/
Function: Release Device-Block */

/*
/*
/*
/*

*/

‘Input - Parameter: *x/

*/
IORequest: Release Device-Block */

/***********************************************************/
VOID FreeDeviceBlock (IORequest)

struct IORequest *IORequest;
{

/* If IORequest can be opened, free up */

/* Device-Port. The free up IORequest */

if (IORequest != 0)

{

if (IORequest->io_Message.mn_ReplyPort != 0)
DeletePort (IORequest->io_Message.mn ReplyPort);
DeleteExtIO (IORequest);

}
/***********************************************************/
/* Open_A Device () *x/
/* *x/
/* Function: Open any Device */
/* */
/* Input - Parameter: */
/* Name: Name the Devices (i.e. "audio.device™) */
/* Unit: Device-Unit *x/
/* Device Request: Pointer to block to be initialized */
/* (initialized) Device-Block *x/
/* Flags: Device-Flags */
/* Size: Size of the Device-Blocks */

[REIRKKKKAKAK KKK KK KKK KKK AR KK KA KKK K KA KKK KKKk hkkkkkkkkkkkk /
VOID Open_ A Device (Name, Unit, Device Request, Flags, Size)

char *Name;
ULONG Unit;
APTR *Device Request;
ULONG Flags, Size;
{
UWORD Error; /* Error from OpenDevice() */
/* If Size > 0, allocate Device-Block. */
/* If Size == 0, use initialized device block*/
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/* from user */
if (size != 0) *Device_Request = GetDeviceBlock(Size);

/* Open Device */
Error = OpenDevice (Name, Unit, *Device Request, Flags);
if (Error != 0)
{
printf ("Open-Device Error #%41x\n",Error):;
CloseIt ("Couldndt get DEVICE !"):;
}

/* NOTE !1!! 4Device Request4 is a pointer  */
/* to a pointer ! (**DevReq) */

}

/************************************************************/

/* Close_ A Device x/
/* x/
/* Function: Device-Block free and close Device */
/* *x/
/* Input - Parameter: *x/
* i */
/* IORequest: Released Device-Block *x/

/************************************************************/
VOID Close A Device (IORequest)

struct IORequest *TORequest ;

{

/* If IORequest can be opened, release */
/* Device-Port. Close Device. The release */
/* IORequest. *x/

if (IORequest != 0)
{
if (IORequest->io_Message.mn ReplyPort != 0)
DeletePort (IORequest-)io_Mess%ge.mn_ReplyPort);
if (IORequest->io Device != 0)
CloseDevice (IORequest);
DeleteExtIO (IORequest);
}
}

/***********************************************************/

/* Do_Command () */
/x */
/* Function: Execute command */
/* -——= *x/
/* Input - Parameter: */
/* */
/* DeviceBlock: Device-Block */
/* Cormmand : command *x/

/***********************************************************/

VOID Do_Command (DeviceBlock, Command)
struct IORequest *DeviceBlock;
UWORD Command;
( .
DeviceBlock->io_Command = Command;
DoIO (DeviceBlock) ;
}

Closing a device

You can open devices and then clo?e them again with the help of these
functions. You must close an open device when finished with it, just as
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you must close a library. While programs and libraries may be used at
the same time, this is not possible with devices. The user can only
access one device at a time. For other users to obtain access, the devices
must be closed after they have been used. This happens through the
Exec support routines DeleteExtI0O () and DeletePort (), as
well as the CloseDevice () command:

/***********************************************************/

/* DeletePort () (Exec support)*/
/* Function: Release port *x/
/* */
/* Input parameters: */
/* IOReplyPort: Released port */

/***********************************************************/
VOID DeletePort (IOReplyPort)
struct MsgPort *IOReplyPort;
{
/* if port is nameless, then remove port */
if ((IOReplyPort->mp_Node.ln Name) != OL)
RemPort (IOReplyPort) ;
/* erase type of port */
IOReplyPort->mp Node.ln Type = Oxff;
/* remove port from list */
IOReplyPort->mp_MsgList.lh _Head = (struct Node *)-1;
/* Release memory of port */
FreeMem(IOReplyPort, sizeof (struct MsgPort));
}

DeleteExt IO () looks like the following:

/*********************************************************/

/* DeleteExtIO() (Exec support)*/
/* Function: Release device block */
/* */
/* Input parameters: *x/
/* IORequest: Device block to be released */

/*********************************************************/
DeleteExtIO (IORequest)
struct IORequest *IORequest;
{
/* In case IORequest is not present, leave routine */
/* otherwise freed twice alert arises */

if (IORequest == 0) return(0l);

/* IORequest mutilated so that further */
/* use is impossible */
IORequest->io Message.mn Node.ln Type = Oxff;
IORequest->io_Device (struct Device *)-1;
IORequest->io_Unit (struct Unit *)-1;
/* memory freed up. (memory from FreeMem() */
/* not erased, that is why the above mutilation.) */
FreeMem(IORequest, IORequest->io Message.mn_Length);

}

[ )

In addition to these two Exec support functions, which make it
impossible to re-use IOReplyPorts and IORequest structures, we
have used the command CloseDevice () in our device support
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functions. This ensures that the device can be used from other programs
again.

The device to be closed is informed through CloseDevice () over
the IORequest block, which contains a pointer to the opened device
(IORequest->io_Device). This pointer extracts
CloseDevice () itself and uses it for the closing. When you want to
use the routines from Devs_Support, you make a routine with the
name CloseIt () available for use. This is always called when an
error is encountered while opening a device. You will encounter such
CloseIt () routines in this book, and we want you to have
confidence in the demands that this routine makes:

/*********************** *************’k****************/

/* CloseIt () (User) */
/* Function: display encountered error. */
/* Close everything. x/
/* */
/* Input Parameters: *x/
/* String: Error String */

/*******'k**'k**********'k*******************************/

VOID Closelt (String)
char *String;
{
UWORD Error = 0;
UWORD 1i;
UWORD *dffl180 = (UWORD *)O0xdff180;

if (strlen(String) > 0)
{
for (i=0;i<0xffff;i++) *dff180 = i;

puts(String);
puts (u\n") :
Error = 100;
}
/* free-up routine */
exit (Error); /* leave program */

}

This CloseIt () routine ensures that the screen blinks colorfully
once by specifying the background color registers. Then the error
message appears on the screen, telling you the location at which you
should look for an error. Then all of the opened device libraries, etc.,
are released. You should make sure that everything is released before the
error message is displayed. Most errors occur when closing, so you
don't know the error that most recently occurred.

You should only use CloseIt () as an "emergency exit." You should
never use CloselIt () for convenience as the exit of the program,
which frees all of the structures for you. Rule of thumb: The routine
that allocates memory also releases memory.
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Oopen

Close

Expunge

Extfunc

BeginlIO
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Communicating through devices

You now know how to open a device and how to close it again. Now
let's look at how you can exchange data between a program and a
device.

A device has many similarities to a library. When the device is opened,
IORequest->io_Device provides some routines for establishing
communication between program and device. This device library
contains the following commands and other data:

Command: Offset:
Open -0x06
Close -0x0c
Expunge -0x12
Ext func -0x18
BeginlO -0Oxle
AbortIO -0x24

Open is a routine called from OpenDevice () to control the device
specific installations. The Exec function OpenDevice () offers you
access to this device file. The device's own Open command provides
the necessary steps for the initialization of the addressed device.

Close is called from CloseDevice () to make sure that the device
file closes properly.

If a device must be loaded from disk, the memory allocated for the
device structures is released by Expunge. Open and Close increment
and decrement the allocated amount. The occupied memory is not
completely released by Close. Expunge releases all memory once it
is called from the Exec function RemDevice ().

The Ext func routine is reserved for special tasks (e.g., printer device
DO_SPECIAL). The routines BeginIO and Abort IO are the
routines we are interested in:

BeginIO initiates the data transfer between the program and the
device. After the device block is completely initialized (data pointer
adjusted, command given, etc.), this command is called from
SendIO () as well as from DoIO (). The call looks like this:
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BeginIO:
* Al contains *IORequest *
move.l 20(al), a6 * Device Library after A6 *

Imp -$le(a6) * jump to BeginIO *

The actual BeginIO routine, which is jumped to here through your
offset, looks for every other device. This is also logical, because
different steps, other than the execution when using the
trackdisk.device, are taken for the use of timer devices. BeginIO is
also called from SendI0 () and DoIO () (the command BeginIO ()
is also in the linker library for your compiler [c. 1ib for Aztec C or
amiga. 1ib for Lattice C]). What difference is there between DoIO ()
and SendIO()?

SendIO () is an asynchronous command. That means that the called
program can continue its processing after a device command is sent.
The device command is executed alongside the called program. When
using DoIO (), the program that was called must wait until the
command from the device is completely processed. That is why you
name the command DoIO (). Program execution and the device
command are synchronized.

DoIO() and SendIO() after identical in their handling of a device
command. The ending of the device command is expected by means of
WaitIO() when using DoIO () in conjunction with the MsgPorts.
After construction you can use DoIO () by means of SendIO () and
WaitIOo():

Second DoIO (IORequest)
struct IORequest *IORequest;
{
SendIO(IORequest);
WaitIO(IORequest);
}

WaitIO () can be constructed by means of CheckIO():

Second_WaitIO (IORequest)
struct IORequest *IORequest;
{
while (CheckIO (IORequest)==0);
/* Device command is not ended */
}

When the device command is fully operational, CheckIO () returns
the value 0 in register DO. When the command is processed, the address
of the device block (IO0Request) after CheckIO () passes to register
DO. You now know the functions needed for communication between a
device and the program.

Now for a question: If you would like to send a command to the device
as things currently stand, which variable of the IORequest (or
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I10StdRequest) structure comes into play? We'll discuss details as
we examine each device. For now, here are a few items common to
each device:

. IORequest->io_Command is the variable into which the
device command is stored.

. The device command consists of only one number. This
nuinber branches in SendIO () orDoIO() for some device
specific routines.

Just stating the command does nothing. When you want to include
data, a data pointer and a variable supply the length or number of data
bytes to be transferred. The transfer of data is no longer possible with
the help of the simple IORequest structure. The I0StdReq
structure or a device specific structure (see IOAudio) must be used
instead:

Offsets struct IOStdReq

——————— {/* defined in "exec/io.h" */
/* - IORequest - */

0 0x00 struct Message io Message;
20 0x14 struct Device *io Device;
24 0x18 struct Unit *io Unit;
28 Oxlc UWORD io_Command;

30 Oxle UBYTE io_Flags;
31 Ox1f BYTE io Error;
/* - IOStdReq ~ */
32 0x20 ULONG io_Actual;
36 0x24 ULONG io_Length;
40 O0x28 APTR io_Data;
44 0Ox2c ULONG io_Offset;
48 0x30 }

The data pointer which works in conjunction with a structure has a
similar name. For example, the data pointer of the I0StdReq
structure is called I0StdReq. io_Data, while the data pointer of the
IOAudio structure is called I0Audio.ioa_Data. The number of
data bytes for I0StdReq can be found in IOStdReq.io_Length.
I0StdReq.io_Actual often specifies the number of data bytes
written or read. These variables occur only with more complex device
blocks such as the IORequest block.

Flag and error variables also appear in device blocks. You can control
the execution of a device command with the help of flag variables.
Because almost every device has its own flags, these flags can specify
when it is necessary to use the device. All devices have the
IOF_QUICK flag in common. This IOF_QUICK flag is set if a
command can be processed immediately. The read and write commands
of the trackdisk.device, for example, go in a trackdisk task. The
program that was called must wait for this command to be processed
with assistance from a message port. When reading disk status (e.g.,
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write protect on), a set IOF_QUICK flag may not occur, since this
command is executed without the trackdisk task.

The error variable is of particular importance. If the error variable equals
zero after a device command, everything is running all right. When the
error variable contains a value other than zero, an error occurred. You
should react according to the severity of the error (e.g., a warning to the
user). Each device has its own errors.

The following errors are common to all devices:

Variable Value Meaning

IOERR_OPENFAIL (-1) Device cannot be opened
IOERR_ABORTED (2) Command interrupted by AbortIO ()
IOERR_NOCMD (-3) invalid command
IOERR_BADLENGTH (4) io_Length has an invalid value

Almost every device uses the read (CMD_READ) and write
(CMD_WRITE) commands. The reset command (CMD_RESET), which
places the device in the original condition, is also used by almost every
device.

In addition to these standardized commands, each device has its own
extended commands. These commands capitalize on the individual
device's special abilities. The remaining sections of this chapter
describe these commands and how they affect their devices. In the
following sections we listed the easiest device access routines we know.
You'll find device specific support routines as well as generic device
support routines. These routines need a device block and parameters for
you to access them. This saves you the trouble of assigning values to
structure elements.
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4.3

The parallel device

The parallel device allows easy access to the Amiga's parallel interface.
You can read and write data through the parallel interface.

The parallel device supports the following commands:

CMD_RESET (1) resets device to post-OpenDevice ()
status (including TermArray)

CMD_READ (2 readsdata

CMD_WRITE (3  writesdata

CMD_STOP (6) stops read/write (expects handshake)

CMD_START (7)  restarts read/write

CMD_FLUSH (8  ignores existing read/write commands

The parallel device includes two device specific commands:

PDCMD_SETPARAMS (9) sets parameters
PDCMD_QUERY (10) finds out port status

4.3.1

50

Opening the parallel device

The following code easily opens the parallel device:

struct IOExtPar *ParReq = OL;
#define PAR LEN (ULONG) sizeof (struct IOExtPar)

Open_A Device("parallel.device", OL, ParReq, OL, PAR_LEN);

If another user opens the parallel device, you no longer have access.
Setting the PARB_SHARED flag (32) before you open the device
ensures that multiple users can access the parallel device at one time:

struct IOExtPar *ParReq = OL;
#define PAR LEN (ULONG) sizeof (struct IOExtPar)
VOID *GetDeviceBlock () ;

ParReq = (struct IOExtPar*)GetDeviceBlock (PAR LEN);
ParReq->io_ParFlags = (UBYTE) PARB_ SHARED;
Open_A Device ("parallel.device", OL, ParReq, OL, OL);
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Problems. with Transferring data from multiple programs to the parallel device can

sharing

cause problems. For example, texts sent from two different word
processors may run together through the device.

Now back to the Open_A Device () command. You must assign
this address to a pointer to the device block (& ParRegq—ParReq is
its pointer). The parallel device's device block looks like the following:

Offset Structure

struct IoExtPar
{
0 0x00 struct IOStdReq IOPar;
48 0x30 ULONG io PExtFlags; /* unused */
52 0x32 UBYTE io_status; /* Port Status */
53 0x33 UBYTE io_ParFlags; /* SHARED+EOFMODE */
54 0x34 struct IOPArray io PTermArray;/* Terminates */
62 0x3c } /* defined in "devices/parallel.h" */

4.3.2

Writing parallel device data

All you need to write data to the parallel device is the data to be sent
and the number of data bytes to be sent. Once those items are
established, you can invoke CMD_WRITE:

/***************************************************************

* Parallel Write() (Par_Support) *
* *
* Function: Send data over the parallel interface *
* *
* Input - Parameter: *
* *
* ParReq: Device~Block *
* Data: Date to be sent *
* Len: number of bytes to be sent *

***************************************************************/

VOID Parallel Write (ParReq,Data,Len)

struct IQExtPar *ParReq;

APTR Data;

ULONG Len;

{
ParReq->IOPar.io Data = Data;
ParReq~>IOPar.io length = Len;
Do_Command (ParReq, (UWORD) CMD WRITE);

}

If you give the value -1 for Len (the number of bytes to be written), the
parallel device writes data until it encounters a null byte. The parallel
device writes this null byte and stops writing data.
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Terminators

52

Reading parallel device data

The following routine shows how to read data from the parallel device:

/% Fe %k ek ek sk ok sk sk sk ok sk ok ke ko ek ke ke ok ke ek ok sk ke ok ke ek ok ek ko ek ko ek ek ko

* Parallel Read() (Par_Support) *
* *
* Function: Read data from the parallel interface *
*. *
* Input - Parameter: *
* *
* ParReq: Device-Block *
* Data: Data buffer *
* Len: Number of bytes to be read *

***************************************************************/

VOID Parallel Read (ParReq,Data,Len)
struct IOExtPar *ParReq;

APTR Data;
ULONG Len;
{

ParReg->IOPar.io Data = Data;

ParReq—>IOPar.io:Length = Len;
Do_Command (ParReq, (UWORD) CMD_READ);
}

You can stop the character reading process using a defined character.
The IOPArray can contain the eight terminators:

Offset Structure

struct IOPArray

{
0 0x00 ULONG PTermArrayO;
4 0x04 ULONG PTermArrayl;
8 O0x08 }; /* defined in "devices/parallel.h™ */

The eight terminators are specified as two long words:

Parallel SetParams(ParReq, PARB_EOFMODE, 0x00010101,
0x01010101) ;
/* PARB_EOFMODE = 2 */

When the terminators of the Parallel SetParams () function are
determined by the method listed above, the reading stops after the
routine encounters 0x00 or 0x01 in ASCII code form. When you, as
above, establish less than eight terminators, you should pad the
remaining terminators with the value of the last terminator listed.

The Parallel_SetParams () function looks like the following:

r'e
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/*i**i*i******************************t*************************

* Parallel SetParams () (Par_Support) *
* *
* Function: Change interface parameters *
*, *
* Input - Parameter: *
* ParReq: Device-Block *
* Flags: new Flags *
* *

TermArray0/1: new terminators
***************************************************************/

VOID Paralell SetParams (ParReq,Flags,TermArray0,TermArrayl)

struct IOExtPar *ParReq;

BYTE Flags;

ULONG TermArrayO;

ULONG TermArrayl;

{
ParReq->io_ParFlags = Flags;
ParReqg->io PTermArray.PTermArray0
ParReq->io_PTermArray.PTermArrayl

TermArray0;
TermArrayl;

Do_Command (ParReq, (UWORD) PDCMD_SETPARAMS) ;
}

After Open_A Device () the PTermArray is ignored and only
0x00 is recognized as a terminator. Logically you can only change the
parameter for the parallel device if there is no write or read access. To
change the parameters of such an operation destroys the communication
base between the sender and the receiver, making further
communication impossible. For now, you can only change the
terminators with Parallel SetParams () (PARB_EOFMODE
must be set accordingly).

4.3.4

Reading parallel device status

You can read the status of the interface in io_Status, with the help
of the PDCMP_QUERY command. The bits in io_Status represent
the following:

Bit O IOPTF_PSEL = 1 (Printer Selected)
= 1: OFFLINE
= 0: ONLINE
Bit 1 IOPTF_PAPEROUT = 2
= 1: OK
= 0: PAPER OUT
Bit 2 IOPTF_PBUSY = 4 (Printer busy)
= 1: Printer has nothing to do
= 0: Printer printed
Bit 3 IOPTF_RWDIR = 8 (Direction (Read, Write))
= 1: It was written
= 0: It was read
Bit 4-7 reserved
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Bits 0, 1, and 2 are active low. There is a O in the flag labeled Status.
PaperOut indicates that the flag IOTPF_PAPEROUT is not set
(these flags are defined in devices/parallel.h). You have
already seen that the parallel device is often assigned to an interfaced and
active printer. Basically, the above bits can be used for other devices
such as an EPROM burner. This status byte informs the computer that
the parallel device is not ready to begin processing the data it received.

The following command sequence displays the status of the parallel
device:

Do_Command (ParReq, (UWORD)PDCMD_QUERY) ;
Status = ParReg->io_Status;

4.3.5

54

A parallel device application

The following program sends a short string through the parallel device.
There is usually a printer connected to the parallel port. The program
can tell whether a printer is actually connected to this port, or whether
the printer is switched off. If the printer is off or not connected, the
program displays the message "Printer OFFLINE or not ready” on the
screen. Combine the three routines in the previous section to form the
Par_Support.c module, don't forget to include the exec/types.h,
exec/memory.h, exec/io.h, and devices/printer.h files in Par_Support.c.

% ek e e e ek ke sk sk ke ke sk sk ke ok ok ok ke ok ok ke sk sk sk sk ke ok sk ke Sk e sk ok ke ke ok e ok ok ok ek
*

Par.c (User) *
* (c) Bruno Jennrich *
* August 1988 *

***************************************************************/
/%K e e ek ke Kok sk ke ke ok ok ke ok ok ok ok ok ke ok ok ke ok ok ok ok ok ke ok ok ok gk ok ok ok ke ok e ke sk ok ke ok ok ok ok ok ek

* Compile-Info: *
* cc Par.c *
* 1ln Par.o Par_Support.o Devs Support.o -lc *

***************************************************************/
#include "exec/types.h"

#include "exec/memory.h"

#include "exec/io.h"

#include "devices/parallel.h”

struct IOExtPar *ParReq = 01;

#define PAR_LEN (ULONG) sizeof (struct IOExtPar)

VOID *GetDeviceBlock () ;
/**i***i********************************************************

* Closelt () (User) *
* ' *
* Function: If error, close all *
* *
* Input - Parameter: *
* String: Error-Message *

***************************************************************/
VOID Closelt (String)
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char *String;
{
UWORD 1i;
UWORD *dff180 = (UWORD *)Oxdff180;
UWORD Error = 0;
if (strlen (String) > 01)
{
for (i=0;i<Oxffff;i++) *dff180 = i;
puts (String);
Error = 10;
}
if (ParReq != 0l) Close A Device (ParReq);
exit (Error);

/***************************************************************
* main () (User) *
e %% % % % 3 % % % 3k 3k 3k 9 3 3 3k ok 9k 3k e 3k kK 3 ok 9k 3k e e 3 ok 3k e 3k 9 3 vk e 3k ok ok o ok ok ok o ok ok *****/
main ()
{
BYTE *String = "I write this to the Parallel-Port\015";
ParReq = (struct IOExtPar *)GetDeviceBlock (PAR _LEN);
ParReq->io ParFlags = (UBYTE) PARF_SHARED;
Open_A Device ("parallel.device",0l, &ParReq, 01,01);
Do_Command (ParReq, (UWORD) PDCMD_QUERY) ;
if (((UBYTE)ParReq->io_Status & (UBYTE) IOPTF PSEL) ==
(UBYTE) IOPTF PSEL)
printf ("Printer OFFLINE or not ready !\n");
else
Parallel Write (ParReq, String, (ULONG)strlen (String));
Close A Device (ParReq);
}

The Selected pin (pin 13) of the Centronics port usually indicates
whether or not a printer is connected. If this pin still equals zero after
thirty seconds, the program aborts.

4.3.6

Parallel device error messages

The following errors can be encountered when using the parallel device:

ParErr_DevBusy (1) Parallel device busy. Non-functional
PDCMD_SETPARAMS.

ParErr_BufToBig (2) Read/write buffer too large.

ParErr InvParam (3) This parameter change not implemented
in this version. Only PARB_EOFMODE
currently allowed for terminator changes.

ParErr_LineErr (4) Transfer error.

ParErr_NotOpen (5) Error occurred when opening the device
(e.g., parallel.device not in the devs
drawer of the SYS disk). Error occurred
during OpenDevice ().
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ParErr_PortReset (6) parall.interface reset.
ParErr_InitErr (7) Error occurred during parallel device
initialization (OpenDevice ()).

4.3.7 Centronics port pin arrangement
Pin A500 A1000 A2000
1 STROBE DRDY STROBE
2 Data0 Data0 Data0
3 Datal Datal Datal
4 Data2 Data2 Data2
5 Data3 Data3 Data3
6 Datad Data4 Data4
7 Data5 Data$ Data$
8 Data6 Data6 Data6
9 Data7 Data7 Data7
10 ACK ACK ACK
11 BUSY BUSY BUSY
12 POUT POUT POUT  (Paper Out)
13 SEL SEL SEL (Selected == OnLine)
14 +5v GND +5v
15 NC GND NC
16 RESET GND RESET
17 GND GND GND
18 GND GND GND
19 GND GND GND
20 GND GND GND
21 GND GND GND
22 GND GND GND
23 GND +5v GND
24 GND NC GND
25 GND RESET GND
The Amiga 500 and 2000 require a DB25 male plug for connection to
their parallel ports.
Note: Never use a standard IBM printer cable alone on an Amiga 1000. The

Amiga 1000 uses a reverse standard, and inserting such a cable may
destroy your computer. Purchase a gender changer to reverse the
Centronics pinout to normal (the Amiga 1000 parallel port accepts a
DB2S5 female connector. Connect the gender changer to the Amiga 1000
paraltel port, then connect a standard IBM printer cable to the exposed
end of the gender changer.
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4.4 The serial device

The serial device allows access to the serial interface of the Amiga. A
few device blocks also exist here:

Offset Structure

struct IOExtSer
{

0 0x00 struct IOStdReq IOSer;

48 0x30 ULONG io _CtlChar; /* transfer protocol */
52 0x34 ULONG io_RBuflen; /* Read buffer size */
56 0x38 ULONG io_ExtFlags;/* unused */

60 Ox3c ULONG io_Baud; /* Baud rate */

64 0x40 ULONG io_BrkTime; /* Break time */

68 0x44 struct IOTArray io_TermArray;/* Terminators */

76 Oxdc UBYTE io_Readlen; /* 7 or 8 Bits */

77 Ox4d UBYTE io_Writelen;/* 7 or 8 Bits */

78 Oxde BYTE io_StopBits;/* 0, 1, 2 */

79 Ox4f BYTE io_SerFlags;/* see SetParams */

80 0x50 UWORD io_Status; /* see Query */

82 0x52 } /* defined in "devices/serial.h"™ */

Notice the terminator array (see Section 4.1). This array also consists
of eight bytes or two long words:

Offset Structure

struct IOTArray
{
0 0x00 ULONG TermArrayO;
4 0x04 ULONG TermArrayl;
8 0x08 } /* defined in "devices/serial.h" */

Now we come to the commands which the serial device understands:

MD RESET (1) resets device to post-OpenDevice ()
status (including TermArray)

CMD_READ (2 readsdata

CMD_WRITE (3)  writes data

CMD_STOP (6 stops reading/writing

CMD_START (7 continue read/write operation

CMD_FLUSH (8)  ignores existing read/write commands
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In addition there are three device specific commands:

SDCMD_QUERY ©) finds out port status
SDCMD_BREAK (10) stops transfer
SDCMD_SETPARAMS (11) sets parameters

4.4.1 Opening the serial device
The following code easily opens the serial device:
struct IOExtSer *SerReq = OL;
#define SER LEN (ULONG) sizeof (struct IOExtSer)
h .Open_A__Device("serial.device", 0L, &SerReq, OL, SER_LEN);
If another program already has access to the serial device, you won't be
able to access it at that time. The serial device offers the option of
sharing the device between users:
struct IOExtSer *SerReq = OL;
#define SER LEN (ULONG) sizeof (struct IOExtSer)
VOID *GetDeviceBlock() ;
.“SerReq = (struct IOExtSer *) GetDeviceBlock (SER_LEN);

SerReq->io_SerFlags = (UBYTE) SERB SHARED; Open_A Device

("serial.device”, 0L, &SerReq, OL, OL);
SERB_SHARED has the value 32 (like PARB_SHARED for the parallel
device). Be sure that you declare the GetDeviceBlock () as a
function with a pointer as the return value. Otherwise the result
executes an extension of a long word (ext.1 d0). This interrupts the
serial device.

4.4.2 Reading and writing serial device data
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The standard commands CMD_READ and CMD_WRITE allow you to
read and write through the serial device:

/***************************************************************

* Ser_Support.c *
* August 1988 *
* (¢) Bruno Jennrich *
* Compile-Info: *
* cc Ser_Support.c *
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***************************************************************/
#include "exec/types.h"

#include "exec/io.h"™

#include "devices/serial.h"
/******************************i********************************

* Serial Read() (Ser_Support) *
Function: Read data *

SerReq: Device-Block

Data: Data buffer

Len: Amount of data to be read
***************************************************************/
VOID Serial Read (SerReq,Data,Len)
struct IOExtSer *SerReq;
APTR Data;
ULONG len;
{

*
*.
* Input - Parameter:
*
*
*

* ¥ ¥ ¥ %

SerReq->I0OSer.io Data = Data;
SerReq->IOSer.io_Length = Len;
Do_Command (SerReq, (UWORD) CMD READ) ;

/************f@*************************************************

* Serial Write() (Ser_Support) *
* Function: Write data *
* *
* Input - Parameter: *
* SerReq: Device-Block *
* Data: Data to be written *
* Len: Amount of data to be written *

**************i***i*******i***********************t***********t/

VOID Serial Write (SerReq,Data,Len)

struct IOCExtSer *SerReq;

APTR Data;

ULONG Len;

{
SerReq->IOSer.io Data = Data;
SerReq->IOSer.io_Length = Len;
Do_Command (SerReq, (UIWORD) CMD_WRITE);

}

These two commands require the address of the data to be sent, or the
address of the buffer to which the data should be written, as well as the
number of bytes to be transferred. If you enter a value of -1 for Len,
the serial device writes data until it encounters a null byte. The serial
device writes this null byte and stops writing data.

When reading you must determine whether io_TermArray is used.
The serial device reads data until a character from the TermArray is
received. When the serial device encounters a null byte during reading,
the reading process stops.

The above functions use the DoIO () command for command
execution. It could be as important to work with SendIO (),
CheckIO() and Wait IO () to implement longer transfer time, when
much data is sent.
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4.4.3

Transfer
protocols

Bits

Baud rate
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Serial device parameters

When reading about serial interfaces, you'll see many buzz phrases like
transfer protocol, word length, baud rate and stop bits. The serial device
allows you to set your own serial interface parameters. Let's take a
closer look at these parameters.

Serial transfer reads and writes data one bit at a time. An error occurring
during this transfer is quite possible. In parallel transfer (one byte at a
time instead of one bit at a time), the odds of errors increase eight
times. Serial transfer offers the programmer many different transfer
protocols. These protocols allow a "re-take" of an incorrectly transferred
byte.

The serial device currently supports the XOn/XOff transfer protocol.
XOn/XOfF is the default protocol (after OpenDevice ()) unless the
SERB_XDISABLED bit (bit 7) is set (bit 7 = 128). It is turned off
when SerReq->io_SerFlags = SERB_XDISABLED. Control
characters, which allow control over XOn/XOff transfer, are determined
by SerRegq->_io_CtlChar. Like TermArray, this element
consists of a ULONG which can read the ASCII codes from characters:
Bits 31-24 test the XOn character, and bits 23-16 determine the XOff
character. Bits 15-8 should take the INQ character, while bits 7-0
should be used for the ACK character. The INQ and ACK (handshaking)
are not currently supported by the serial device.

The number of bits per byte that you want to send or receive also
directly affect the transfer protocol. You have the option of sending 7 or
8 bits (SerReq->io_WriteLen) or receiving 7 or 8 bits
(SerReqg->io_ReadLen). A stop bit follows the seventh or eight
bit. This stop bit marks the end of the transferred value. Seven bits are
most often used to send and receive ASCII codes. The ASCII codes here
have the values 0 to Oxf. You can increase the number of stop bits to 2
to further ensure data security when you are sending seven bits.
(SerReq->io_StopBit = (BYTE) 2).

In addition to the transfer protocol we must determine the speed at
which the data should be transferred. The baud rate specifies the number
of bits transferred per second. The Amiga can handle serial transfer from
112 baud (bits per second) to 292,000 baud (bits per second). Insert
your baud rate in SerReq~->io_Baud. The normal minimum setting
is 110 baud; the Amiga can only process a minimum of 112 baud
because of its hardware design.
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When you want to interrupt the data transfer you must send a break
signal. The break signal ensures that all of the connections are set to
zero for a specific amount of time. The time that the connections
should be in the low condition can be specified in microseconds in
SerReq->io_BrkTime. The SDCMD_BREAK command sends the
break signal. You must be sure that the same parameters exist on both
the receiver's side and the sender's side, otherwise the transfer will not
interact.

The Amiga also manages some software based parameters. The serial
device also controls one of the Amiga's own read buffers. Normally this
buffer is 512 bytes. If you need a larger buffer, you can specify the new
buffer length in SerReq->io_RBufLen. You must then execute
SDCMD_ SETPARAMS. First the new buffer is allocated and the data
that was previously stored in the old buffer is lost. All of the
parameters that were changed are first given to the serial device after
SDCMD_SETPARAMS.

It is the same with a change of the terminators. You simply specify the
eight (or less) new terminators that end a read command (Len = -1) and
set the EOFMODE flag in SerReq->io_SerFlag. The terminators
are used after SDCMD_SETPARAMS. You should make sure that the
only parameter change during a read or write operation is the change to
the SERB_XDISABLED parameter. Any other changes abort transfer
with an error.

The serial device includes a set of flags that can control data transfer.
Here are the flags and what they do:

SERB_PARTY ON (1):

‘Checks parity of bits received.

SERB_PARTY ODD (2):

SERB_7WIRE

Checks for odd parity (total of the digits = 1). If this bit is clear, even
parity is used.

(4) :

When set before OpenDevice (), seven-wire communication
becomes active. Normal data transfer uses three lines:

TXD (TRANSMIT DATA)
RXD (RECEIVE DATA)
GND (GROUND)

Seven-wire handshaking adds four wires for a total of seven lines:
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TXD (TRANSMIT DATA)

RXD (RECEIVE DATA)

GND (GROUND)

RTS (REQUEST TO SEND)

CTS (CLEAR TO SEND)

DSR (DATA SET READY)

DCD (DATA CARRIER DETECT).

SERB_QUEUEDBRK (8):

Controls enqueued break commands. The queue is an area of memory
into which serial output is stored and transmitted. The queue operates
on a first in, first out (or FIFO) basis. If the SERB_QUEUEDBRK bit
is set, the system executes the current serial output commands
sequentially, ending with the break command (SDCMD_BREAK). If this
bit is cleared (default state), the break has first priority over any other
serial output waiting in the queue. Once the break command executes,
the interrupted request continues execution, unless the user aborts the
request. This flag may be set with SDCMD_ SETPARAMS.

SERB_RAD_ BOOGIE (16):

SERB_SHARED

SERB_EOFMODE

Controls high-speed mode. If this bit is set, parity check is disabled,
XOn/XOff protocol is disabled, SERB_XDISABLED is set and the
system consistently sends eight-bit data. Some external devices such as
MIDI equipment require high-speed data transfer.

(32):

Controls sharing the serial interface with other users. This flag can
only be set before OpenDevice (),orOpen_A Device ().

(64) :

Controls io_TermArray and IORequest usage. Setting this flag
instructs the serial device to verify characters against io_TermArray,
and instructs the serial device to end IORequest as soon as the device
detects and end of file character. This flag may be set without
SDCMD_SETPARAMS to activate and deactivate the established
terminators.

SERB_XDISABLED (128):
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Disables XOn/XOff protocol. It is enabled after OpenDevice ().

SDCMD_SETPARAMS is consistently used to indicate a parameter
change for the serial device.
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4.4.4

Reading serial interface status

The following command sequence displays the status of the serial
device:

Do_Command (SerReq, (UWORD)SDCMD QUERY);
Status = SerReq->io_Status;

Calling Do_Command (SerReq, (UWORD) SDCMD_QUERY)
retums the status of the serial interface in SerReq~>io_Status:

Bit 0 = 0: BUSY
= 1: no transfer
Bit 1 = 0: Paper out
= 1: Paper is present
Bit 2 = 0: ONLINE
= 1: OFFLINE
Bit 3 = 0: Data Set Ready
= 1: No data
Bit 4 = 0: Clear To Send
= 1: Not clear
Bit 5 = 0: Carrier Detect (carrier signal present)
= 1: No carrier
Bit 6 = 0: Ready To Send
= 1: Not ready
Bit 7 = 0: Data Terminal Ready
= 1: Not ready
Bit 8 = 1: Read Buffer Overrun (Read buffer full)
= 0: No overrun
Bit 9 = 1: Break Sent
= 0: No break
Bit 10 = 1: Break received
= 0: No break
Bit 11 = 1: Transmit XOFFed (xOff sent)
= 0: No XOFF
Bit 12 = 1: Received XOFFed (xOff received)
= 0: No XOFF
Bits 13-15 Unused

In addition to checking the status word, you have the option of
checking the variable SerReq->I0Ser.io_Flags. The most
important conditions are saved here:

IOSERF_OVERRUN (1)  Read buffer overrun

IOSERF WRITEBREAK (2) Breaksent

IOSERF. READBREAK  (4)  Breakreceived

IOSERF XOFFWRITE (8)  XOff written
IOSERF_XOFFREAD (16) XOff received
IOSERF_ACTIVE (32) Read or write access executing
IOSERE'_ABORT (32) AbortIO() executed
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IOSERF_QUEUED (64) Read/write announced but not executed
(another read/write already active)
IOSERF_BUFREAD (128) Data read from the internal buffer

As you see, bit four (32) appears twice. This may or may not be an
error, which makes it hard to determine which bit stands for which
condition. Avoid checking the io_Flags variable, and go directly
over the SDCMD_QUERY and io_Status instead.

4.4.5
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Serial device error messages

Serial device errors occur easily during the initial phases of developing
serial access programs. The following list describes the standard serial
device errors you may encounter:

SerErr_DevBusy (1) Reading or writing in process.
SETPARAMS cannot be executed
SerErr BaudMismatch (2) Baud rates of sender and receiver do

not match

SerErr InvBaud (3) Baud rate less than 112 and more
than 292,000 baud

SerErr BuffErr (4) Internal buffer size is less than 512
bytes or too large (insufficient
memory)

SerErr InvParam (5) Parameter change not allowed

SerErr LineFrr (6) Transfer error (possibly defective
connection)

SerErr NotCpen (7 Cannot find serial.device

SerErr PortReset (8) Interface reset

SerErr ParityErr (9) Parity error in transfer

SerErr InitErr (10) Device initialization error

SerErr TimeErr (11) Errorinio_BrkTime

SerErr BufOverflow (12) Read buffer overflow

SerErr NoDsr (13) No Data Set Ready signal

SerErr NoCTS (14) No Clear To Send signal

SerErr DetectedBreak  (15) Break detected
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4.4.6

Null modem
cable

Serial port pins

Pin A500 A1000 A2000

1 GND GND GND  (Ground)

2 TXD XD XD (Transmit Data)

3 RXD RXD RXD  (Receive Data)

4 RTS RTS RTS (Request To Send)

5 CTS CTS CTS (Clear To Send)

6 DSR DSR DSR (Data Set Ready)

7 GND GND GND  (Ground)

8 DCD DCD DCD  (Data Carrier Detect
[receive carrier signal])

9 +12v NC +12v

10 -12v —— -12v

11 AUDO  — AUDO (Audio Output)

12

13

14 —_— -5v _—

15 _ AUDO ——  (Audio Output)

16 _ AUDI ————  (Audio Input)

17 EB (716 KHz Takt)

18 AUDI INT2* AUDI  (External interrupt [IRQ])

19

20 DTR DTR DTR (Data Terminal Ready)

21 +5v

22 RI RI (Ring Indicator)

23 _— +12v _—

24 _ C2* —— (3.58 MH2z)

25 _— RESB* ~—————  (Buffered reset)

To conclude here is a layout for a null modem cable to connect two
computers over the serial interface, and a short application for using the

null modem cable.

The connector used with Amiga serial port is a DB25 (25-pin)
connector. The Amiga 1000 uses a DB25 male connector, while the
Amiga 500 and 2000 accept a DB25 female connector. This is
important when you go into an electronics store to get parts for the
null modem cable. The RS-232 connection is crossed in the null
modem cable, as shown in the following table:
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Null modem cable connections

Pin Computer A Computer B Pin
1 GND GND 1
2 TXD RXD 3
3 RXD TXD 2
4 RTS DCD 8
5 CTS DCD 8
6 DSR DTR 20

20 DTR DSR 6
8 DCD RTS 4
7 GND GND 7
8 DCD CTS 5

Connect pin 2 of one connector with pin 3 of the other connector, and
SO on.

4.4.7
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A serial device application

The following program transfers data between two computers using the
null modem cable described in Section 4.4.6.

/***************************************************************
*

Ser.c *

* August 1988 *
* (¢) Bruno Jennrich *
* *
*

* Function: Access serial interface
***************************************************************/

/***************************************************************

* Compile-Info: *
* *
* cc Ser *
* 1ln Ser.o Ser_Support.o -Devs_Support.o -lc *

**************;************************************************/

#include "exec/types.h"
#include "exec/io.h"
#include "devices/serial.h”

struct IOExtSer *SerReq;
#define SER LEN (ULONG) sizeof (struct IOExtSer)

/***************************************************************

* CloseIt () (User) *
* *
* Function: In case of error, close everything *
*. *
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* Input - Parameter: *
* *
* String: Error-Message *

***************************************************************l

VOID CloseIt (String)
char *String;
{
UWORD i;
UWORD *dff180 = (UWORD *)Oxdff180;
UWORD Error = 0; :
if (strlen (String) > 01)
{
for (i=0;i<Oxffff;i++) *dff180 = i;
puts (String);
Error = 10;
}
if (SerReq != 0l) Close A Device (SerReq);
exit (Error);
}

/***************************************************************
* main ()
*
*

* Input - Parameter:
*
* When argc > 1 => read data

* When argc == 0 0> write data
*******i*************t*********tit***i**t**i*******************/

* % % % * O *

main (argc,argv)
UWORD argc;
BYTE *argv(];
{
BYTE Buffer([256];

Open_A Device ("serial.device”,0l,&SerReq, 01,SER LEN);

if (arge > 1)
{
Serial Read (SerReq,Buffer,-1);
printf ("%$s \n",Buffer);
}
else
Serial Write (SerReq, "HELLO",-1);
Close A Device (SerReq):;

}

Call the program with any command parameter (e.g., Ser x) on the
receiving Amiga. This Amiga waits until data is received. Remove the
disk from the drive and place it in the sending Amiga. Start the
program without command parameters (enter Ser) and watch the result:
The text sent appears on the receiving computer's screen.
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4.5 The printer device

The printer device allows access to a printer. The printer device has
three different types of access:

Text CMD_WRITE (3) & PRD_RAWWRITE (9)
Command PRD_PRTCOMMAND (10)
Hardcopy PRD_DUMPRPORT (11)

These three task regions of the printer device use three different device
blocks. The printer commands and hardcopy access have their own
special device blocks:

Offset Structure

struct IOPrtCmdReq /* Command Request */
{

0 0x00 struct Message io Message;

20 0x14 struct Device *io Device;

24 0x18 struct Unit  *io Unit;

28 Oxlc UWORD io_Command; /* PRD_PRTCOMMAND */
30 Oxle UBYTE io Flags;

31 Ox1f BYTE io_Error;

32 0x20 UWORD io_PrtCommand; /* printer command */
34 0x22 UBYTE io_Parm0; /* Parameter */

35 0x23 UBYTE io_Parml;

36 0x24 UBYTE io_Parm2;

37 0x25 UBYTE io_Parm3;

38 0x26 } /* defined in "devices/printer.h" */

Offset Structure

struct IODRPReq /* DumpRastPort Request */
{

0 0x00 struct Message io Message;

20 0x14 struct Device *io_Device;

24 0x18 struct Unit *io Unit;

28 Oxlc UWORD io_Command; /* PRD_PRTCOMMAND */
30 Oxle UBYTE io _Flags;

31 Ox1f BYTE io_Error;

32 0x20 struct RastPort *io_RastPort; /* Graphic RastPort*/
36 0x24 struct ColorMap *io ColorMap; /* color table */

40 0x28 ULONG io Modes; /* ViewPort Modes */
44 0x2c UWORD io_SrcX; /* Start point */

46 Ox2e UWORD io_SrcY;

48 0x30 UWORD io_SrcWidth; /* width */

50 0x32 UWORD io_SrcHeight; /* Height */

52 0x34 LONG io DestCols; /* print width */

56 0x38 LONG io_DestRows; /* print height */

60 Ox3c UWORD io_Special; /* Special Flags */

62 Ox3e } /* defined in “devices/printer.h" */
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The following routine allows open access to all three device blocks
through the Normal, DumpRastPort and Command pointers:

struct IODRPReq *PrtPtr = OL; /* Dummy pointer */

struct IOStdReq *Normal;

struct IODRPReq *DumpRastPort;

struct IOPrtCmdReq *Command;

#define PRT_LEN (ULONG) sizeof (struct IODRPReq)/*larger block*/
Open A Device ("printer.device", 0L, &PrtPtr, OL, PRT_LEN};

Normal = (struct IOStdReq *)PrtPtr;
DumpRastPort = (struct IODRPReq *)PrtPtr;
Command = (struct IOPrtCmdReq *)PrtPtr;

4.5.1

Printing escape sequences

You can send your texts to the printer with the PRD_ RAWWRITE
command. The escape sequences are not replaced (see CMD_WRITE).
What you specified as the output string, is also output:

/% % sk gk de sk de ok g ke ok ke ok ok ok e o sk o ok ok ok ok ok ok ok ok o sk ke ok ok ok ok ok ok ok e ok ok keok

Printer RawWrite() (Printer Support)*
*

Function: Display data

Input - Parameter:

PrtReq: Device~Block (Normal)
Data: String to be displayed

Len: Number of characters to be displayed
***************************************************************/

* % % K % % H ¥ %
* % % K % H *

Printer_RawWrite (PrtReq,Data,len)
struct IOStdReq *PrtReq;
APTR Data;
ULONG Len;
{
PrtReq->io_Data = Data;
PrtReq->io_Length = Len;
Do_Command (PrtReq, (UWORD) PRD_RAWWRITE);
}

4.5.2

Amiga printer escape sequences

The Amiga can take a standard set of printer escape sequences and
translate them for most printers, using the available printer drivers. The
following table lists the escape sequences that the Amiga understands;
their command numbers; the standard printer escape sequences; and their

. meanings.
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Printer Escape |Command |Command | Escape Meaning
Sequences name number sequence

aRIS OL ESCc Reset
aRIN 1L ESC#1 Initializing
aIND 2L ESCD Linefeed
aNEL 3L ESCE LF = CR+LF
aRl 41, ESCM Reverse linefeed
aSGRO SL ESC[Om Normal character set
aSGR3 6L ESC[3m Italics on
aSGR23 7L ESC[23m Italics off
aSGR4 8L ESC[4m Underline on
aSGR24 9L ESC[24m Underline off
aSGR1 10L ESC[1m Bold on
aSGR22 11L ESC[22m Bold off
aSFC 12L ESC[30m- Set

ESC[39m foreground color
aSBC 13L ESC[40m- Set

ESC49m background color
aSHORPO 14L ESC[0w Normal type
aSHORP?2 15L ESC[2w Elite on
aSHORP1 16L ESC[1w Elite off
aSHORP3 18L ESC[3w Condensed off
aSHORP6 19L ESC[6w Expanded print on
aSHORPS 20L ESC[5w Expanded print off
aDENG6 21L ESC[6"z Shaded print on
aDENS5 22L ESC[5"z Shaded print off
aDEN4 23L ESC[4"z Double-strike on
aDEN3 4L ESC[3"z Double-strike off
aDEN2 25L ESC[2"z NLQ on
aDEN1 26L ESC[1"z NLOQ off
aSUS2 27L ESC[2v Superscript on
aSuUS1 28L ESC[1v Superscript off
aPLU 32L ESCL Superscript (half step)
aPLD 33L ESCK Subscript (half step)
aFNTO ML ESC(B US character set
aFNT1 35L ESC(R French character set
aFNT2 36L ESC(K German character set
aFNT3 37L ESC(A English character set
aFNT4 38L ESC(E Danish character set 1
aFNT5 39L ESC(H Swedish character set
aFNT6 40L ESC(Y Italian character set
aFNT?7 41L ESC(Z Spanish character set
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Command Command | Escape Meaning
name number sequence
aFNT8 42L ESC({J Japanese character set
aFNT9 43L ESC(6 Norwegian character st
aFNT10 441 ESC(C Danish character set 2
aPROP2 45L ESC[2p Proportional text on
aPROP( 47L ESC[Op Proportional text off
aTSS 48L ESC[n E Proportional spaces=n
aJFY5 49L ESC[5 F Left justification
aJFY7 S0L ESC[7 F Right justification
aJFY6 S1L ESC[6 F Block characters on
aJFY3 S3L ESC[3 F Adjust character width
aJFY1 541 ESC[1 F Centering
aVERP( 55L ESC[0z Line spacing 1/8"
aVERP1 56L ESC[1z Line spacing 1/6"
aSLPP S7L ESC[nt Set page length (n)
aPERF S8L ESC[ng__ Page break (n>0)
aPERF( S9L ESC[0q Page break
aLMS 60L ESC#9 Set left margin
aRMS 61L ESC#0 Set right margin
aTMS 62L ESC#8 Set page header
aBMS 63L ESC#2 Set page footer
aSTBM 64L ESC[Pnlr Set top (n1) and
ESC[Pn2r bottom(n2) margins |
aSLRM 65L ESC[Pnls Set left (n1) and
ESC[Pn2s right (n2) margins
aCAM 66L ESC#3 Clear all margins
aHTS 67L ESCH Horizontal tabs
aVTS 68L ESCJ Vertical tabs
aTBCO 69L ESC[0g Clear horizontal tab
aTBC3 70L ESC[3g Clear all horiz. tabs
aTBC1 71L ESC[1g Clear vertical tab
aTBC4 72L ESC[4g Clear all vertical tabs
aTBCALL 73L ESC#4 Clear all tabs
aTBSALL 74L ESC#5 Set default tabs
aEXTEND 75L ESC[Pn"x Extended font

You can see the advantage of using this table. If someone wants to
write a text that contains underlined superscripts, the word processor
only needs to send the command "ESC[4m" for underline and "ESC[2v"
for superscripts. It's the same, no matter what printer you're using. The
corresponding printer driver contains a similar table that has the printer
specific escape sequences.
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The eighth entry of the sequence in this table is "ESC-1" (Star NL-10).
The printer device replaces "ESC[4m" with "ESC-1" and the following
text is underlined. This functions only when you use the CMD_WRITE
command instead of the PRD_RAWWRITE command:

/***************************************************************

Printer Write() (Printer_ Support)*
*

Function: output data (Convert Escape-Sequences)

Input - Parameter:

PrtReq: Device-Block (Normal)
Data: String to be output

Len: Number of characters to be output
**********i**********i*i**i*t**************************t*******/

* % * % ¥ % * ¥ *
* % % * * * *

Printer Write  (PrtReq,Data,Len)
struct IOStdReq *PrtReq;

APTR Data;
ULONG Len;
{
PrtReq->io__Data = Data;
PrtReq->io_Length = Len;

Do_Command (PrtReq, (UWORD) CMD_WRITE);
}

There is no substitution with the RAWWRITE command.

4.5.3
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Printer commands

You can use these escape sequences as printer commands. When escape
sequences contain only parameters (e.g., setting the left and right
margins), no simple substitution can be made. A routine in the printer
driver processes the irreplaceable escape sequences. This routine can be
accessed directly with the command PRD_PRT COMMAND:

/*******************t*ti***t***tt********t***********t*******i**

Printer_Command () (Printer_Support)*
*

Function: Execute printer command

Input - Parameter:

PrtReq: Device-Block
Command: command

P1-P4: Parameter
******k**t*****t*****t*********t**************i*********t******/

* % % % % X ¥ ¥ *

* % % ¥ ¥ * *

Printer_Command (PrtReq, Command,P0,P1,P2,P3)
struct IOPrtCmdReq *PrtReq;

UWORD Command;

UBYTE PO,P1,P2,P3;
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{
PrtReq->io_PrtCommand = Command;
PrtReq->io_Parm0 = PO;
PrtReq->io Parml = P1;
PrtReg->io Parm2 = P2;
PrtReq->io Parm3 = P3;
Do_Command (PrtReq, (UWORD) PRD_PRTCOMMAND) ;
}
Here is a short example. To establish the left and right margins, you
can call:
Printer_Command (PrtReq, 651, (BYTE)2, (BYTE)78, (BYTE)O,
(BYTE) 0) ;
You can also replace the number 651 with the command name a SLRM.
The Parm0-Parm4 variables specify the printer driver routines.
4.5.4 Hardcopy

DestRows and
DestCols

The PRD_DUMPRPORT command provides the developer with an easy
method of printing a screen to the printer.

There are a few parameters you must provide when accessing
PRD_DUMPPORT:

1) The RastPort which contains the graphic to be printed.

2.) The ColorMap which contains the graphic's colors (this is
especially important when using color printers).

3) The viewPort mode variables so that the printer knows the
graphic's current display mode (HI-RES, LACE, HAM, etc.).

4.) The upper left corner of the area to be printed (SrcX, SrcY).

5.) The height and width of the area to be printed (SxrcHeight,
SrcwWidth). This allows you to print any rectangular section
of the screen (Src = Source = <=> RastPort).

6.) The size of the hardcopy as it should appear on the printer
(DestRows, DestCols) (Dest = Destination <=>
Printer).

7.) The io_Special flag should be set to zero.

The DestRows and DestCols parameters can be set in a number of
ways. Here are some examples.

DestCols>0
DestRows>0
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The above configuration prints a graphic DestRows rows high and
DestCols columns wide.

DestCols=0
DestRows>0

The above configuration prints a graphic as wide as the paper and
DestRows rows high.

DestCols=0
DestRows=0

The above configuration prints a graphic as wide as the paper and as
high as the paper.

DestCols>0
DestRows=0

The above configuration prints a graphic DestCols columns wide,
with the height proportional to the width.

DestCols<0
DestRows>0

The above configuration enlarges or reduces the size of the printed
graphic. The equation for computing this is as follows:

|DestCols|
= enlargement factor
DestRows

For example, if DestCols has a value of -1 and DestRows has a
value of 4, the enlargement/reduction factor is equal to 1/4. This value
only applies to DestCols and DestRows if io_Special is zero.
The following lines describe the individual Special_Flags and
their tasks in the printing process:

SPECIAL_MILCOLS 0x001L  DestCols givenin 1/1000

SPECIAL MILROWS 0x002L  DestRows given in 1/1000

SPECIAL_FULLCOLS 0x004L DestCols set at maximum

SPECIAL FULLROWS 0x008L DestRows set at maximum

SPECIAL FRACCOLS 0x010L  Width = maximum/DestRows

SPECIAL FRACROWS 0x020L Height = maximum/DestRows

SPECIAL_ASPECT 0x080L If set, either height or width
changes to preserve page set up

SPECIAL_DENSITY1 0x100L Print density (1=low; 4=high)

SPECIAL DENSITY2 0x200L

SPECIAL DENSITY3 0x300L

SPECIAL DENSITY4 0x400L

SPECIAL_CENTER 0x040L Center graphic
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The printer driver contains the width and height of the maximum
printable area. You get page setups from these two maxima
(MaximaX/MaximaY), reserved through Special_Aspect.

/t*******'ﬁ****i****i"*****t***'k***************'k***t***********t*

* Printer_Dump () (Printer_Support)*
* *
* Function: Hardcopy *
| —— *
* Input - Parameter: *
* *
* PrtPtr: Device-Block *
* RastPort: RastPort of the graphic to be printed *
* ColorMap: ColorMap contains the actual colors *
* Modes: Display modes *
* SrcX,SrcY: Top left corner of graphic to be printed *
* SrcWidth, bl
* SrcHeight: Width and height of the graphic to be printed *
* DestCols: Number of columns (Printer) *
* DestRows: Number of lines (Printer) *
* Special:  Special-Flags *

KHKK KKK KKK IA KKK KKK * kKKK kA KAk h ARk kAR Ak Ik Kk kA Ak kKA kkkkkkkkkkhkk /

VOID Printer Dump (PrtPtr,RastPort,ColorMap,Modes, SrcX,SrcY,
SrcWidth, SrcHeight,DestCols, DestRows, Special)
struct IODRPReq *PrtPtr;
struct RastPort *RastPort;
struct ColorMap *ColorMap;
ULONG Modes;
UWORD SrcX,SrcY;
UWORD SrcWidth, SrcHeight;
LONG DestCols,DestRows;
UWORD Special;
{
PrtPtr->io_RastPort = RastPort;

PrtPtr->io ColorMap = ColorMap;

PrtPtr->io_Modes = Modes; /* Viewmodes */
PrtPtr->io_SrcX = SrcX; /* Start point */
PrtPtr->io_SrcY = SrcY;

PrtPtr->io_SrcWidth = SrcWidth; /* Width */
PrtPtr->io_SrcHeight = SrcHeight; /* Height */
PrtPtr->io_DestCols = DestCols; /* Print width */
PrtPtr->io _DestRows = DestRows; /* Print height */
PrtPtr->io_Special = Special; /* Special-Flags */

Do_Command (PrtPtr, (UWORD) PRD_DUMPRPORT) ;
}

The following program uses the Dump routine to print a section of the
current window. You must select the section using the mouse.
Combine the previous printer support routines to make the
Printer_Support.c file. Don't forget the include files in the
Printer_suppport.c file.
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/****t******i*********i********i**it****************************

* Prt.c *
* August 1988 *
* (¢) Bruno Jennrich *
* *

*

* Function: Hardcopy of the current Window
*********t***t*****t**'***i*******t**********i*******t****t****/

/***********************t*******t*******t******************t****

* Compile-Info: *
* *
* cc Prt *
* 1n Prt.o Printer_Support.o Devs_Support.o -lc *

************i***t****************;************t****************/

#include "exec/types.h"
#include "exec/io.h"
#include "devices/printer.h"
#include “"intuition/intuitionbase.h"
#include “intuition/intuition.h"
#include “graphics/gfxbase.h"
#include "graphics/view.h"
union PrinterIO
{ /* Printer Blocke */
struct IOStdReq Normal;
struct IODRPReq DumpRastPort;
struct IOPrtCmdReq Command;
I
union PrinterIO PrtReq;
struct IODRPReq *PrtPtr = 01;
struct IOStdReq *Normal;
struct IODRPReq *DumpRastPort;
struct IOPrtCmdReq *Command;

#define PRT_LEN (ULONG) sizeof (struct IODRPReq)

struct IntuitionBase *IntuitionBase = OL;
struct Window *Window = OL;
struct GfxBase *GfxBase = OL;

VOID *OpenLibrary();

/****t**************tt************tt****it**t*t***********t***ﬁ*

* CloseIt () (User) *
*

Function: In case of error close everything

Input-Parameter:

* % % *

*

* % % % %

* String: Error-Message
********************i**************i**it****i******************/
VOID CloselIt (String)
char *String;
{

UWORD i;

UWORD *dff180 = (UWORD *)Oxdff180;

UWORD Error = 0;

if (strlen (String) > 01)
{
for (i=0;i<Oxffff;i++) *dff180 = i;
puts (String);
Error = 10;
}
if (PrtPtr != Q1) Close_A Device (PrtPtr);
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if (IntuitionBase == 0l) CloselLibrary (IntuitionBase);
if (GfxBase == 01) CloseLibrary (GfxBase);
exit (Error);

}

/*****i**i******t******************tti****t*********************

* Mark PrintArea () (User) *
* *
* Function: Choose section for hardcopy *
* *
* Input-Parameter: *
* *
* Window: Address of the window to be printed *
* x1,yl,x2,y2: later contains the upper left and lower *
* *

corner of the area to be printed
**i**************************t*****************i***************/
Mark PrintArea (Window,xl, yl, x2, y2)

struct Window ‘*Window;

ULONG *x1, *yl, *x2, *y2;

{

UBYTE *LeftMouse = (UBYTE *)Oxbfe00l;

ULONG xold, yold;

*x]1 = (ULONG) O;
*yl = (ULONG) 0;
*x2 = (ULONG) O;
*y2 = (ULONG) O0;

SetDrMd (Window->RPort, COMPLEMENT);

while ((*LeftMouse & (UBYTE)Ox40) == (UBYTE)Ox40);

*x1 = (ULONG)Window->MouseX;

*yl = (ULONG)Window->MouseY;

xold = *x1;

yold = *yl;

Move (Window->RPort,*xl,*yl); /* first rectangle */

Draw (Window->RPort, xold, *yl);
Draw (Window->RPort,xold,yold);
Draw (Window->RPort, *x1,yold);
Draw {(Window->RPort, *x1,*yl);

while ((*LeftMouse & (UBYTE)Ox40) == (UBYTE)OxO0)
{

*x2 = (ULONG)Window->MouseX;

*y2 = (ULONG)Window->MouseY;

if ((*x2 != xold) || (*y2 !'= yold))

{

Move (Window->RPort,*xl,*yl); /* Rubberband-
Rectangle */

Draw (Window->RPort,xold, *yl);

Draw (Window->RPort,xold,yold);

Draw (Window->RPort, *x1,yold);

Draw (Window->RPort, *x1,*yl);

Move (Window->RPort,*x1,*yl);
Draw (Window->RPort, *x2,*yl);
Draw (Window->RPort,*x2,*y2);
Draw (Window->RPort,*xl,*y2);
Draw (Window->RPort,*x1, *yl);

77



4. DEVICES

78

ADVANCED SYSTEM PROGRAMMER'S GUIDE

xold = *x2;
yold = *y2;
}
}
Move (Window->RPort, *x1, *yl); /* erase rectangle */

Draw (Window->RPort, xold, *yl);
Draw (Window->RPort,xold,yold);
Draw (Window->RPort, *x1,yold);
Draw (Window->RPort, *x1, *yl);

SetDrMd (Window->RPort,JAM2);
if (*x1 > *x2)
{

xold = *x1;

*x1 = *x2;

*x2 = xold;

}

if (*yl > *y2)

{
yold = *yl;
*yl = *y2;
*y2 = yold;

}

/***t*********t**t***********t*t****************i***ti*******

* main () (User) *
* *
* May have to change SPECIAL DENSITYl depending on quality *
* supported by your printer *

**********t******************************t*****t************/
main()

{
ULONG x1,yl,x2,y2;
if ((IntuitionBase = (struct IntuitionBase *)
OpenLibrary ("intuition.library",0L)) == (struct
IntuitionBase *) 0l)
CloseIt ("No Intuition !!!"®);
if ((GfxBase = (struct GfxBase *)
OpenlLibrary ("graphics.library",0L)) == (struct GfxBase
*) 01)
CloseIt ("No Graphics !'!!");
Window = IntuitionBase->ActiveWindow;
Mark_PrintArea (Window,&x1,&yl, &x2,&y2);
Open_A Device ("printer.device",OL,&PrtPtr,OL,PRT_LEN);
Normal = (struct IOStdReq *)PrtPtr;
DumpRastPort = (struct IODRPReq *)PrtPtr;
Command = (struct IOPrtCmdReq *)PrtPtr;
Printer Dump (DumpRastPort,
Window->RPort,
GfxBase->ActiView->ViewPort->ColorMap,
(ULONG) GfxBase->ActiView->ViewPort->Modes,
(UWORD) x1,
(UWORD) y1,
(UWORD) (x2-x1),
(UWORD) (y2-yl),
(ULONG) (x2-x1),
(ULONG) (y2-y1),
(UWORD) SPECIAL DENSITY1);
Closelibrary (GfxBase);
CloseLibrary (IntuitionBase);
Close A Device (PrtPtr);
}
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4.5.5

Printer device error messages

The printer device contains the following messages:

#define PDERR_NOERR 0
No error—everything OK

#define PDERR_CANCEL 1
Printer operation interrupted (AbortIO())

#define PDERR_NOTGRAPHICS 2
Printer does not support graphics

#define PDERR_INVERTHAM 3
You cannot print inverted HAM pictures (Kick1.1 and Kick1.2 only)

#define PDERR_BADDIMENSION 4

Invalid print size

#define PDERR_DIMENSIONOVFLOW 5

Too large a print size chosen (Kick1.1 and Kick1.2 only)

#define PDERR_INTERNALMEMORY 6
Insufficient memory present for internal variables

#define PDERR_BUFFERMEMORY 7
Insufficient memory for printer driver to allocate printer buffer

These errors are returned in the io_Error variable of the device
blocks.

4.5.6

The printer device under Kickstart 1.3

Printer drivers are much faster under Kickstart 1.3. Kickstart 1.3 also
provides a new command for the printer device: the PRD_QUERY
command (#define PRD_QUERY 12), which returns the current
printer port status. You may remember other forms of this command
from the parallel and serial devices. This way the port to which the
printer is connected (i.e., Preferences) is the port that is chosen. To get
the status, you must enter two UBYTES or one UNORD and give the
address of these words to the 1io_Data pointer:
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UWORD Status;
PrtReq->io_Data = (APTR) &Status

The status stands in this UWORD after the call of the PRD_QUERY
command (Do_Command (PrtReq, (UWORD) PRD_QUERY). The
entire UWORD is needed for the serial printer, while the parallel printer
needs only the lower byte (bits 0-7) of the UWORD to reserve the status.
With that you know how you must interpret the status returned in
io_Actual. You can tell if it is being handled as a serial
(io_Actual == 2)ora parallel printer (io_Actual == 1), The
sections on the serial and parallel devices indicate the meanings of these
bits.

In addition to the new command, there are some new flags:

#define SPECIAL DENSITYS 0x0500
#define SPECIAL DENSITY6 0x0600
#define SPECIAL_DENSITY5 0x0700

You can now select seven print densities instead of four, if the printer
supports these.

#define SPECIAL NOFORMFEED 0x0800

A page oriented printer (e.g., laser printers or friction feed printers)
usually executes a formfeed after printing a page. This ensures that you
only print one graphic to a sheet of paper. When you set this flag, no
formfeed is executed.

#define SPECIAL TRUSTME 0x1000

The printer is usually reset after a hardcopy. To print multiple graphics
on the same page, you must instruct the computer not to reset after a
hardcopy by setting the SPECIAL_TRUSTME flag.

#define SPECIAL NOPRINT 0x2000

This flag stops the printer from printing. This may seem silly—why
open the printer device and then print nothing? Remember that the
printer driver calculates the size of the hardcopy based on the data you
placed in io_DestCols, io_YDotsInch, etc. The size of the
hardcopy on the printer then passes to the variables io_DestCols
and io_DestRows. io_DestCols and io_DestRows contain the
number of columns and lines needed to create the hardcopy. Using the
SPECIAL_ NOPRINT flag can then test, for example, if the hardcopy
can be printed in the desired size, or if some parameters need changing.
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4.6

The keyboard device

The keyboard device allows direct reading of the keyboard. The keyboard

device uses the following commands:

KBD_READEVENT (10) prepares keyboard input as an input
event structure

KBD_READMATRIX (11) reads status of all keys (pressed or not
pressed)

CMD_CLEAR (5 clears keyboard buffer

The keyboard device also features reset handler routines:

KBD_ADDRESETHANDLER (12 inserts reset handler

KBD_REMRESETHANDLER (13) removes reset handler

KBD RESETHANDLER-DONE (14) informs user that a reset
routine has been executed

Of these commands, the only command that currently works is the
KBD_READEVENT command. All of the other commands return error
messages that say that the command is not implemented (-Oxfc). This
means that the input task checks this device and does not allow any
other users. Regardless, we'll discuss all of the commands.

4.6.1

Opening the keyboard device

The keyboard device uses a standard request block. The following code
opens access to the device:

struct IOStdReq *KeyRequest = OL;
#define KEY_LEN (ULONG) sizeof (struct IOStdReq)

Open_A Device ("keyboard.device", OL, &KeyRequest, OL,
KEY_LEN);
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4.6.2

82

Reading the keyboard device

As mentioned above, you have two options for viewing the keyboard
status. The first consists of allowing the input device to fill an input
structure, which you can examine:

/***i****ti*******tt**t*************i**********i**i*************

* KeyBoard_ReadEvent () (Key Support)*
* *
* Function: Read KeyBoard-Event *
K e e e e e o e e *
* Input - Parameter: *
* *
* GamePortRequest: GamePort-Device-Block *
* Type: Controller-Type *

Kk dk kA kKKK KKK A I IA kA hH A I I XA I IR AK kA Ak khkkkkkkkkkkkkkk kX /

VOID KeyBoard ReadEvent (KeyRequest,InputEvent)

struct IOStdReq *KeyRequest ;

struct InputEvent *InputEvent;

{
KeyRequest->io Data (APTR) InputEvent;
KeyRequest->io_Length (ULONG) sizeof (struct InputEvent);
Do_Command (KeyRequest, (UWORD)KBD_READEVENT) ;

('}

}

The second option consists of reading the status of all of the keys (this
second option is currently not implemented, but may be added soon).
The address of a byte array is first given to the io_Data pointer of the
device block. This array will later contain the status of every key on the
keyboard. Each bit of this array represents one key (bit = 0 => key not
pressed).

The first byte contains the status for the keys coded 0-7, the second
contains the status for the keys coded 8-15, and so on. You must
specify the number of bytes of the array in io_Length to execute the
KDB_READMATRIX command. Then the array fills with the status of
each key.

J/ Kk kg ek ok ok ok ek Wk Kk ko Rk kK R AWK AR A AR AR KK KRR KK AR K KX KAk Nk kK

* KeyBoard ReadMatrix () (Key_Support)*
* *

* Function: Read key statsu
*

Input - Parameter:

* % * % ¥ % *

*

*

* KeyRequest: Device-Block

* Array: Byte-Array for Status
* Len: Size of arrays
*****************t*ti*******************i**********************/
VOID KeyBoard ReadMatrix (KeyRequest,Array,Len)

struct IOStdReq *KeyRequest;

APTR Array;
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ULONG Len;

{
KeyRequest->io Data (APTR) Array;
KeyRequest-~>io_Length Len;
Do_Command (KeyRequest, (UWORD) KBD_READMATRIX) ;

}

4.6.3

The resets
routine

Resets through the keyboard device

The keyboard device has provisions for executing system reset routines.
These routines execute when the user presses the <Ctrl><left
Amiga><right Amiga> keys. These routines may close open files
when a reset occurs.

This routine is installed through an interrupt structure whose
is_Code (program code) and is_Data (data) elements are initialized.
This interrupt structure is given in the 1o_Data pointer of the device
block, where the io_Length variable of the value sizeof
(struct interrupt)is. Then the KBD_ADDRESETHANDLER
command is called:

struct Interrupt OwnReset

OwnReset.is Code = YourOwnRoutine;
OwnReset .is Data = YourOwnData;

KeyReq->io Data = (APTR) OwnReset;
KeyReg->io_Length = (ULONG) sizeof(struct Interrupt);
Do_Command (KeyReq, (UWORD) KBD_ ADDRESETHANDLER) ;

[[]

Unfortunately, this command is not implemented. You may be able to
crash the system by accessing this command, which requires powering
down on most of the Amiga models.

KBD_REMRESETHANDLER works to some extent. With the help of
this command the reset handler should be removed shortly before the
end of a program. The variables that must be initialized are the same as
those used by KBD_ADDRESETHANDLER,

The last command, which the keyboard device completely supports at
this time, is the KBD_RESETHANDLERDONE command. This
command must be called after the execution of a reset routine.
KBD_RESETHANDLERDONE informs the system that the reset handler
has been completely processed and the reset can be continued. We don't
know if this command functions—we were never able to install a reset
handler.
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4.6.4

84

A keyboard device application

The following program reads the input events from the keyboard and
displays the key code of the pressed key (ie_Code). Combine the two
keyboard support routines and the include files listed in the folowing
program to make the Key_Support.c file.

/********t*****************t****************************t**t****
* Key.c *
* (c) Bruno Jennrich *
*********t***************i***************t*********************/
/**********************************************i**********i*****

* Compile-Info: *
* cc Key.c *
* ln Key.o Key Support.o Devs_ Support.o -lc *

***********t*****************************t********t************/

#include "exec/types.h"
#include "exec/io.h"

#include “exec/devices.h"
#include "devices/inputevent.h"
#include "devices/keyboard.h"
struct InputEvent Event;

struct IOStdReq *KeyRequest=0l;

#define KEY LEN (ULONG) sizeof (struct IOStdReq)
/********t***************ﬁ***i**********************************

* CloseIt() {(User)*
* Function: In case of error, close everything *
* *
* Input - Parameter: *
* String: Error-Message *

****************************************************i**********/
VOID Closelt (String)
char *String;
{
UWORD 1i;
UWORD *dff180 = (UWORD *)O0xdff180;
UWORD Error = 0;
if (strlen (String) > 01)
{
for (1=0;i<Oxffff;i++) *dffl180 = i;
puts (String);
Error = 10;
}
if (KeyRequest != 0l) Close_A Device (KeyRequest);
exit (Error);
}
main()
{
Open_A Device ("keyboard.device",O0l,&KeyRequest,0l,KEY LEN);
do
{
KeyBoard ReadEvent (KeyRequest, &Event);
printf ("ie Code: %d\n",Event.ie_Code);
} while (Event.ie Code != (UWORD) Ox45); /* Escape */
Close A Device (KeyRequest);
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4.7

The gameport device

The gameport device accesses any connections to the gameports (€.g.,
mice or joysticks). The gameport device supports the following
commands:

GPD_READEVENT (9) read controller status
GPD_ASKCTYPE (10) read controller type
GPD_SETCTYPE (11) set controller type
GPD_ASKTRIGGER (12) read announcement status
GPD_SETTRIGGER (13) set announcement conditions
CMD_CLEAR (5) erase gameport buffer

4.7 .1

Controller
specification

Opening the gameport device

‘When opening a device you must determine which gameport you want
to check. The Unit parameter of OpenDevice () contains either 0
for gameport 1 or 1 for gameport 2:

#define GP_LEN (ULONG) (sizeof (struct IOStdReq))
struct IOStdReq *GamePortRequest = OL;

Open_A Device ("gameport.device", 1L, &GamePortRequest, OL,
GP_LEN) ;
/* 1L: GamePort 2 */
Close_A_Device (GamePortRequest);

This sequence opens gameport 2 for access. If you want to use both
gameports for a game, you must open the gameport device twice, once
with GamePortRequest = 0L and with GamePortRequest =
1L.

Once OpenDevice executes, you must specify the type of controller
in the gameport. You can select from the following controller types:

GPCT_MOUSE (1) mouse
GPCT_RELJOYSTICK  (2)  relative joystick
GPCT_ABSJOYSTICK  (3)  absolute joystick

If you select GRCT _MOUSE, the system accesses the Amiga mouse in

gameport 2. Do not try accessing the mouse in gameport 1 through the
input device, because the input device treats the mouse in gameport 1
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as a different device device. You can, however, instruct the input device
to check a joystick instead of a mouse (see Section 4.8—The input
device).

The input device controls gameport 1 until you take over the entire
system through software, or disable the input task. Avoid disabling the
input task, since this can cause problems throughout the system. When
you want to use gameport 1 without disturbing the input task, you can
access it direct over hardware register joyOdat ($dff00a).

The GP_SETCTYPE command helps you determine which controller
should be checked with OpenDevice (). You only need to give the
following routine the flags GPCT_MOUSE, GPCT_RELJOYSTICK,
and GPCT_ABSJOYSTICK:

JREk ko kkkkkkkkkkkkkkkkkkkhkkkkkkkkkkkkkkkkkkkkkkkkkkkkk ok kkkkkkkk

GamePort_SetCType () (Game_Support) *
*

Function: Determine controller type

Input - Parameter:

* % % % A ¥ %
* % % % % %

GamePortRequest: GamePort-Device-Block
Type: Controller-Type

*******************t***ii******tt**************i***************/

VOID GamePort_SetCType (GamePortRequest,Type)
struct IOStdReq *GamePortRequest;
UBYTE Type;
{

UBYTE GP_Type;

GP_Type = Type;
GamePortRequest->io_Data = (APTR) &GP_Type;
GamePortRequest->io_Length = 11;

Do_Command (GamePortRequest, (UWORD)GPD_SETCTYPE) ;
}

The address of the variable is given to the gameport device block,
which contains the type to be set. Because this type must be
established as a UBYTE variable, it contains the value 1L.

The Amiga's operating system is an ongoing system. Like many
software/hardware bases, it has undergone many upgrades and will
probably continue to develop. Later versions of Kickstart may support
other gameport controllers (e.g., a lightpen). Since this new controller
is not supported from the previous Kickstart versions, the program will
probably crash if started from an earlier Kickstart version.

To prevent this, the value -1 is returned for GPDERR_SETCTYPE for a
controller not supported in the io_Error of the gameport device
block. This can be altered to abort the program without a crash. The
controllers mouse, Reljoystick, and Abs joystick are all
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supported by all versions of Kickstart, so the controller check is
unnecessary for these controllers. The following routine helps you
determine which controllers are connected to the gameport:

/***************************************************************

* GamePort_AskCType () (Game_Support) *
* *
* Function: Which controller is supported? *
K e e e o o e . o e o e e e . o . o o . . o . S o o . *

* Input - Parameter:

*

* GamePortRequest: GamePort-Device-Block

* Type: Address of the bytes, assigned to the
*

controller type
***************************************************************/

* % ¥ * %

VOID GamePort_ AskCType (GamePortRequest,Type)

struct IOStdReq *GamePortRequest;
UBYTE *Type;
{
GamePortRequest->io Data = (APTR) Type:
GamePortRequest->io_Length = 11;

Do_Command (GamePortRequest, (UWORD)GPD_ASKCTYPE) ;
}

Other than the gameport device block, you need the address of the bytes
into which the controller type should be placed. If the value zero
(GPCT_NOCONTROLLER) is returned in Type, you can then use the
gameport for your own controller. The gameport is occupied by another
program when Type == -1 (GPCT_ALLOCATED). When the
value 1, 2 or 3 is returned in Type, that means that your program is
being used by the gameport, and the controller that was returned is
supported by the gameport device.

4.7.2

Reading gameport device status

The READEVENT command allows the user to read the gameport device
status.

/***************************************************************

GamePort_ReadEvent () (Game_Support)*
*

Function: Read controller status

*

- *

Input - Parameter: *
*

*

GamePortRequest: GamePort-Device-Block
ReadEvent : Addesse of an InputEvent strukture, in which*

the controller status is written *
**i************************************************************/

* % ¥ % * F A X *
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VOID GamePort ReadEvent (GamePortRequest,ReadEvent)
struct IOStdReq *GamePortRequest;
struct InputEvent *ReadEvent;
{
GamePortRequest->io_Data = (APTR) ReadEvent;
GamePortRequest->io_Length = (ULONG) (sizeof (struct
InputEvent));
GamePortRequest->io_Command = (UWORD)GPD_READEVENT;
DoIO (GamePortRequest) ;
}

The controller status (e.g., left or right on a joystick) is placed in an
input event structure assigned by you (see Section 4.8).
ReadEvent.ie position.ie x and ReadEvent.ie position.ie y
return the controller settings. That differentiates between the three
different controller types.

When you read the mouse (or a trackball), the two variables listed
above receive the number of steps that the mouse has moved. The faster
you move the mouse, the larger the value. When you move the mouse
up, the Y coordinate is negative. When you move the mouse down, the
Y coordinate is positive. When you move the mouse left, the X
coordinate is negative, and when you mouse the mouse right, the X
coordinate is positive.

=

Remember that the value given here represents the movement, rather
than the actual position of the mouse pointer. If you want to control
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one of your own mouse pointers, you only need to add the values in
ReadEvent.ie_X and ReadEvent.ie_Y (see Section 4.8) to the
position of the mouse pointer.

GPCT_RELJOYSTICK:

When you plug a relative joystick in the gameport, the system returns
the stick status in the form of the numbers -1, 0 and 1. The pattern
given in the figure above represents the negative and positive values.
The center position of the joystick returns a zero to the variables.

GPCT_ABSJOYSTICK:

Mouse and
fire buttons

Movement patterns for the absolute and relative joysticks are the same.
The difference between them is that GPCT RELJOYSTICK constantly
supplies the position, while GPCT ABSJOYSTICK only states when
the joystick is brought to a new position.

The ReadEvent structure also comes into play for reading the mouse
buttons on a mouse or the fire button on a joystick. The ie_Code
field describes the status of these buttons. When this element has the
value IECODE_LBUTTON (0x68), either the fire button or the left
mouse key was pressed. The right mouse key is tested through
IECODE_RBUTTON (0x69). You also have the option of reading the
release of the button by instructing the gameport device through
SETTRIGGER:

/***************************************************************

* GamePort_SetTrigger () (Game_Support)*
* *
* Function: Set movement trigger *
* —%
* Input - Parameter: *
* *
* GamePortRequest: GamePort-Device-Block *
* GPT: GamePortTrigger-Structure, which determines*
* when the movement message mshould be sent *
* and if the keypress or release of the key *
*

should be announced *
LR e T T L L e ey

VOID GamePort SetTrigger (GamePortRequest,GPT)
struct IOStdReq *GamePortRequest;
struct GamePortTrigger *GPT;
{

GamePortRequest->io Data

GamePortRequest->io_Length
GamePortTrigger));

Do_Command (GamePortRequest, (UWORD)GPD_SETTRIGGER) ;
}

(APTR) GPT;
(ULONG) (sizeof (struct

Don't let the comments in this routine confuse you: the factors in this
function primarily control mouse movement (more on this later).
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The given GamePort Trigger structure helps you determine whether
one key was pressed (GPTF_DOWNKEYS = 0x01), one key was
released (GPTF_UPKEYS = 0x02) or both keys were released
(GPTF_UPKEYS+GPTF_DOWNKEYS = 0x03). This determination
occurs through the Keys element.

This Keys element is not the only element of the
GamePortTrigger structure:

Offset Structure

struct GamePortTrigger
{/* defined in "devices/gameport.h" */

0 0x00 UWORD gpt_Keys;

2 0x02 UWORD gpt_TimeOut;
4 0x04 UWORD gpt_XDelta;
6 0x06 UWORD gpt_YDelta;
8 0x08 }

Timeout states the number of vertical blanks that should be sent from
the gameport device between ReadEvents (60 per second). XDelta
and YDelta state after how many pulses of the controller a
ReadEvent should be created. This only works when using a mouse
as an input device. The mouse contains two shafts fitted with wheels,
and the wheels have holes drilled in them. When the mouse changes
position, the holes interrupt a light source. The gameport checks for
this light change.

These pulses are added together. When the sum of the values exceeds
the values given in XDelta and YDelta, the mouse pointer moves
to point XDelta and YDelta. When you give the value 1 for
XDelta and YDelta, the mouse pointer moves the fastest. This
means that you need less room on your desk to move the pointer from
the upper left corner of the screen to the lower right corner of the
screen.,

Preferences program also allows the user to set the mouse speed. The
mouse speed assigned after every boot operation is an input device
routine which accesses the gameport device.

How does Preferences know which values to set for the mouse speed?
GamePort_AskTrigger reads the GamePortTrigger of the
corresponding gameport:

/% %k 3k ok ok ek sk ok ok ok ok Kk K Ik 3k ko ok ok ok ok e ok ok ok ok ok o ok ook ok ok ok ok Rk ok Rk Kk kK KR R K

* GamePort_AskTrigger () (Game_Support) *
* *
* Function: Which condition makes sence for the controller *
* *
* Input - Parameter: *
* *
* GamePortRequest: GamePort-Device-Block *
* GPT: Address of the GamePortTrigger structure *



ABACUS

4.7 THE GAMEPORT DEVICE

* to be filled (see SetTrigger) *
***************************************************************/

VOID GamePort AskTrigger (GamePortRequest,GPT)
struct IOStdReq *GamePortRequest;
struct GamePortTrigger *GPT;
{

(APTR) GPT;
(ULONG) (sizeof (struct

GamePortRequest->io Data

GamePortRequest->io_Length
GamePortTrigger));

Do_Command (GamePortRequest, (UWORD)GPD_ASKTRIGGER) ;

}

This routine fills the GamePort Trigger function that was given by
you with the trigger values of the corresponding gameport, which you
can then read.

4.7.3

A gameport device application

The following program checks a mouse in gameport 2. Left mouse
button key presses are displayed; pressing the right mouse button ends
the program. When you move the mouse, the position change is
displayed on the screen. The faster you move the mouse, the larger the
displayed value. Combine the game support routines to make the
Game_Support.c file. Include the devs/gameport.h and
devs/inputevent.h files in the Game_Suppport.c file.

/***************************************************************

* GamePort.c *
* (c) Bruno Jennrich *
* August 1988 *

***************************************************************/

/***************************************************************

* Compile-Info: *
* *
* cc GamePort *
* ln GamePort.o Game_Support.o Devs_ Support.o -lc *

***************************************************************/

#include "exec/Types.h"
#include “execZmemory.h"
#include "exec/io.h"

#include "exec/devices.h"
#include "devices/inputevent.h"
#include "devices/gameport.h"

#define GP_LEN (ULONG) (sizeof (struct IOStdReq))

struct IOStdReq *GamePortRequest=0;
struct GamePortTrigger GPT;
struct InputEvent ReadEvent;
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/***************************************************************

* CloselIt () (User) *
* Function: In case of an error, release structure and memory *
L - *
* Input ~ Parameter: *
* String: Error-Message *

ek e ok ek Kk 3k ko ok ko ko kR Kk ke ko ke ke ke ko ko ke k ko k ok k ok k ok ok kk ok /

VOID Closelt (String)
UBYTE *String;
{
UWORD *dffl180 = (UWORD *)0xdff180;
UWORD 1i;
UWORD Error;
Error = 0;
if (strlen (String) > 0)
{
for (i=0;i<Oxffff;i++) *dff180 = i;
Error = 10;
}
puts (String);

if (GamePortRequest != 0) Close A Device (GamePortRequest);
exit (Error);

}

Vad it 2 SRR RSt RSttt st sttt St it iRttt Rttt

* The_GamePort Device() (User)*
* *
* Function: Use GamePort device *

ek ok ok ke ok ok ko ok 3k ok ke ok ok ke ok ok ok e ek kK ok sk kR ko ko ko ke ok ok kk ko kk kR ok ko /

The_GamePort Device ()

{
Open_A Device

("gameport.device", 11, &GamePortRequest, 01, GP_LEN) ;
printf (" Please put mouse in second GamePort!\n");
printf (" right mouse key == end of program\n");
GamePort_SetCType (GamePortRequest, (UBYTE)GPCT_ MOUSE);
GPT.gpt_Keys = (UWORD) (GPTF_UPKEYS+GPTF_DOWNKEYS) ;
/* Announce both */

GPT.gpt_Timeout = (UWORD) O0;
GPT.gpt_XDelta = (UWORD) 1;
GPT.gpt_YDelta = (UWORD) 1;

GamePort_SetTrigger (GamePortRequest, &GPT);
ReadEvent.ie Code = 0;
while (ReadEvent.ie Code != IECODE_RBUTTON)
{
if (ReadEvent.ie Code == IECODE LBUTTON) printf ("Left
Button\n");
if (ReadEvent.ie_Code == IECODE_LBUTTON+IECODE_UP_PREFIX)
printf (“Left Button released\n");
GamePort ReadEvent (GamePortRequest,&ReadEvent);
printf ("x: %d\n y: %d\n",ReadEvent.ie_X,ReadEvent.ie Y);
Do_Command (GamePortRequest, (UWORD) CMD_CLEAR) ;
}
GamePort_SetCType (GamePortRequest, (UBYTE)GPCT_NOCONTROLLER) ;
Close_A Device (GamePortRequest);

}

main()
{
The_GamePort Device();

}
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4.8

The input device

The input device is based to some degree on the keyboard device and the
gameport device (see Sections 4.6 and 4.7). The input device supports
the following commands:

IND_ADDHANDLER (9) insert own input handler

IND_REMHANDLER (10) remove own handler

IND_WRITEEVENT (11) send input event to all other input
device users

IND_SETTHRESH (12) set time trigger for repeat function

IND_SETPERIOD (13) determine repeat speed

IND_ SETMPORT (14) determine mouse port
IND_SETMTYPE (15) determine mouse port controller
IND_SETMTRIG (16) determine mouse port controller trigger

These commands are defined in "devices/input.h". In addition to
the device commands, the input device supports the following common
commands:

CMD_RESET (1) reset input device without disabling
handler

CMD_CLEAR (5 clear input buffer: suppress all
previously sent input events and those
not yet processed by the handler

CMD_STOP (6) stop input device

CMD_START (7)  start input device

4.8.1

Opening and closing the input device

The input device must be opened before access, using the
Open_A Device () function:

#define INPUT_LEN (ULONG) (sizeof (struct IOStdReq))
struct IOStdReq *InputRequest;

Open_A Device("input.device", OL, &InputRequest, OL,
INPUT_LEN);
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After access the device must be closed again, using the
Close_A Device () function, as usual:
Close A Device (InputRequest);

4.8.2 Accessing the input device

94

No READ command exists for the input device. But how can we receive
key presses from the input device and process them? The key phrase
here is input handler. The input task calls an input handler which
controls all of the keypresses and mouse movements. This handler
receives an input event structure that was created from the input task.
The input event structure looks like this:

Offset: Structure:

struct InputEvent
{/* defined in "devices/inputevent.h" */

0 0x00 struct InputEvent *ie NextEvent;
4 0x04 UBYTE ie Class;
5 0x05 UBYTE ie SubClass;
6 0x06 UWORD ie Code;
8 0x08 UWORD ie Qualifier;
union
{
struct
{
10 0xOA WORD ie_x;
12 0x0C WORD ie y;
} ie_xy;
10 0x0A APTR ie addr;
} ie_position;
14 0xOE struct timeval ie_TimeStamp;
22 0x16 }

Let's take a closer look at this structure. The variable ie_Class
contains the result type, which the input event structure contains. The
following input event classes exist:

IECIASS NULL (0x00) NOP input event
IECLASS RAWKEY (0x01) keyboard code
IECIASS RAWMOUSE (0x02) mouse movement
IECLASS EVENT (0x03) internal event

IECLASS POINTERPQOS (0x04) mouse position

! ' TECLIASS (0x05) does not exist!
IECLASS TIMER (0x06) timer event

TECLASS GADGETDOWN 0x07) gadget clicked on
IECLASS GADGETUP (0x08) gadget released
IECLASS REQUEST (0x09) requester now displayed
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IECLASS MENULIST (0x0A) menu clicked on

TECIASS CLOSBAINDOW  (0xOB) window close gadget clicked
IECIASS SIZBWINDOW  (0xOC)  window resized

TECIASS REFRESHWINDOW (0xOD)  window refreshed

TECIASS NEWPREFS (Ox0E) new Preferences

IECIASS DISKREMVED  (0x0F)  disk removed

IECIASS DISKINSERTED  (0X10) disk inserted

TBCIASS ACTIVEWINDOW  (0x11) window activated

IECIASS INACTIVEWINDOW (0x12) window deactivated

Let's examine each input event and how ie_Class interprets them:

IECLASS_Null

A NOP input event. Data from the event has no meaning.

IECLASS_RAWKEY

Places the keyboard code of the pressed key in ie_Code (not the
ASCII code). ie_Qualifier contains the status of the <Cul>,
<Shift> and <Alt> keys:

IEQUALIFIER LSHIFT (0x0001) left <Shift> key
IEQUALIFIER RSHIFT (0x0002) right <Shift> key
IEQUALIFIER CAPSLOCK (0x0004) enable <Caps lock>
IEQUALIFIER CONTROL (0x0008) <Cul> key
IEQUALIFIER IALT (0x0010) left <Alt> key
IEQUALIFIER RALT (0x0020) right <Alt> key
IEQUALIFIER LOCMMAND (0x0040) left <Amiga> key
IEQUALIFIER ROOMMAND (0x0080) right <Amiga> key
IEQUALIFIER NUMERICPAD (0x0100) numeric keypad key
IEQUALIFIER REPEAT (0x0200) key repeated
IEQUALIFIER INTERRUPT (0x0400) m
IEQUALIFTER MULTIBROADCAST (0x0800) m
IEQUALIFIER LBUTTON (0x1000) left mouse button
IEQUALIFIER RBUTTON (0x2000) right mouse button
IEQUALIFIER MBUTTON (0x4000) middle button (does
not exist)
IEQUALIFIER REIATIVEMOUSE (0x8000) relative mouse
position message

When the bit is set, the <Shift>, <Alt> or <Ctrl> key was also pressed
as well as the key in ie_Code. The illustration shows the layout of
the key codes. The numbers on the keys are equal to the value returned
in ie_Code. The two input events are sent from the input device
when one key is pressed. The keypress and the release of the key are
two separate events. You can differentiate the two input events because
the high value bit (bit 7 = 0x80) is set in actual keyboard code
(ie_cCode) when the key is released (IDCMP flag: RAWKEY).
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IECLASS_RAWMOUSE
Returns a mouse movement to ie_x and ie_y. These two variables
are part of a union. Here are two macros to allow you to move the
mouse in the X or Y direction without entering input event
ie_position.ie_x time after time:

#define ie X ie_position.ie x;
#define ie Y ie position.ie_y;

Now it is possible to access the movement change over input event
ie_X to the X coordinate. The IDCMP flag DELTAMOVE must be set
in the current window so that the input task of this event can be sent.

IECLASS_EVENT
An internal event of the input device. It is a necessary part of keeping
the system informed of changes to the current input window.
ie_Code has the value IECODE_NEWACTIVE (0x01).

IECLASS_POINTERPOS
The absolute mouse position as placed in ie_X and ie_Y. This event
functions only when the IDCMP flag MOUSEMOVE is set for the
current window.

IECLASS_TIMER
Places the current system time in timeval. This event comes from
the input task every 60th of a second (IDCMP flag: INTUITICKS).

IECLASS_GADGETDOWN
Places the address of a clicked gadgetin ie_Position.ie_addr.
This event functions only when the IDCMP flag GADGETDOWN is set
for the current window. System gadgets like the front gadget
(WINDOW-TO-FRONT) or the back gadget (WINDOW-TO-BACK)
cannot be checked.

IECLASS_GADGETUP
Places the address of a released gadget in ie_position.ie_addr.
This event functions only when the IDCMP flag GADGETUP is set for
the current window.

IECLASS_REQUESTER
Sent when a requester is represented in the current window.
IECODE_REQSET (0x01) is in ie_Code with the requester
encountered first. When another one is encountered without the first
requester disappearing, this event is no longer sent.

When all of the requesters have disappeared, another input event is sent.
This time the value IECODE_REQCLEAR (0x00) is given in
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ie_Code. To receive this input event, the IDCMP flag REQCLEAR
and/or REQSET must be set.

MENULIST
Places the code of the menu selected from the current window in
ie_Code. This event functions only when the IDCMP flag
MENUPICK is set for the current window.

CLOSEWINDOW
Sent when the user clicks on the close gadget of the current window.
This event functions only when the IDCMP flag CLOSEWINDOW is
set for the current window.

IECLASS_SIZEWINDOW

IECLASS_

Sent when the size of the current window changes. This event functions
only when the IDCMP flag NEWSI ZE is set for the current window.

REFRESHWINDOW
Sent when the current window should be refreshed. This event functions
only when the IDCMP flag REFRESHWINDOW is set for the current
window.

IECLASS_NEWPREFS

Sent when new preferences are present due to changes from the
Preferences program (IDCMP flag: NEWPREF S).

IECLASS_DISKREMOVED

Sent when the user removes a disk from a disk drive (IDCMP flag:
DISKREMOVED).

IECLASS_DISKINSERTED

IECLASS_

Sent when the user inserts a disk in a disk drive (IDCMP flag:
DISKINSERTED).

ACTIVEWINDOW
Makes the window most recently clicked the active window.

IECLASS_INACTIVEWINDOW

Deactivates the currently active window.

Intuition and  Many of the input/output functions used in Intuition are controlled

the input
device
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through the input device, and must be passed on to your Intuition
window. Now let's write a routine that will let you view the events
sent by the input task. We'll start by creating an input handler using
the IND_ADDHANDLER device command:

ULONG User_Routine;
VOID Input Code();
struct Interrupt Input_Handler;
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/***************************'k**'k**'k**t**************************

* Input_AddHandler() (Input_Support)*
* *
* Function: Add own C handler in input handler *
* ——— - *
* Input - Parameter: *
* *
* InputRequest: Input-Device-Block *
* Handler: Address of your own handler routine (C) *
* Data: Address of data area for handler routine *

******************************************************t********/

VOID Input_AddHandler (InputRequest,Handler,Data)

struct IOStdReq *InputRequest;
VOID *Handler;
APTR Data;

{

User_Routine (ULONG) Handler;

(']

Input_Handler.is_Data Data;
Input Handler.is _Code = (VOID (*)())Input_Code;
Input_Handler.is_Node.ln Pri = 51;

InputRequest->io Data (APTR) &Input_Handler;
Do_Command (InputRequest, (UWORD) IND_ ADDHANDLER);

}

This routine specifies the device block with which the device was
opened (or a copy of the original device block). Then the routine gives
the address of the handler routine that was written in C. You also have
the option of specifying a range of memory for use by your handler
routine (e.g., for variables).

Unfortunately the input task is not in the position to call C routines,
because the parameters are passed in the stack in C. The input task
gives the parameters (input event and data region) in the hardware
registers. For this reason, we must switch to an interface that moves
the parameters from the hardware register onto the stack, and then call
the C program. We have developed a short machine language routine
for this purpose:

/***************************************************************

* _Input_Code.asm (Input_Support) *
* *
* Function: Call Input-Handler Routine (C-Routine) *
U S S L L P ——— *

Input - Parameter:

*

*

* AQ: Pointer to Input-Event

* Al: pointer to your own data

* Return values:

* % % ¥ H * * *

* DO: Contains the Input-Event to process further
*******************t**t***********t****************************/

#asm
public _getad
public _Input Code
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_Input_Code:
move.1l a4, -(sp)
jsr _getad
movem.l a0/al,-(sp) ; parameter auf Stack
move.l _User Routine,a0l
jsr (a0)

movem.l (sp)+,a0/al
move.l (sp)+, a4
rts

#endasm

Because the Aztec compiler accesses program variables through
hardware register A4, this register must be re-initialized before each call
of the C handler routine. This is done here using the routine geta4,
which transfers the variables' basis address according to A4. The
initialization of register A4 must occur because register A4 contains
another value during the input handler processing. This register should
return to its old value when leaving the handler. The parameter can be
brought to the stack after initialization of register A4, and the C routine
can be recalled.

This machine language routine is given as the actual input handler in
Input_AddHandler (). For this an interrupt structure is stored
whose is_Code field is loaded with the address of the machine
language routine, and whose is_Data field is loaded with the address
of the memory range. We set the priority of our handler higher than
that of the system input handler, so that we get all of the input events
that the input task creates first. The priority of the system input handler
is 50, and the priority of our handler is 51.

Then the initialized interrupt structure can be given in our input device
block (io_Data), and the IND_ ADDHANDLER command is sent.
Remember not to use any variables named Input_Handler and
User_Routine, just in case you want to use the above program.
InputHandler is the interrupt structure, over which the machine
language segment Input_Code is called. User_Routine contains
the address of the C routine that was called, and which the input handler
should process. When you want to exit a program that has installed an
input handler, you must remove the input handler again. This is done
with the following code.

JRFEKK KKK KK KKk kk kkkkkk ko kkk ok khkhhkkk kkkkkkkkkhkkk ko kkkkkk kkkkkk

* Input_RemHandler () (Input_Support) *
*

Function: Disable Input-Handler

Input - Parameter:

* % % ¥ N

* % X H

* InputRequest: Input-Device-Block
*****t**********************tw*******************t*************/
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VOID Input_RemHandler (InputRequest)
struct IOStdReq *InputRequest;
{
InputRequest~->io_Data = (APTR) &Input_Handler;
Do_Command (InputRequest, (UWORD) IND_ REMHANDLER) ;
}

These two routines give you the information needed to write a macro
recorder that registers all of the encountered input events. Here's the
code for just such a recorder. Combine all the input support routines
presented in this section to make the Input_Support.c file. The header
for the Input_Support.c file is presented at the end of this section.

/***t*****************t*****************************************

* Recorder.c *
* August 1988 *
* (c) Bruno Jennrich *

LA AR A AR SRR LSS a il et sttt st sttt s )
/********************************t******i**t***************i**ii

* Compile-Info: *
* ¢c Recorder *
* 1ln Recorder.o Input_Support.o Devs_iSupport.o -lc *

¥ o e e K ke Kk ko ok ok **************t*********************************/

#include "exec/types.h"
#include “"exec/memory.h"
#include "exec/interrupts.h"
#include "exec/nodes.h"
#include "devices/input.h"
#include "devices/inputevent.h"
VOID *AllocMem();

VOID *Open();

ULONG User_Routine;

#define MODE_NEWFILE 1006L

#define INPUT_LEN (ULONG) (sizeof (struct IOStdReq))
#define RECORD SIZE 50001

#define INEV_LEN { (ULONG) (sizeof (struct InputEvent)))
#define MEMTYPE (MEMF_CHIP | MEMF_CLEAR)

ULONG HowMuchEvents;

ULONG ActualEvents;

BOOL End;

UWORD *FileHandle=01;

struct InputEvent *Recorder=01;
struct I0StdReq  *InputRequest = 01;

struct InputEvent *Pointer;
/*************i***i*******i************t*********t***i**********

* CloseIt () (User) *
* Function: Release all occupied memory and structures *
K- ———————— *
* Input - Parameter: *
* String: Error-Message *

******t************************************i***************t***/

CloselIt (String)
BYTE *String;
{
UWORD *dff180 = (UWORD *)Oxdff180;
UWORD 1i;
UWORD Error;
Error = 0;
if (strlen (String) > 0)
{
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for (i=0;i<Oxffff;i++) *d£ff180 = i;
Error = 10;
}
puts (String);
if (FileHandle != 0) Close (FileHandle);
if (InputRequest != 0l) Close A Device (InputRequest);
if (Recorder != 0) FreeMem
(Recorder, HowMuchEvent s*INEV_LEN) ;
exit (Error); -
}

/*******i************t************t***t***************t*********

* C_Handler () (User) *
* *
* Function: Handles InputEvents of the Input-Task *
* *
* Input - Parameter: *
* Input: InputEvent *
* Data: Pointer to data *
* . *
* Return value: *
* *

InputEvent, that should be processed further.
t**t**********t************************************************l

struct InputEvent *C_Handler (Input,Data)

struct InputEvent *Input;
ULONG *Data;
{

if (!End)

{

if (Input->ie Class == IECLASS RAWKEY)

{
if (Input->ie_Code == 0x45) End = TRUE; /* Escape */
else
if (*Data < HowMuchEvents)
{

Pointer = &Recorder {*Data]; /* InputEvent */
Pointer->ie NextEvent = 0;
Pointer->ie Class = Input->ie_Class;

Pointer->ie_SubClass

Pointer->ie Code Input->ie Code;

Pointer->ie Qualifier Input->ie Qualifier;

Pointer->ie TimeStamp.tv_secs = Input-
>ie_TimeStamp.tv_secs;

Pointer->ie_TimeStamp.tv_micro = Input-
>ie_TimeStamp.tv_micro;

*Data+=1;

Input->ie SubClass;

]

#

}
else End = TRUE;
}
}
return (Input);
}

/**************************************************************t

* Input Device() (User) *
* - *
* Function: Use InputDevice d

************t*******************************t******************/
Input_Device ()
{

Open_A_Device ("input.device",0l,&InputRequest,0l,INPUT LEN);

End = FALSE;
ActualEvents = 0;
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Input_AddHandler (InputRequest,C_Handler, éActualEvents);
while (!'End); /* wait until end of the line */

Input_RemHandler (InputRequest);
Close A Device (InputRequest) ;
}

/********************t************************t****t********t***

* main() (User)*
* *
* Input - Parameter: *
* argv{l): Name of the Macro File *
* argv{2]: Number of events *

************‘k***************************t**********************/

main (argc,argv)
UWORD argc;
BYTE **argv;
{
if (argc '= 3)
{
printf (“USAGE: %s MacroFile How many events\n",argv[0]);

Closelt ("");
}

if ((HowMuchEvents = atoi(argv([2])) < 0)/* how many events */
Closelt {"HowMuchEvents < 0 !!!");

Recorder = (struct InputEvent *) AllocMem
(HowMuchEvent s*INEV_LEN, MEMTYPE) ;
/* Get memory for events */
if (Recorder == 01)
CloseIt ("No Memory for InputEvents !!!%");

Input_Device();
FileHandle = Open ({(argv(l],MODE NEWFILE);

if (FileHandle == 01)
Closelt ("Cannot Open MacroFile !!!");

Write (FileHandle, &§ActualEvents,4l); /* save length */
Write (FileHandle,Recorder,ActualEvents*INEV_LEN);

/* save events */
Close (FileHandle);

FreeMem (Recorder, HowMuchEvents*INEV_LEN);
}

This program first opens the input device. Then the input handler is
installed. This handler calls our C_Handler routine. Only RAWKEY
events are recorded in this C_Handler routine. Whether it was
recorded or not, the received input event is given in the other input
handler (all of the input handlers like interrupt server are organized in a
list). This happens by simply returning the received input event. The
return () routine writes the address of the received input event in DO
for this. If you place the value 0 in D0, you must remember that the
following handler can no longer be accessed.
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Also, remember that input events can be combined. The
ie_NextEvent array uses one of each input event structures (this
pointer points to the input event's successor). So it can happen that
your input handler only receives the first input event of a long list.
You are free to change this list to insert your own input events. Just
bear in mind that anyone developing an input event handler is
responsible for any problems he/she creates.

Now back to the above program. We have recorded only RAWKEY
events there. With this you can record keypresses that occur while the
program is running (it doesn't matter in which window, as long as no
input handler with a higher priority exists). For this you must give the
maximum number of events that should be recorded. You must also
give the names of files in which these recorded input events should be
stored. A sample call of the program can look like this:

Recorder Macro 100

This program call allows you to save up to S0 keypresses to a file
named Macro. You can only record up to 50 keypresses because a
keypress consists of depressing and releasing the key. An input event is
sent for each, so one keypress actually counts for two actions. But you
can test bit 7 in ie_Code and if this is clear, the corresponding event
is not recorded.

Pressing the <Esc> key aborts the program—all data up to that point is
saved and the program ends. A macro recorder is worthwhile only if you
can play back the recorded key presses. We can also play back the input
task with the help of this function. We send only input events in the
input handler, from which more can be given in the system, for
example the system handler and our own input handler installed with
Input_AddHandler. This function is called WRITEVENT. Add it
to your Input_support.c file, remember to include devices/inputevent.h
before compiling.

#define INEV_LEN ( (ULONG) (sizeof (struct InputEvent)))

/*****************************w*********************************
* Input_WriteEvent () (Input_Support)*
* *
* Function: Givw InputEvent in other Input-Handler again *
K e e e e e e —————— o — R —————
* Input - Parameter: *
* *
* InputRequest: Input-Device-~Block *
* Event: InputEvent to redirect *

*************t********kk***ki*i*****i**************************/

VOID Input WriteEvent (InputRequest,Event)

struct IOStdReq *InputRequest;
struct InputEvent *Event;
{

InputRequest->io Data = (APTR) Event;
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InputRequest->io_Length
InputRequest->io_Flags

INEV_LEN;
(UBYTE)O;

Do_Command (InputRequest, (UWORD) IND WRITEEVENT);
}

This routine lets you send an input event to all of the present handlers.
If you installed your own handler, this handler also receives your input
event, as long as a handler with a higher priority has not changed the
input events.

Based on the above routine we can actually write a program to play
back the entered keypresses. Our program must open the file created by
the recorder, read the saved number of recorded input events, allocate
memory as needed and load the input events into this allocated memory.
Then these input events only need to be executed by
Input_WriteEvent ():

/***************************************************************

* Play.c *
* August 1988 *
* (c) Bruno Jennrich *

******t****************tt**************************************/
/**************************************************************i

* Compile-Info: *
* *
* cc Play *
* ln Play.o Input_Support.o Devs_Support.o -lc *

***********************t*******t*******************************/
#include "exec/types.h"

#include "“exec/memory.h"

#include "“exec/interrupts.h"

#include “exec/nodes.h"

#include "devices/input.h"

#include "devices/inputevent.h"

VOID *AllocMem();
VOID *Open();
#define MODE_OLDFILE 1005L

#define INPUT LEN (ULONG) (sizeof (struct I0OStdReq))
#define RECORD_SIZE 50001

#define INEV_LEN ((ULONG) (sizeof (struct InputEvent)))
#define MEMTYPE (MEMF_CHIP | MEMF_CLEAR)

UWORD *FileHandle = 01;

struct InputEvent *Player = 01;/* Memory for InputEvents */
ULONG Length = 01;/* Niumber of InputEvents */

[

struct IOStdReq  *InputRequest= 01;

% ek ek ek ek ke K kK ok ok ok ok ok ok ok ok 3k ok ok ok e sk ok ke sk ok ek R R kR Kk Rk ek ROk Kk ok ok Rk

* CloseIt () (User) *
* *
* Funktion: In case of erroe, release memory and structures *
kS e e —————————— —— *
* Input - Parameter: *
* *
* String: Error-String *

**********t****tt**tﬂ******************************************/
VOID Closelt (String)

105



4. DEVICES ADVANCED SYSTEM PROGRAMMER'S GUIDE

BYTE *String;

{
UWORD *dff180 = (UWORD *)0xdff180;
UWORD 1i;
UWORD Error;

Error = 0;

if (strlen (String) > 0)

{
for (i=0;i<Oxffff;i++) *dff180 = i;
Error = 10;

}
puts (String);

if (FileHandle != 01) Close (FileHandle);
if {(Player !'= 01) FreeMem (Player,Length*INEV_LEN);
if {InputRequest != 01) Close A Device (InputRequest);

exit (Error);

}

/****************************ﬁ**********************************

* main (User) *
* Input - Parameter: *
* argv([l]: MacroFile *

***********i**************i************************************/
main (argc,argv)
UWORD argc;
BYTE **argv;
{
UWORD i;
if (argc != 2)
{
printf ("USAGE: %s MacroFile\n",argv([0]);
CloseIt ("");:
}
FileHandle = Open (argv(1l],MODE_OLDFILE);

if (FileHandle == 0) Closelt ("File does not exist!!!");
if (Read (FileHandle, &Length,4l) != 4)/* Number of events */
Closelt ("Read Error #1 !!!"); /* Events cannot be */
/* read *x/
Player = AllocMem (Length*INEV_LEN, MEMTYPE) ;
if (Player == 0) CloselIt ("No Memory !!!");

/* Memory for Length-Events occupied*/
if (Read (FileHandle,Player,Length*INEV_LEN) !=
Length*INEV_LEN)
CloseIt ("Read-Error #2 !'!'!");
Close (FileHandle);
Open_A Device ("input.device",0l, &InputRequest,0l,INPUT LEN);

for (i=0;i<Length;i++) /* rather small cost, isn't 1t? */
Input_WriteEvent (InputRequest,&Player(i]);

Close_A Device (InputRequest);

FreeMem (Player,Length*INEV_LEN);
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This program shows you how to open and use a device with as little
effort as possible. The program section that sends out the input events
consist of only three functions and a control instruction (for (; ;) ;).
You find the compiled programs Recorder and Play on the optional disk
in the CH-4/4 . 8 directory. We have also included a macro in this
directory. You can play it back by entering the directory and entering:

Play Macro

4.8.3

Setting repeat
speed

The input device, mouse and keyboard

Now let's look at the input device commands which access the mouse
and keyboard. You may want to re-read Section 4.7, since much of the
material concemning the gameport device also applies to the input
device.

This section also examines the similarities between the Preferences
program and the input device.

The Preferences program offers the option of changing the key repeat
speed. This parameter controls the speed at which a key repeats when
the user presses and holds the key. The key repeat speed is set from
Preferences using slider gadgets. When booting, the system reads the
repeat rate from the devs/system configuration file and places the
value in IND_SETTHRESH. If you want to change the repeat speed
after booting, you must load the Preferences program, change the repeat
speed and exit to the Workbench. The following routine allows you to
change the repeat speed without returning to Preferences:

/% KAk ke ok ok sk ok ok ek ek o ok 3 ok sk ok ok e ok ke ok o ok ok ok e ke ke ok ok kb ok ok ok ok ko

Input_SetPeriod() (Input_Support)*
*

Function: Set repeat period

Input - Parameter:

InputRequest: Input-Device~Block

Secs, Micro: Time that should pass between two repetitions
**********t***t*************************t***t**************tt**/

¥ % o N O X % *

* % ok * * %

VOID Input_SetPeriod (InputRequest, Secs,Micro)
struct timerequest *InputRequest;
ULONG Secs,Micro;
{
InputRequest->tr time.tv_secs
InputRequest->tr time.tv_micro

Secs;
Micro;

Do_Command (InputRequest, (UWORD)IND_SETPERIOD);
}
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You only need to give this routine the time that should pass between
two repetitions of a pressed key.

When you press and hold a key, the key delays before beginning key
repeat. The time that passes between the pressing down and the
repetition of a key is called the repeat threshold. You can completely
change this threshold with the following routine.

/**************i************************************************

Input_SetThresh() (Input_Support)*
*

Function: Set repeat time thresholden

Input - Parameter:

InputRequest: Input-Device-Block
Secs, Micro: After how many seconds and micro seconds the
key should be repeated

***********t**********i**t****i********************************/

* % % % % X % * *
* % * % X X H

VOID Input_SetThresh (InputRequest, Secs,Micro)
struct timerequest *InputRequest; VAR R R RV
ULONG Secs,Micro;
{
InputRequest->tr time.tv_secs = Secs;

InputRequest->tr_time.tv_micro = Micro;

Do_Command (InputRequest, (UNORD) IND SETTHRESH);
}

Try a threshold of zero seconds and zero microseconds. Run the
program, press a key and watch the result.

Now from the keyboard to the mouse. Here's one of the input device
functions usually reached through Preferences:

/****************t*t*********i**********************************

* Input SetMTrig() {Input Support)*
* Function: Set threshold for mouse movement - *
* - —_——- ———— *
* Input - Parameter: *
* InputRequest: Input-Device-Block *
* Keys: Mouse button pressed or released? *
* Timeout: Send mouse report after how many VBlanks? *
* XDelta,YDelta: Announce after n mouse movements? *

**********k****************************************************/
VOID Input_SetMTrig (InputRequest,Keys,Timeout,XDelta,YDelta)

struct IOStdReq *InputRequest;
ULONG Keys, Timeout ,XDelta, YDelta;
{

struct GamePortTrigger GPT;

GPT.gpt_Keys = Keys;

GPT.gpt_Timeout = Timeout;

GPT.gpt_XDelta = XDelta;

GPT.gpt_YDelta = YDelta;

InputRequest->io Data
InputRequest->io_Length
GamePortTrigger));

(APTR) &GPT,;
(ULONG) (sizeof (struct
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Do_Command (InputRequest, (UWORD) IND SETMTRIG);
}

This routine informs the input device of how many pulses the mouse
should announce for one move in the X or Y direction. As mentioned
above, there are two shafts fitted with wheels perpendicular to each
other inside of the mouse. These wheels have holes drilled in them.
When moving the mouse, each wheel rotates, interrupting a light
source. This pulse is then sent to the input device, or the input device
reads this pulse from the hardware register.

When the number of this pulse of the given value has been reached, the
input device ensures that the mouse pointer moves to a point on the
screen. XDelta and YDelta give the number of the pulse in the X
and Y direction by which the mouse pointer was moved to a point on
the screen. The larger this value is, the slower the mouse is.

The Timeout parameter helps you determine the number of vertical
blanks after which a mouse report or mouse event should be sent, in
case the mouse is not moved extensively. The parameter has the value
1 (for Intuition). The mouse position is renewed after each vertical
blank in the Intuition window, or on the Intuition screen. The Keys
parameter allows the system to announce the release of a mouse button
(GPTF_UPKEYS) instead of pressing down a mouse button
(GPTF_DOWNKEYS).

The following routine allows the user to connect the mouse to the
second gameport instead of the default first gameport.

/**********i***************t********t**********t****************

* Input_SetMPort () (Input_Support) *
* Function: Set mouse port *

K e e e - = ———————————— -— *
* Input - Parameter: *
* InputRequest: Input-Device-Block *
* Port: 0: GamePort 1 *
* 1: GamePort 2 *

***********i****i**i***********i***i**i**********t***t*********/
VOID Input_SetMPort (InputRequest,Port)
struct IOStdReq *InputRequest;
UBYTE Port;
{
UBYTE PointerToPort;
PointerToPort = Port;
InputRequest->io_Data = (APTR) &PointerToPort;
InputRequest->io Length = (ULONG) 1;

Do_Command (InputRequest, (UWORD) IND_ SETMPORT) ;
}

You must give this routine the input device block and a one or zero.
Then, depending on which value you entered, the mouse is read from
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gameport 1 or gameport 2. Remember that the address must be given
on the value 1 or 0 with this command.

You can change the mouse controller as well as the mouse port. For
example, this means that a joystick can take over almost all the
functions of the mouse, except for the right mouse button. The
following routine executes this.

/***************************************************************

* Input_SetMType () (Input_Support) *
* Function: Set mouse controller type *
K e e e e e e —— e —— *
* Input - Parameter: *
* InputRequest: Input-~Device-Block *

*

* Type: new controller type
***************************************************************/
VOID Input_SetMType (InputRequest,Type)
struct IOStdReq *InputRequest;
UBYTE Type;
{
UBYTE MouseType;
MouseType = Type;
InputRequest->io Data (APTR) &MouseType;
InputRequest->io_Length = 11;
Do_Command (InputRequest, (UWORD) IND SETMTYPE);

[]

}

The new controller type is given in Type:

GPCT_MOUSE: mouse in the port
GPCT_RELJOYSTICK: relative joystick in the port
GPCT _ABSJOYSTICK: absolute joystick in the port

GPCT_NOCONTROLLER: nothing more in the port

Remember that this command must include the address of the type.
That is why the given parameter is written in an extra variable, whose
address is given in the device block.

The following is the start of the Input_Support.c file:

/***************************************i*i*i*******************

* Input_Support.c *

* Compile-Info: cc Input_Support *
****************************************i*********t*****t******/
#include "exec/types.h"

#include "exec/memory.h"

#include "exec/interrupts.h"

#include "exec/nodes.h"

#include "devices/input.h"

#include "devices/gameport.h"

#include "devices/timer.h"

#include "devices/inputevent.h"

ULONG User Routine;

#define INEV_LEN { (ULONG) (sizeof (struct InputEvent)))
VOID Input Code();

struct Interrupt Input Handler;
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4.9

The console device

The console device is the simplest method used to display text on the
screen. A window must first be opened. The console device can read
your input from this window, and the console device can activate the
output. The opened window is specified before the opening of the
console device in the corresponding device block.

struct IOstReq *ConsoleRead = 0L;
#define CON_LEN ( ULONG) (sizeof(struct IOStdReq))

Window = OpenWindow (&NewWindow) ;

ConsoleRead = (struct IOstdReq *)GetDeviceBlock (CON_LEN);
ConsoleRead->io _Data = (APTR) Window;
ConsoleRead->io_Length = (ULONG) (sizeof(struct Window));
Open_A Device("console.device", 0L, &ConsoleRead, OL, OL);

You can now access the console device. The console device supports
the following commands:

CMD_READ ) read keypress

CMD_WRITE 3) display text

CMD_CLEAR ®) clear console buffer

CD_ASKKEYMAP ) send current keyboard layout

CD_SETKEYMAP (10) set new keyboard
arrangement

CD_ASKDEFAULTKEYMAP (11) find out default keyboard
arrangement

CD_SETDEFAULTKEYMAP (12) set default keyboard
arrangement

As you see, the console device uses few commands, but they play an
important role in developing such complicated applications as editors
(see DiskEd), word processors, etc.

The console device is controlled through command strings. These are
sent to the console device with the help of the command CMD_WRITE.
You should prepare another device block for the CMD_WRITE
command so that the READ and WRITE commands do not interfere
with each other:

struct IOStdReq *ConsoleWrite = OL;

ConsoleWrite = (struct IOStdReq*) GetDeviceBlock (CON_LEN) ;
Console_Copy (ConsoleRead, ConsoleCopy);
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Combine the following routines labled (Con_Support) to form the
Con_Support.c file, don't forget to include the proper header files.
Some structure elements must be borrowed for accessing the second
device block:

/***t**t**t*********t*************************t*****************

Console_Copy () (Con_Support) *
*

Function: Device-Block copy

Input - Parameter:

OldStdReq: Original
NewStdReq: Copy
*********************************************tt************t***/
VOID Console_Copy (OldStdReq, NewStdReq)

struct IOStdReq  *OldStdReq,*NewStdReq;

{

* % % % Ok % %

* % % % % %

NewStdReq->io Device =
OldstdReq->io_Device;

NewStdReg->io_Unit =
OldstdReg->io Unit;
}

The following routine reads keypresses with Console_Read () and
Console_Write () and displays them on the screen:

/************************************************t**************

Console Write() (Con_Support) *
*

Function: Display string on Console-Device

Input - Parameter:

ConWrite: Device-Block
String: String to be displayed
Len: Length of string

ii*****it**********t***********************************t******t/

* % % % % H * %
%* % % % % % *

VOID Console Write (ConWrite,String,Len)
struct IOStdReq *ConWrite;
BYTE *String;
ULONG Len;
{
ConWrite->io_Data (APTR) String;
ConWrite->io_Length = Len;
Do_Command (ConWrite, (UWORD)CMD_WRITE);

}

/t************************t**************************t********t*

Console Read() (Con_Support)*
*

Function: Read string from Console-Device

Input - Parameter:
ConWrite: Device-Block
String: Address of the buffers

Len: How many characters to be read
********************************************************t*t****/

* % % X X % H %

* % % X % %
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VOID Console Read (ConRead,String,Len)
struct IOStdReq *ConRead;
BYTE *String;
ULONG Len;
{
ConRead->io_Data
ConRead->io_lLength
ConRead->io_Command

(APTR) String;
Len;
(UWORD) CMD_READ;

DoIO (ConRead) ;
}

In addition to the device block, these routines give you the address of
the string to be displayed, or the address of the range of memory into
which the read keypress should be written. It also gives you the number
of characters to be displayed or read. If you enter -11 as the number of
characters to be displayed, all of the strings that end with a null byte are

displayed.

When you read keypresses from the keyboard by means of
Console_Read(), it returns the ASCII code that represents the
depressed key. Remember that this is not automatically displayed. You
must provide for the output yourself by means of
Console_Write () or CMD_WRITE. As was already mentioned, a
certain number of control strings exist with which you can test for the
form of the input and output:

BELL (0x7)
Screen flashes and tone sounds.

BACKSPACE (0x08)
Moves the cursor one position to the left. The character to the left of
the cursor is not deleted. You can delete the character by combining a
backspace and a space.

LINE FEED (0xOa)
Moves the cursor one position down. When the cursor arrives at the
bottom line of the screen, the screen scrolls up one line (see SET
MODE).

VERTICAL TAB (0xOb)
Moves the cursor one line up. When the cursor arrives at the top line of
the screen, the screen scrolls down one line.

FORM FEED (0x0Oc)
Clears the console window.

CR (0x0d)
Places the cursor in the first column but not in the next line.
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SHIFT IN (0xOe)

Enables <Shift> key.

SHIFT OUT (0x0f)

Disables <Shift> key. Only capital letters are displayed in the output.

CAPS LOCK Key

See keyboard layout.
ESC (0x1lb)
<Escape> key.
CSI (0x9b)
Control Sequence Introducer. All command strings begin with this
ASCII code.
RESET ("<CSI>c")
Resets the console device.
INSERT [N] SPACES ("<CSI>[N]@")

CURSOR

CURSOR

CURSOR

CURSOR

CURSOR

114

Inserts N spaces starting at the current cursor position. When N is
omitted, one space is inserted. N is a decimal string. For example,
"<CSI>12@" inserts 12 spaces. @ represents the ASCII code 64.

UP [N] ("<CSI>[N]A")
Moves the cursor N lines up. When N is omitted, the cursor moves up
one line. N is a decimal string. For example, "<CSI>2A" moves the
cursor up two lines.

DOWN [N] ("<CSI>[N]B")
Moves the cursor N lines down. When N is omitted, the cursor moves
down one line. N is a decimal string. For example, "<CSI>2B" moves
the cursor down two lines.

FORWARD [N] ("<CSI>[N]C")
Moves the cursor N columns to the right. When N is omitted, the
cursor moves right one column. N is a decimal string. For example,
"<CSI>20C" moves the cursor 20 characters to the right.

BACKWARD [N] ("<CSI>[N]D")
Moves the cursor N columns to the left. When N is omitted, the cursor
moves left one column. N is a decimal string. For example,
"<CSI>20D" moves the cursor 20 characters to the left.

NEXT LINE [N] ("<CSI>[N]E")
Moves the cursor N lines down and to the first column (has the same
effect as pressing the <Return> key).
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CURSOR PRECEDING LINE [N] ("<CSI>[N]F")
Moves the cursor N lines up and to the first column.

MOVE CURSOR ("<CSI>[N][:;M]H")
Moves cursor to line N and, if given, column M. If the M parameter is
omitted, the semicolon must be omitted as well. For example,
"<CSI>1;1H" or "<CSI>1H" or "<CSI>H" each places the cursor in
the upper left comner of the screen (same as Cursor home).

ERASE TO END OF DISPLAY ("<CSI>J")
Clears the screen from the current cursor position to the end of the
screen. To clear the entire screen, you can use the following sequence:
"<CSI>1;1;H" (Cursor home) and "<CSI>J" (Delete).

ERASE TO END OF LINE ("<CSI>K")
Deletes line from the current cursor position to the end of the current
line (same as <Ctrl><Y> function in ED).

INSERT LINE ("<CSI>L")
Inserts a line at the current cursor position.

DELETE LINE ("<CSI>M")
Deletes the line at the current cursor position. Lines below the deleted
line scroll up to fill in the deletion (same as <Ctrl><B> function in
ED).

DELETE CHARACTER ("<CSI>[N]P")
Deletes N characters to the right of the current cursor position. If the N
parameter is omitted, only the character at the current cursor position is
deleted.

SCROLL UP [N] LINES ("<CSI>[N]S")
Scrolls the entire screen up N lines. The blank lines below fill with
blank spaces.

SCROLL DOWN [N] LINES ("<CSI>[N]T")
Scrolls the entire screen down N lines. The blank lines above fill with
blank spaces.

SET MODE ("<CSI>20h")
Treats a line feed as <Return><Line feed> (0x0c,0x0a). The cursor
moves to the first column of the next line.

RESET MODE ("<CsI>20L")
Treats a line feed as <Line feed> only when a line feed is sent (0x0a),
the cursor moves to the next line but remains in the same column.
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DEVICE STATUS REPORT ("<CSI>6n")
Instructs the console device to send a status report in the following
form: "<CSI>Line; ColumnR". There are decimal strings in Line
and Column which give the line and column of the cursor position.
This report can be read using CMD_READ. Remember that you must
convert the decimal strings to decimal values if you want to calculate
them to determine a new position.

SELECT GRAPHIC Style
("<CSI><Style>;<Foreground>; <Background>n")
Selects character attribute (style), foreground color and background

color.
<Style> The Style parameter allows the following values:
0 normal text
1 bold print
3 italics
4 underline
7 inverse

You give the foreground and background color of the characters to be
displayed with Foreground and Background:

<Foreground>
30 Color0
31 Colorl
37 Color7
<Background>
40 Color0
41 Color 1
47  Color 7

For example, if you want the text displayed underlined and bold and in
colors 0 and 1, you must send the following sequence:

"<CSI>4;30;40m" (underline, without color)
"<CSI>1;30;41m" (bold, with color)
All parameters must be entered.

SET PAGE LENGTH ("<CSI><LEN>t")
Specifies the number of lines that the console device should control in
the window. The entire window is usually allocated for text output, but
you can reduce the text area with this and the following commands.
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SET

SET

SET

‘When changing the size of the window the console device calculates the
new value from the current character set and alters the size of the text
range correspondingly. This happens only if you have not established
your own values. When you want the console device to manage the size
of the window or the text range by itself, you must call the commands
with statements of values, for example "<CSI>t".

LINE WIDTH ("<CSI><width>u")
Specifies the number of characters per line. You can use the remaining

space for graphics.

LEFT OFFSET ("<CSI><offset>x")
Specifies the starting vertical raster line (not column) at which the text
range should start. For example,"<CSI>8x" uses eight lines of space in
the left window margin for small graphics, scroll bars, etc.

TOP OFFSET ("<CSI><offset>y")
Specifies the starting horizontal raster line (not text line) at which the
text range should start. The remaining space can be used for displaying
graphics, tab positions, etc.

CURSOR ON ("<CSI>0 p")

Enables cursor.

CURSOR OFF ("<CSI> p")

Disables cursor.

WINDOW STATUS ("<CSI>o q")

RAW

Sends window status request. The system returns a status report in the
following form, readable using CMD_READ:

"<CSI>1;1;,<bottom border>;right border> r"

The window status report returns the positions of the upper left corner
(1,1) and the lower right corner.

EVENTS
Requests additional information about the system from the console
device. For this you must inform the console device which RAW

EVENTS you want to see:

0 no operation

1 keypress and the release of the key
2 mouse button pressed

3 window was activated

4 mouse pointer position

5 unused

6 timer events
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7 gadget clicked

8 gadget released

9 requester displayed
10  menu selected

11  close gadget clicked
12 window resized

13 window redrawn

14  Preferences changed
15  disk removed

16  diskinserted

The RAW EVENTS read through the console device are identical to
those events accessible from the input device. Here too the
corresponding flags for checking the event must be set. The following
syntax sends the required events:

<CSI>Event number({

The events return in the following format:

"<CSI><Class>;<SubClass>; <KeyCode>; <Qualifiers>; <X>; <Y¥>;<Seconds
>; <MicroSeconds>|"

When you look at the input event structure, you determine large
coincidences between this structure and the control string, which are
sanded from the console device. Each decimal string means the
following:

<Class> Returns the number of results received from the console device. You
can check multiple results of all of the results from the console device.
For example, if you want keypresses and mouse button clicks to be
returned, you can access them through "<Ccs1>1 {" followed by
"<CSI>2{",or simply through "<CSI>1;2{".

<SubClass> Most often contains the value 0. SubClass contains the value 1 only
when the mouse is plugged into gameport 2.

<KeyCode> Contains the decimal string that indicates the keyboard code of the
pressed or released key (see Section 4.8).

<Qualifiers>
Indicates which of the <Cirl>, <Alt> and <Shift> keys was pressed.
1 left <Shift>
2 right <Shift>
4 <Caps lock>
8 <Ctrl>
16 left <Alt>
32 right <Alt>
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64 left <Amiga>

128 right <Amiga>

256 numeric keypad key

512 key repeated (repeat function)

1024 interrupt (unused)

2048 multi broadcast (result for current window)
4096 left mouse button

8192 middle mouse button (unused)

16384 right mouse button

32768 relative mouse movement

When multiple Qualifiers are pressed, the corresponding values are
added and given in <Qualifier>.

<X> <Y> Returns the relative mouse movement or the address of the chosen
gadget (X<<16+Y).

<Seconds>  Retumns the system time in seconds.

<Microseconds>

Returns the system time in microseconds.

The user must decode the string supplied by the console device and
interpret the values found there. It takes little time to calculate how
much more he gets directly though the IDCMP flags of the events and
the keyboard code.

Now that we've described all of the control strings that can be sent and
received, we have here a short application that you can enter, compile,
link and run. This console device editor allows you to enter control
strings from the keyboard and watch the result firsthand. Because the
control sequence can be chosen by sources other than through the
keyboard, we check the escape key and interpret Escape as <CSI>. You
can get out of the editor by entering <q><Return>.

Combine all of the Con_Support routines presented in this chapter to
form the Con_Support.c program. Compile the Con_Support.c
program and link it to the following program. Don't forget the proper
include files in the Con_Support.c file (exec/types.h, exec/memory.h,
exec/devices.h, devices/console.h, devices/keymap.h)

/*************i***i***************t*****************************

* Conni.c *
* (c) Bruno Jennrich *
* August 1988 *

*****i***************************************i*****************/
/****ti**i*ti**i**i*******tt*tt*t******************t************

* Compile-Info: *
* cc Conni.c *
* ln Conni.o Con_Support.o Devs_Support.o -lc *

*ii*i*i***************i****************************************/
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#include "exec/types.h"

#include "exec/mermory.h"

#include "exec/devices.h"

#include “"devices/console.h"
#include "devices/keymap.h"

#include "intuition/intuitionbase.h"
#include "intuition/intuition.h"

$define MEMTYPE
#define CON_LEN (ULONG) (sizeof (stru
VOID *Open();

VOID *AllocMem();

VOID *GetDeviceBlock{);

VOID *OpenLibrary();

VOID *OpenScreen();

VOID *OpenWindow () ;

struct Screen *Screen =
struct Window *Window
struct IntuitionBase *IntuitionBase

struct NewScreen NewScreen = {

Yo

struct NewWindow NewWindow = {

Editor (c¢) Bruno Jennrich",

}:

struct IOStdReq *ConsoleRead = 01,

(MEMF_CHIP | MEMF_CLEAR)

ct I0StdReq))

01;
01;
01;

0,0, 640,200, 4,
0,1,

HIRES,
CUSTOMSCREEN,
01,
(UBYTE*)
01,

01

"No Name",

0,0,

640,200,

0,1,

01,

(ULONG) ACTIVATE,
01,

01,
(UBYTE*) "Console-Device-
01,

01,

0,0,

0,0,

CUSTOMSCREEN

* % ok % *

*

*ConsoleWrite = 01;
/************t**t****************t******************************
Closelt() (User) *
*
Function: In case of erro rclose everything *
*
Input - Parameter: *
*
*

* String: Error-Message

t***t************t******t**t*********************************t*/
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VOID Closelt (String)

char *String;

{
UWORD i;
UWORD *dff180 = (UWORD *)Oxdff180;
UWORD Error = 0;

if (strlen (String) > 0l)

{
for (i=0;i<Oxffff;i++) *dffl80 = i;
puts (String);

Error = 10;
}
if (Window != 01) CloseWindow (Window);
if (Screen != 01) CloseScreen (Screen);

if (IntuitionBase != 0l) CloseLibrary (IntuitionBase);

if (ConsoleRead != 0) Close A Device (ConsoleRead);
if (ConsoleWrite != 0) FreeDeviceBlock (ConsoleWrite);
exit (Error);

/***************************************************************
* Open_Screen_and Window () (User)*
* *
* Function: Open editor screen and window *
***************************************************************/

VOID Open Screen_and Window ()
{

IntuitionBase = (struct IntuitionBase¥*)
OpenLibrary ("intuition.library",01);
if (IntuitionBase == 01) Closelt ("No IntuitionBase !");

Screen = (struct Screen *) OpenScreen (&NewScreen);
if (Screen == 0l) CloseIt ("No Screen !");

NewWindow.Screen = Screen;

Window = (struct Window *) OpenWindow (&NewWindow);
if (Window == 0l1) CloselIt ("No Window !");

/***************************************************************
* Close_Screen_and_ Window () (User) *
* *

* Function: Close editor screen and window
***************************************************************/

*

VOID Close Screen and_Window ()

{
CloseWindow (Window);
CloseScreen (Screen);
CloseLibrary (IntuitionBase);

121



4. DEVICES ADVANCED SYSTEM PROGRAMMER'S GUIDE

/*************************************i*************************

* main() (User) *
* *
%% o 3 3 I e 3 e e sk e e ok ok e 3k ok ok ke ok ok ok ok ok ok ok ok 3k ok ok ok Ik 3k % ok ok ok i******i*ii****i******/
main ()
{

UWORD 1i;

BYTE InputString[256];

BYTE *BufPointer; /* Actual input position inside */

/* of InputString x/
UWORD Pos; /* Number chars in InputString */
BOOL Quit = FALSE; /* Programm ended ? */

BOOL Return = FALSE; /* Return pressed ? */
Open_Screen_and Window () ;

ConsoleRead
ConsoleWrite

(struct IOStdReq *)GetDeviceBlock (CON_LEN);
(struct IOStdReq *)GetDeviceBlock (CON_LEN) ;

(APTR) Window;
(ULONG) (sizeof (struct Window));

ConsoleRead->io Data
ConsoleRead->io_length

o

Open_A Device ("console.device",0l,&ConsoleRead,01,01);
Console Copy (ConsoleRead,ConsoleWrite);

BufPointer = InputString;
Pos = 0;
while (!Quit)
(
while (!Return)
{
*BufPointer = (BYTE)O;
Console Read (ConsoleRead,BufPointer,1l);
if (*BufPointer == (BYTE)Ox08) /* Backspace */
{
if (Pos>0)
{
*BufPointer = (BYTE)O;
BufPointer--;
if (*BufPointer == (BYTE) O0xlb)
{ /*< C s I > %/
Console Write
(ConsoleWrite, "\010\010\010\010\010",-11);
Console Write (ConsoleWrite," n,=11);
Console Write
(ConsoleWrite, "\010\010\010\010\010",-11);
}
else
{
Console Write (ConsoleWrite,"\010%,11);
Console Write (ConsoleWrite," ",11);
Console Write (ConsoleWrite,"\010",11);
}
*BufPointer = (BYTE)O;
Pos--;
}
}
else
{
if (Pos <256)
{
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if (*BufPointer == (BYTE) Ox9b)
{ /* Replace revieved CSI with 0x07 */
*BufPointer = 0x7;
}
if (*BufPointer == 0x0d) /* Return */
{
Return = TRUE;
Console Write (ConsoleWrite,™\012%,11);
if (*InputString == 'q') Quit = TRUE;
/* ‘q' pressed ? */
}
else
if (*BufPointer == 0x1b) /* Escape */
{
Console_Write (ConsoleWrite,"<CSI>",51);

}
else Console Write (ConsoleWrite,BufPointer,1l);

BufPointer++;
Pos++;

}
}
Return = FALSE;
*BufPointer = (BYTE)O;

if (*InputString == (BYTE)Ox1lb)

{ /* Display control string after Return */
*InputString = (BYTE) Ox9b;
Console Write (ConsoleWrite,InputString,-11);

}

BufPointer = InputString;

Pos = 0;

}

Close A Device (ConsoleRead);
FreeDeviceBlock (ConsoleWrite);

Close_Screen_and Window();

}

Once you enter "<CSI>1{" there is no going back.

The <CSI> codes are replaced with BELLs (0x07) when the control
strings are received. Many of the keypresses (e.g., cursor keys) also
send a <CSI>. Therefore, cursor keys and function keys may not work.
One last item of interest: The control codes listed above also function
in a CON: window. To see if the ConIn program works press the
<Esc> <0> <p> to turn off the cursor, then <Esc> <p> to turn is back
on.
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Key mapping

The console device allows the option of overlaying new keys. This
makes it possible to print a string like "Hello people, how are you?" in
response to a single keypress. The console device gets the key code of
the character that was pressed from the input device by way of the
keyboard device. The console then extracts the ASCII code from the
tables that correspond to the key that was pressed and gives this to the
user. You can change this table, provided you know the keymap
structure:

Offset Structure

struct KeyMap
{

0 0x00 UBYTE *km LoKeyMapTypes;
4 0x04 ULONG *km LoKeyMap;
8 0x08 UBYTE *km LoCapsable;
12 0x0c UBYTE *km LoRepeatable;
16 0x10 UBYTE *km HiKeyMapTypes;
20 O0x14 ULONG *km HiKeyMap;
24 0x18 UBYTE *km HiCapsable;
28 0Oxlc UBYTE *km HiRepeatable;

32 0x20 } /* defined in "devices/keymaps.h" */

This structure contains the pointer to memory ranges that compare
what was sent with a certain keypress in the console device. The
difference between Hi and Lo map is important. The Lo keymap
contains the data for key codes 0x0 through Ox3f. The Hi keymap
contains the data for key codes 0x40-0x67.

Next we need the KeyMapTypes and the KeyMap. The pointers
km_ LoKeyMapTypes and km_HiKeyMapTypes point to a byte
array which determines which qualifier (<Shift>, <Al>, <Ctrl>) is
supported by the key, or if a string (KCF_STRING) should be sent
instead of a simple ASCII code. The following values are allowed:

#define KC NOQUAL  0x00

#define KCF_SHIFT  0x01

#define KCF_ALT 0x02

#define KCF_CONTROL 0x04

#define KC_VANILIA O0x07 /* Shift+Alt+Ctrl */
#define KCF_STRING 0x40 /* String */

/* defined in "devices/keymaps.h" */
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The ASCII codes that should be sent if a single key or a key with a
qualifier is pressed are saved in km_LoKeyMap and km_HiKeyMap.
This memory area is a long word array (4 bytes = 4 ASCII codes).

The result is that a key can support only two qualifiers (e.g.,
<Shift><Alt> or <Ctrl><Alt>). ASCII codes are sent when a single
key is pressed, when a key is pressed in conjunction with one of the
qualifiers (e.g., <Shift> or <Alt>), and when a key is pressed in
conjunction with two qualifiers (e.g., <Shift><Alt>).

By using strings instead of simpler ASCII codes, up to eight different
strings can be sent out based on a single key and the corresponding
qualifier. Let's look at a German keymap that makes simple ASCII
codes available as strings:

#asm
;ownkeymap.asm (c) Bruno Jennrich

KC_NOQUAL equ 0
KC_VANILIA equ 7
KCF_SHIFT equ 1
KCF_ALT equ 2
KCF_CONTROL equ 4
KCF_STRING equ 64
CSI equ $9b

public _LoKeyMapTypes
even

_LoKeyMapTypes:
dc.b KC_VANILIA ;$00 Tilde
dc.b KC_VANILIA ;01 1
dc.b KC_VANILLA ;502 2
dc.b KC_VANILLA ;503 3
dc.b KC_VANILLA ;504 4
dc.b KC_VANILLA ;805 5
dc.b KC_VANILLA 7506 6
dc.b KC_VANILLA ;507 7
dc.b KC_VANILLA ;508 8
dc.b KC_VANILLA ;509 9
dc.b KC_VANILLA ;$0a 0
dc.b KC_VANILLA ;$0b _
dc.b KC_VANILLA ;$0c '
dc.b KC_VANILLA ;$0d \
dc.b 0 ;$0e undefinied [RERERE
dec.b 0 ; $0e undefinied
dc.b KC_NOQUAL ;$0f 0 (Number field)
dc.b KC_VANILLA ;810 q
dc.b KC_VANILIA ;511 w
dc.b KC_VANILLA ;512 e
dc.b KC_VANILLA ;%13 r
dc.b KC_VANILLA ;514 t
dc.b KC_VANILLA ;815 z , y on US keyboard
dc.b KC_VANILLA ;816 u
dc.b KC_VANILLA ;817 i
dc.b KC_VANILLA ;818 (<]
dc.b KC_VANILLA ;819 P
dc.b KC_VANILLA ;$1a |
dc.b KC_VANILLA ;$1b +
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dec.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dec.b
dec.b
dc.b
dec.b
dec.b
dc.b
dec.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dec.b
dc.b
dec.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
de.b
dc.b

0
KC_NOQUAL
KC_NOQUAL
KC_NOQUAL
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
0

0
KC_NOQUAL
KC_NOQUAL
KC_NOQUAL
0
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
KC_VANILLA
0
KC_NOQUAL
KC_NOQUAL
KC_NOQUAL
KC_NOQUAL

public _LoKeyMap

even

_LoKeyMap:

dec.b
dc.b
dec.b
de.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dc.b
dec.b
dc.b
dc.b
de.1l
dec.1
dc.b
dc.b
dc.b
dc.b
dec.b
dc.b

w.nw nwin II]II "[ll
’ ’ ’

$21+$80,$31+%$80,"!", "1™
$22+580, $32+4$80, $22, 2"
$a7+5$80, $33+$80, """, "3"
$24+$80, $34+%80, "$", "4"
$25+4$80, $35+$80, "$", "5"
$26+$80, $36+%$80, "&", "6"
$2£+$80, $37+580, /", "7
$28+$80, $38+$80' " (II' ll8"
$29+$80, $39+$80, ") ", ngn
$3d+5$80, $30+$80, "=","0"
$3£+$80, $Af+580, "2", " "
$27+$80,$60+380, """, """
$7c+$80, $5¢+$80, ", "\"
$0

$0

$00,$00,$00,"0"
$51+$80, $71+$80’ ngw, nqn
$57+$80, $77+$80, "W", "w"
$45+$80, $65+$80, "E", "e"
$52+$80, $72+$80, "R", "r"
$54+%$80, $74+$80, "T", "t

;$lc
;$1d
;Sle
;$1f
;520
;821
;822
;823
;824
;825
;5826
;827
;528
3829
;$2a
;$2b
;$2c
;$2d
; $2e
;52
;530
;831
;832
;833
;834
;835
;836
;837
;638
;839
;83a
;$3b
;8$3c
;%3d
;$3e
; $3f
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undefinied

1 (Number field)
2 (Number field)
3 (Number field)
a

s

d

f

g

h

3

13

1

v

d

reserved
undefinied

4 (Number field)
5 (Number field)
6 (Number field)
reserved

Y, z on US keyboard
X

c

v

b

n

m

undefinied

, (Number field)
7 (Number field)
8 (Number field)
9 (Number field)
;500 [

;601 1

;502 2

;503 3

;504 4

;$05 5

;506 6

;807 7

;508 8

;509 9

;$0a 0

;$0b _

;$0c '

;$0d \

;$0e undefinied
;$0e undefinied
;80f 0 (Number field)
;810 q

;811 w

;812 e

;$13 r

;514 t
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dc.b $5a+$80, $7a+$80, 2", "z" ;815 z, y on US
dc.b $55+$80, $75+$80, "U", "u" ;816 u
dc.b $49+5$80,$69+$80,"I","i" ;817 i
dc.b $4£+580, $6£+580, "O", "o" ;518 o
dc.b $50+$80, $70+$80, "P", "p" ;819 P
dc.b $dc+$80, $fc+$80, "\", " (" ;$1a |
dc.b $2a+580, $2b+$80, "x", nyn ;$1b +
dc.b $00, $00, $00, $00 ;81lc undefinied
dec.b $00,$00,%$00,"1" ;81d 1 (Number field)
dec.b $00,$00,500,"2" ;81le 2 (Number field)
dec.b $00,$00,$00,"3" ;$1f 3 (Number field)
dc.b $41+5$80, $61+$80, "A", "a" ;$20 a
dc.b $53+$80,$73+$80, "s", "s" ;821 s
dc.b $44+$80, $64+$80, "D", "d" ;822 d
dc.b $46+580, $66+$80, "F", "f" ;623 f
dc.b $47+5$80,$67+$80, "G", "g" ;%24 g
dc.b $48+$80, $68+$80, "H", "h" ;825 h
dc.b $4a+$80, $6a+5$80,"J", "j" ;826 3j
dc.b $4b+$80, $6b+$80, "K", "k" ;827 k
dc.b $4c+$80,$6c+$80, "L", "1" ;528 1
dc.b $d6+$80, $£6+580, V", "v" ;829 v
dc.b $c4+580, $ed4+$80, D", "d" ;$2a d
de.b $00,$00,$00,5$00 +52b reservied
dec.b $00,$00,$00,$00 ;$2¢c undefined
de.b $00,$00,$00,"4" ;82d 4 (Number field)
dec.b $00,$00,$00,"5" ;$2e 5 (Number field)
dec.b $00,%$00,%$00,"6" ;82f 6 (Number field)
dec.b $00, $00, $00, $00 :$30 reserved
dc.b $59+$80,$79+580, "y", "y" ;831 Yy, z on US
dc.b $58+580, $78+$80, "X", "x" ;832 X
dc.b $43+$80, $63+580, "C", "c" ;833 c
dc.b $56+580, $76+$80, "V, "y" ;834 v
dc.b $42+580, $62+$80, "B", "b" ;835 b
dc.b $4e+$80, $6e+$80, "N", "n" ;%36 n
dc.b $4f+$80,$6£+$80, "M", "m" ;837 m
dc.b $3b+$80, $2c+$80,"; ", ", " ;$38 ’
dc.b $3a+$80, $2e+$80,":", " .® ;$39 .
dc.b $5f+$80, $2d+%$80,"_","-" ;$3a -
dc.b $00,$00,$00,$00 ;$3b undefined
dc.b $00,$00,%00,"," ;83c , (Number field)
dc.b $00,$00,5$00,"1" ;$3d 7 (Number field)
dc.b $00,%$00,$00,%2" ;83e 8 (Number field)
de.b $00,500,$00,"3" ;$3f 9 (Number field)
public _HiKeyMapTypes
even
_HiKeyMapTypes:
dc.b KC_NOQUAL 2840 Space
dc.b KC_NOQUAL ;841 BackSpace
dc.b KC_NOQUAL ;842 Tab
dc.b KC_NOQUAL ;543 Enter
dc.b KC_NOQUAL ;544 Return
dc.b KC_NOQUAL ;845 Escape
dc.b KC_NOQUAL ;846 Delete
de.b 0 ;847 undefined
dc.b 0 ;848 undefined
dc.b 0 ;849 undefined
dc.b KC_NOQUAL ;$4a Number feild
de.b 0 ;$4b undefined
dc.b KCF_STRING+KCF_SHIFT ;$4c Up Arrow
dc.b KCF_STRING+KCF_SHIFT ;$4d Down Arrow
dc.b KCF_STRING+KCF_SHIFT ; $4e Forward Arrow
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dec.b KCF_STRING+KCF_SHIFT
dec.b KCF STRING+KCF SHIFT
de.b KCF STRING+KCF SHIFT
dc.b KCF STRING+KCF SHIFT
de.b KCF STRING+KCF SHIFT
dc.b KCF STRING+KCF_! " SHIFT
dc.b KCF | STRING+KCF SHIFT
dc.b KCF STRING+KCF SHIFT
dec.b KCF STRING+KCF SHIFT
dec.b KCF_STRING+KCF;SHIFT
dc.b KCF_STRING+KCF_SHIFT
dec.b
de.b
dec.b
de.b
b
b

CF_STRING

dc.b

Q

Q

H

o
0000000 OROOOOO

public _HiKeyMap

even

_HiKeyMap:
dc.b $00, $00, $00, $20
dc.b $00, $00, $00, $08
dec.b $00, $00, $00, $09
dc.b $00, $00, $00, $0d
dc.b $00,$00,$00, $0d
dc.b $00,$00, $9b, $1b
dc.b $00,$00,$00,$7f
dc.b $00,$00, $00, $00
dc.b $00,$00, $00, $00
dc.b $00,$00, $00, $00
dc.b $00,5$00,%00, "-"
dec.b $00,$00, 500,500
dc.l Up Arrow
dc.1l Down_Arrow

dc.l Forward Arrow
dc.l Backward Arrow
dc.1l F1

dc.l F2

dc.1l F3

dc.1l F4

dc.l FS

dc.1l Fé

dc.1l F7

dc.l F8

dc.l F9

dc.1 F10

dc.b $00, $00, 500,500
dc.b $00,$00, $00, $00
dc.b $00,$00, $00,$00
dc.b $00,$00,$00,500
dc.b $00,$00, $00, 500
dc.l Help

;$4f
;850
;851
;852
;%53
;854
;855
;$56
;857
;858
;859
;$5a
;$5b
;$5¢
:$5d
;$5e
;$5F
;560
;561
;5862
;563
;564
;865

;867
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Backward Arrow
Fl

F2

F3

F4

F5

Fé

F7

F8

F9

F10
undefined
undefined
undefined
undefined
undefined
Help

SHIFT left
SHIFT right
CAPS LOCK
CTRL

ALT left
ALT right
AMIGA left
AMIGA right

;%40 Space
;$41 BackSpace

;%42 Tab

;$43 Enter

;$44 Return

;%45 Escape

;$46 Delete

;%47 undefined
;$48 undefined
;%49 undefined
;$4a Numeric Pad
;$4b undefined
;%4c Up Arrow
;$4d Down Arrow
;$4e Forward Arrow
;$4f Backward Arrow

;850 F1
;851 F2
;852 F3

;$59 F10

;$5a undefined
;$5b undefined
;$5¢ undefined
;$5d undefined
;$5e undefined

;$5f Help
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de.b $00, $00, $00, $00
dec.b $00, 500, $00, $00
dec.b $00,$00, $00, $00
dc.b $00,$00,$00,%$00
dc.b $00, 500,500,500
dc.b $00,%00, 500,500
dc.b $00, $00, $00, 500
de.b $00, $00, $00, $00

Up_Arrow:
dc.b 2

ADVANCED SYSTEM PROGRAMMER'S GUIDE

;$60 SHIFT left
;$61 SHIFT right
;562 CAPS LOCK
;$63 CTRL

;$64 ALT left
;$65 ALT right
;566 AMIGA left
;$67 AMIGA right

; Length of the strings (unshifted)

dc.b Up Arrow Unshift-Up Arrow ; Offset

de.b 2

; Length of the strings (shifted)

dc.b Up_Arrow_Shift-Up Arrow ; Offset

Up_Arrow _UnShift:
dc.b CSI,"A"

Up Arrow_Shift:
dec.b CSI,"T"

Down_Arrow:
dc.b 2

dc.b Down_Arrow_UnShift-Down_Arrow

de.b 2

dc.b Down_Arrow_Shift-Down Arrow

Down Arrow_UnShift:
dc.b CSI,"B"

Down Arrow Shift:
dc.b CSI,"s"

Forward Arrow:
de.b 2

; Length of the strings (unshifted)
; Offset

; Length of the strings (shifted)

; Offset

; Length of the strings (unshifted)

dc.b Forward Arrow UnShift-Forward Arrow ; Offset

de.b 3

; Length of the strings (shifted)

dc.b Forward Arrow Shift-Forward Arrow ; Offset

Forward Arrow UnShift:
de.b €SI, "C"

Forward_Arrow_Shift:
dc.b CSI," A"

Backward Arrow:
dec.b 2

; Length of the strings (unshifted)

dc.b Backward Arrow_Unshift-Backward Arrow ; Offset

dc.b 3

dc.b Backward Arrow_Shift-Backward Arrow

Backward Arrow_Unshift:
dc.b CSI,"D"

Backward Arrow Shift:
dc.b €SI, " @"

Fl:

de.b 3

de.b Fl_UnShift-Fl

dc.b 4

dc.b F1l_Shift-Fl
Fl Unshift:

dc.b CSI,"0~"
Fl_shift:

dc.b CSI,"10~"

F2:
dec.b 3

; Length of the strings (shifted)
;s Offset

; Length of the strings (unshifted)
; Offset

; Length of the strings (shifted)

; Offset

Length of the strings (unshifted)

~
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dc.b F2_Unshift-F2

dc.b 4

dc.b F2_shift-F2
F2_UnShift:

dc.b CSI,"1~"
F2_shift:

dc.b CSI,"11~"

F3:

dc.b 3

dc.b F3_UnShift-F3

dc.b 4

dc.b F3_Shift-F3
F3 Unshift:

dc.b CSI,"2~"
F3_shift:

dc.b CSI, "12~"

F4:

dc.b 3

dc.b F4_Unshift-F4

dc.b 4

dc.b F4_shift-F4
F4_Unshift:

dc.b CSI, "3~"
F4_shift:

dc.b CSI,"13~"

F5:
dec.b 3
dc.b F5_Unshift-F5
dec.b 4
dc.b F5_Shift-F5
F5 UnsShift:
dc.b CSI, "4~"
F5 shift:
dc.b CSI,"14~"

F6:

dc.b 3

dc.b F6_Unshift-Fé

dc.b 4

dc.b F6_Shift-Fé
F6_UnShift:

dc.b CSI,"5~"
F6_sShift:

dc.b CSI,"15~"

F7:

dec.b 3

dc.b F7_UnShift-F7

dc.b 4

dc.b F7_shift-F7
F7_Unshift:

dc.b CSI,"6~"
F7_shift:

dc.b CSI,"16~"

F8:
dec.b 3
dc.b F8 Unshift-F8
dc.b 4

~e Se N

Ne Ne Se N LT TRE TR

~e e

. S

Se Se Ne oS

~

ETEE YRR

LT TR

Offset
Lenght
Offset

Length
Offset
Length
Offset

Length
Offset
Length
Offset

Length
Offset
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Offset

Length
Offset
Length
Offset
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Offset
Length
Offset
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dc.b F8 Shift-F8 ; Offset
F8 UnsShift:
de.b CSI,"7~"
F8_shift:
de.b CSI,"17~"
F9:
dc.b 3 ; Length of the strings (unshifted)
dc.b F9 Unshift-F9 ; Offset
dc.b 4 ; Length of the strings (shifted)
dc.b F9_shift-F9 ; Offset
F9 Unshift:
dc.b CSI,"8~"
F9 shift:
dc.b CSI,"18~"
F10:
dc.b 3 ; Length of the strings (unshifted)
dc.b F10 _Unshift-F10 ; Offset
dec.b 4 ; Length of the strings (shifted)
dc.b F10_shift-F10 ; Offset
F10_Unshift:
dc.b CSI,"9~"
F10_shift:
dc.b CSI,"19~"
Help:
dec.b 3 ; Length of the strings (unshifted)

dc.b Help UnShift-Help ; Offset
Help Unshift:

dc.b CSI,"2~"

even
#endasm

For unknown reasons we must use $0e twice for the keyboard code
instead of one byte in the KeyMapTypes table and eight bytes instead
of four in the Keymap table. If you don't do this, all of the keypresses
end with incorrect codes. For example, "v" instead of C or "m" instead
of M.

Remember that the KeyMap and KeyMapTypes arrays begin in word
addresses (even). After determination of the arrays you should also make
sure that the rest of the program continues with an even address
otherwise a Guru Meditation occurs. This Guru informs you of an
address error (Guru number $00000003).

Now let's examine the entries in LoKeyMap more closely: you have
determined that the first byte contains the value "A"+$80 for the
keyboard code $20. The second byte contains "a"+$80 and the last
two bytes contain the value "A" and "a". Unfortunately the Aztec C
assembler does not understand expressions like "A"+$80. That is why
we have translated the character "A" into its ASCII code $41. Let's see
which of the four ASCII codes are sent when a key is pressed in
conjunction with a qualifier:
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allowable qualifiers (keyMapTypes)

) A C_ NSiAN C+A | S+C [S+AsC

a a a a a a a a

ol a A a a A a A a

a a+

<] a a A a $-;0 A a $80

a+ a+ a~

2 |9 @ | @] 2 A a | $80| $80 | $30

< A+
o +* A+

% wl @ A A a $80 A A | s80

a+ A+ | a+ a+
k{ a a A A $80 $80 $80 $80

~$30
2 a+ A+ A~
[3)
+ A+ A+ | A+ | A+
A A A
i 2 $80| $80| $80 980
~$30
= Example: allowable qualifier: S+A o
:=:T:" : printable qualifier: C+A Result: "a"+$80
C=Control
KeyMapEntry:

dC.b "A"+$80, "a"+$80, "Au' "a"
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You see that one of the ASCII codes "a", "A", "A"+$80, or "a"+$80 is
sent only when the qualifiers <Alt> and <Shift> are pressed. When all
three qualifiers are allowed, bits 5 and 6 ($30) of the sent code are
cleared when the <Ctrl> key is pressed. You also have no option of
testing for the ASCII code sent in conjunction with <Cul>,
independently from the codes established in the keymap.

This changes somewhat when we use strings instead of simple ASCII
codes. Here you must bear in mind that the four bytes in the keymap
act as an entry point to one or more string descriptors. Such a string
descriptor has the following format:

1) byte length of the string to be displayed
2.) Dbyte offset of the string at the beginning of the descriptor

Here is an example:

StringDescriptor:
dc.b 8 ;length
dc.b Stringtobedisplayedl-StringDescriptor ;Offset
de.b 14 ;length

dc.b Stringtobedisplayed2-StringDescriptor ;Offset
Stringtobedisplayedl: dc.b "String 1"
Stringtobedisplayed2: dc.b "second String"

Because the strings to be displayed are addressed over offsets, the strings
must be placed in the range from +127 to -128 bytes from the
beginning of the string descriptor. Now you can represent all three
qualifiers and their combinations through other strings. The illustration
on the opposite page tells which combination of allowed and pressed
qualifiers display which string.

Remember that with one allowable qualifier, two strings must be
available; for two allowable qualifiers, four strings must be available;
and with three qualifiers, eight strings must be available. A string
descriptor must also be specified for each of the strings to be displayed.
Now the pointers Lo /HiCapsable and Lo/HiRepeatable must
be explained.

Certain keys like the <Caps lock> key are not represented by their
shifted values. So <Caps lock> displays a "1" instead of a "!". The
CapsAble pointer points to a 8 byte array from which a bit is
responsible for seeing if a key should execute Caps lock (Bit == 1) or
ignore it (Bit == 0). The CapsAble bit O of the first byte is set to
zero for the key number zero (LoCapsable). The first bit of the
second byte pertains to key 8, and so on. The first bit from
HiCapsable pertains to key 0x40. Two pointers point to a 64 bit =
byte size array.
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allowable qualifiers (keyMapTypes)
S A Cc S+A | C+A | S+C [S+AsC

Ala | alalalal|a]a

printable qualifiers
S+A

<
dalalslBlc|B|c]| a
O
dA | B | A|B|A]|]c]|D]|F
Q
A |B|B|B|D|D| D]J|H
[/}

l

S=Shift KeyMapEntry

AzAlt

C=Control NewA:
dc.b1t A: dc . b "A"
dc . b A-NewA B: dc .b "B"
dc.b1 C:dc.b"C"
dc . b B-NewA D:dc. b:o:
dc.b1 E-:.::.E'
dc . b C-NewA G do . b G"
dc.b1 H: dc . b "H°
dc . b D-NewA
dc.b1
dc . b E-NewA
dc.b1
dc . b F-NewA
dc.b1
dc . b G-NewA
dc.b1
dc . b H-NewA
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It is similar with Lo/HiRepeatable. Here one bit is reserved for
one key in Hi KeyMap and LoKeyMap. The set bits indicate if the
corresponding key should be repeated after it has been released (see
input device). If, for example, this bit = 0 for the <Return> key, the
<Return> key does not repeat.

How can you use a new keymap over the console device? The keymap
structure must be filled by Console_AskKeyMap () with the values
of the console window keymap structure.

struct KeyMap KeyMap;

Console_AskKeyMap (ConsoleRead, &KeyMap);

Then change the corresponding pointer of the keymap structure and the
command CD_ SETKEYMAP.

" KeyMap.km LoKeyMapTypes
KeyMap.km_ LoKeyMap

(UBYTE*) &LoKeyMapTypes;
(ULONG*) &LoKeyMap;
KeyMap.km HiKeyMapTypes (UBYTE*) &HiKeyMapTypes;
KeyMap.km HiKeyMap (ULONG*) &HiKeyMap;
Console_SetKeyMap (ConsoleRead, &KeyMap);

Now the new keymap is installed. Here are the Con_Support
routines that we have used above, add them to your Con_Support.c file:

/**t*t*********t*tt*tt*tt********t*****t**********t*****t*******

* Console_AskKeyMap () (Con_Support) *
* *

* Function: Fill KeyMap-Structure
K

* Input - Parameter:
*

* ConReq: Device-Block

* KeyMap: Pointer to KeyMap-Structure
*

* Return Value:
*

* FALSE: Error !!! *
************************************************i**************/

* % ¥ % ¥ % H ¥ *

BOOL Console_AskKeyMap (ConReq,KeyMap)
struct IOStdReq *ConReq;

struct KeyMap *KeyMap;
{

ConReg->io_Length (sizeof (struct KeyMap));
ConReg->io_Data = (APTR)KeyMap;

Do_Command (ConReq, (UWORD)CD ASKKEYMAP) ;

if (ConReq->io Error != (BYTE)0) return (FALSE);
return (TRUE);

}

/********t******************************************************

* Console_ SetKeyMap () (Con_Support) *
* *

* Function: Install Console-KeyMap *
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*

* Input - Parameter:
*

* ConReq: Device-Block
KeyMap: Pointer to KeyMap-Structure

* % % % X ¥ ¥ ¥ *

*
*
* Rerun value:
*
*

FALSE: Error !!!
************************t**************************************/

BOOL Console_SetKeyMap (ConReq,KeyMap)
struct IOStdReq *ConReq;
struct KeyMap *KeyMap;
{

ConReq->io_Length = (sizeof (struct KeyMap));
ConReq->io_Data = (APTR)KeyMap;
Do_Command (ConReq, (UWORD) CD_SETKEYMAP) ;
if (ConReg->io_Error != (BYTE)O) return (FALSE);
return (TRUE);

}

You also have the option of bypassing the console device and assigning
a different keymap to the console window. This can be done through
CD_ASKDEFAULTKEYMAP and CD_SETDEFAULTKEYMAP. When
you use these two commands to install a new keymap, the next time
you invoke the Open_A Device ("console.device", 0L,
&ConsoleRead, OL, 0L); command enables the keymap. These
commands are used by the SetMAP CLI command. The Set MAP
command changes the ConUnit structure of the current CLI window.

Vad it st s i st it sttt sttt s sttt s sttt is s ittt st

* Console_AskDel faultKeyMap () (Con_Support) *
* *

* Function: Fill KeyMap-Structure

Input - Parameter:

ConReq: Device-Block
KeyMap: pointer to KeyMap-Structure

Retrun value:

* % % X % X H * H
* % % % % H ¥ * % *

FALSE: Error !!!
**t*tt*********************************************************/

BOOL Console_AskDefaultKeyMap (ConReq,KeyMap)
struct IOStdReq *ConReq;
struct KeyMap *KeyMap;
{

ConReq->io_Length (sizeof (struct KeyMap));
ConReq->io_Data (APTR) KeyMap;

Do_Command (ConReq, (UWORD)CD_ASKDEFAULTKEYMAP) ;
if (ConReq->io_Error != (BYTE)O) return (FALSE);
return (TRUE);
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/****************'k**'k*'k*********'k'k*'k****'k*'k*********************

Console_SetDefaultKeyMap () (Con_Support) *
*

Function: Install Console-Default-KeyMap

Input - Parameter:

ConReq: Device-Block
KeyMap: Pointer to KeyMap-Structure

Retrun value:

* % % % % % o % % % % %
* % % % % % % ¥ ¥ *

FALSE: Error !!!
R T e e e 2 e Ty

BOOL Console_SetDefaultKeyMap (ConReq,KKeyMap)
struct IOStdReq *ConReq;
struct KeyMap *KeyMap;
{

ConReq->io_Length = (sizeof (struct KeyMap));
ConReq->io_Data = (APTR)KeyMap;

Do_Command (ConReq, (UWORD)CD_SETDEFAULTKEYMAP) ;
if (ConReg->io_Error != (BYTE)0) return (FALSE);
return (TRUE);

4.9.2 Console internals

After Open_A_Device the ConsoleRead->io_Unit pointstoa
ConUnit structure. This structure contains all of the important
variables needed for using the console:

Offset Structure

struct ConUnit

{
0 0x00 struct MsgPort cu MP; /* message port for sending */

/* and receiving */
34 0x22 struct Window *cu Window; /* Console Window */
38 0x26 WORD cu_XCP;
40 0x28 WORD cu_YCP; /* character position */
42 Ox2a WORD cu_XMax;
44 0x2c WORD cu_YMax; /* maximum character */
/* position *x/
46 0Ox2e WORD cu_XRSize;
48 0x30 WORD cu_YRSize; /* character size */
50 0x32 WORD cu_XROrigin;
52 0x34 WORD cu_YROrigin; /* start of the */
/* text region *x/
54 0x36 WORD cu_XRExtant; /* maximum size */
56 0x38 WORD cu_YRExtant; /* of the text region */
58 Ox3a WORD cu_XMinShrink; /* smaller *x/
60 Ox3c WORD cu_YMinShrink; /* unrelated */
/* region by */
/* Window Resize */
62 Ox3e WORD cu_XCCP;
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64 0x40 WORD cu_YCCP; /* Cursor Position */
66 0x42 struct KeyMap cu KeyMapStruct; /* KeyMap */
98 0x62 UWORD cu_TabStops[80]; /* Tab Positions */
/* see RastPort Structure: */

178 Oxb2 BYTE cu_Mask;

179 0xb3 BYTE cu_FgPen;

180 Oxb4 BYTE cu_BgPen;

181 0OxbS BYTE cu_AOLPen;

182 0Oxbé BYTE cu_DrawMode;

183 Oxb7 BYTE cu_AreaPtSz;

184 0xb8 APTR cu_AreaPtrn; /* Cursor Pattern */

188 Oxbc UBYTE cu Minterms(8];

196 Oxc4 struct TextFont *cu Font;

200 Oxc8 UBYTE cu Algostyle;

201 0xc9 UBYTE cu_TxFlags;

202 Oxca UWORD cu_TxHeight;

204 Oxcc UWORD cu_Tx_Width;

206 Oxce UWORD cu_TxBaseline;

208 0xd0 UWORD cu_TxSpacing;

210 0xd2 UBYTE cu Modes[3]; /* memory for modes */

/* and RAW EVENTS */

/* (respectively 1 Bit) */

213 0xd5 UBYTE cu RawEvents([3];

216 0xd8 } /* defined in "devices/conunit.h" */

4.9.2.1 Console functions

The console device includes functions which can be accessed through
offsets. The ConsoleDevice = ConsoleRead->io_Device
represents the basis address for these functions.

Offset Command

0x2a CDInputHandler (&InputEvent)

A0
-0x30 Actual = RawKeyConvert (&InputEvent, Buffer, Length,
KeyMap)

DO A0 , Al , D1 , A2

CDhInputHandler () sends the event in the input device to the
current console window. For example, you can initialize an input event
structure and send it to the console device using CDInputHandler.
The input event's reaction can then be displayed by the console device.
CDInputHandler is similar to CMD_WRITE, except that
CDInputHandler displays event structures instead of strings.

CDInputHandler () calls RawKeyConvert (). This command
translates the input event into a string that begins at the Buffer
parameter, and has a maximal length of Length. This specifies the
keymap intended for conversion. Actual contains the number of
characters which comprise the created string. If Actual contains the
value -1, the buffer wasn't large enough to hold the string.
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A console function can be called using the following syntax:

move.l _ConsoleDevice, a6
sinitialize parameter
jsr -$2a(ab)

4.9.2.2

0x80-0xe7

0xf9
Oxfa
0xfb

0xfd

Oxfe

Oxff

140

More key codes

Take another look at the keymap illustration that appeared earlier in
this book. You'll notice that beside some undefined keyboard codes
there are also two reserved keyboard codes ($2b and $30). These
keyboard codes are intended for foreign characters.

In addition to the keyboard codes from 0x00 through 0x67 there are
more codes that cannot be controlled through a keymap:

0x68 left mouse button
0x69 right mouse button
Ox6a middle mouse button

These three key codes are never sent from the console device during
normal operation. First, if you turn on the RAW mode for the mouse
keypress with "<CSI>2{", you can add these key codes through the
control string that was received.

The key assigned a code ranging from 0x00 to 0x67 was released (e.g.,
0x80 for key 0x00). This code can only be received when the flag
KCF_DOWNUP (0x80) is set for the key in KeyMapTypes.

The keyboard code last sent from the keyboard was incorrect.

The internal keyboard buffer (10 characters) is full.

Keyboard catastrophe - fatal error.

Keyboard power-up (keys pressed during booting). This was sent from
Oxfd and Oxfe. (for example: Oxfd, 0x03, 0x04, Oxfe).

Keyboard power-up ended (keyboard initialized and all keys pressed in
the meantime are sent to the system).

The mouse was moved (no button pressed).



ABACUS

4.10 THE CLIPBOARD DEVICE

4.10

The clipboard device

You have probably worked with the block movement operations
included in a word processor or text editor. Block operations require
some memory management. If you've ever thought about adding block
operations to your own programs, you may have changed your mind
when you thought about how complicated this memory management
can be.

The clipboard device offers a simple method of implementing block
commands. You allocate the block into which you want the clipboard
device to write. The clipboard device reserves this block until you
access it further or declare it as invalid.

The clipboard device can be opened as follows:

struct IOClipReq *ClipReq = OL;
#define CLIP_LEN (ULONG) sizeof (struct IOClipReq)

Open_A Device("clipboard.device", Unit, &ClipReq, OL,
CLIP_LEN);

The clipboard device can only handle one unit at a time. Therefore, you
must open the clipboard device with different unit numbers, if you wish
to access more than one unit. The device block layout below will help
you understand how this works:

Offset Structure

struct IOClipReq
{

0 0x00 struct Message io_Message;

20 0x14 struct Device *io Device;

24 0x18 struct Unit *io Unit; /* which unit? */

28 Oxlc UWORD io_Command;

30 Oxle UBYTE io_Flags;

31 O0Ox1f UBYTE io_Error;

32 0x20 ULONG io_Actual; /* number of */
/*transferred bytes */

36 0x24 ULONG io_Length; /* number of bytes to*/

/* transfer */

40 0x28 SPTR io_Data; /* data (Stringpointer)*/

44 0x2c ULONG io_Offset; /* Offset inside unit */

48 0x30 LONG io ClipID; /* identification number */

/* of the clip */
52 0x34 } /* defined in "devices/clipboard.h™ */

The variables io_Message, io_Device, and so on may be
familiar to you from the previous section.

141



4. DEVICES

142

ADVANCED SYSTEM PROGRAMMER'S GUIDE

The variables io_Offset and io_ClipID are of interest. The
clipboard device must reserve memory locations before it can save data
to memory. The io_Of fset variable helps determine the position at
which the data was last read/written. io_Offset contains the byte
offset inside the clipboard device that gives the last read/write position.
This variable is similar to the file position used by DOS to determine
the location of the file. The io_C1ipID variable contains the number
of blocks that was already written to the clipboard device, then deleted
from the clipboard device.

The following routine writes data to the clipboard using the
CMD_WRITE command:

/*****************t******t*i****t**i****i*i**********i*****

* Clip Write() (Clip Support)*
* *
* Function: Write data in the ClipBoard-Device n *
* *
* Input - Parameter: *
* *
* ClipReq: Device-Block *
* Data: Data to be written *
* Len: Number of bytes to write *
* FirstTime: TRUE => first write command *
* FALSE => write command of a sequence *
* *
* Return value: *
* *
* Number of data written *

************t*t***********tt****************************tt*/

ULONG Clip Write (ClipReq,Data,Llen,FirstTime)
struct IOClipReq *ClipReq;
APTR Data;
LONG Len;
BOOL FirstTime;
{
if (FirstTime==TRUE)
ClipReqg->io_Offset = 01;

ClipReg->io Data (STRPTR) Data;
ClipReqg->io_Length Len;
Do_Command (ClipReq, (UWORD) CMD_WRITE);
return (ClipReg->io_Actual);

}

You must set the variables io_Offset and io_ClipID to zero on
the first write access. This prevents the clipboard device from acting
through another device. To inform the clipboard device that all of the
data was written, a CMD_UPDATE command is sent after the
CMD_WRITE command. You can also write a larger block bit by bit to
the clipboard device.

The clipboard device now contains a block. This block can consist of
text, graphics or other data. If not enough memory was allocated to the
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clipboard block, the clipboard device writes your block to disk, placing
it in the directory "SYS:devs/clipboards". The filename is the unit
number, notated as a decimal string (e.g., 0).

The following routine reads data from a clipboard device block using
the CMD_READ command:

/***************************************************** *kkkk

Clip_Read() (Clip Support) *

*
Funktion: Read data from ClipBoard-Device

Input - Parameter:

ClipReq: Device-Block
Data: Data buffer
Len: Number of bytes to read
FirstTime: TRUE => first read command
FALSE => read command of a sequence

Return value:

* % % Ok O % % % ¥ % ¥ ¥ ¥ ¥
* % % % % * * % % ¥ ¥ *

Number of the data that was read (contains errors!) *
***********************************************************/

ULONG Clip Read (ClipReq,Data,Len,FirstTime)
struct IOClipReq *ClipReq;
APTR Data;
LONG Len;
BOOL FirstTime;
{

if (FirstTime=TRUE)

ClipReq->io_Offset = 01;

ClipReg->io_Data = (STRPTR) Data;
ClipReq->io_Length = Len;
Do_Command (ClipReq, (UWORD) CMD_READ);
return (ClipReg->io_Actual);

}

The io_Offset and io_ClipID variables must be set to zero on
the first read access.

There is a bug in the clipboard device which we must mention here. A
zero is usually placed in io_Actual to indicate that all of the data
has been read. Unfortunately, the clipboard device always takes the
value in io_Length and places it in io_Actual. You must also
keep the number of bytes written in the footer yourself so that none of
the data is lost. In addition, you must read the data once with a value of
zero in io_Length after all of the data has been read. This serves to
end a read sequence for the clipboard device when the value zero is
returned in io_Actual. Because the value from io_Length is
always transferred into io_Actual when reading, you must read zero
byte data.
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When you no longer need the block, you must execute the
CcMD_CLEAR command. This clears the data in the clipboard device and
increments the C1ipID counter by one. For write and read accesses
you should only clear the io_Offset array. Do not write to

io_ClipID, for reasons which we'll explain in a moment.

Converting a large block to another format from the clipboard device
(e.g., conversion to IFF format) can take a lot of time. You can save
time by declaring a C1ip (naming the transfer of data blocks in and out
of the clipboard device). First you specify the address of a message port
to the io_Data pointer. Through this message port you get a
Satisfy message if the data available for use is needed by both parts.
This also sends a CBD_POST command. The Satisfy message looks
like the following structure:

Offset Structure

struct SatisfyMsg
{

0 0x00 struct Message sm Message;

20 0x14 UWORD sm_Unit; /* from which unit */
22 0x16 LONG sm_ClipID;

26 Oxla )}

You can then test for a received message using Message =
GetMessage (ownPort). A received message is indicated by
(Message !=0). If not, your program can continue with other
tasks. If a message has arrived, you must write the data into the
clipboard device as described above. Remember that the clip announced
with POST is not needed in some cases. Meanwhile other blocks can be
written to and read from the clipboard device. This naturally changes the
io_ClipID variables.

When you want to get a POST command after receiving the Satisfy
message through a CMD_WRITE command, read the io_ClipID of
the current read command with CBD_CURRENTREADID . If this value
is larger than the io_ClipID variable of the device block, with which
the CBD_POST command is executed, your data is not needed.

If you want to test whether you should execute a previously sent POST
command before leaving the program, just read the io_ClipID.
Compare its contents with the io_ClipID variable of the POST
device block. If the value returned from CURRENTWRITEID in
io_ClipiID is larger than the C1ipID variable of the POST device
block, the other CMD_WRITE commands are executed in the meantime
and the announced data transfer does not need to be executed.

These two routines are combined to form the Clip_Support.c file,
remember to insert the following include files, exec/types.h,
exec/memory.h, exec/io.h, and devices/clipboard.h.
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4.11

The audio device

You've probably heard about the fantastic sound capabilities of the
Amiga. Programming sound requires the use of the audio device. This
device allows you to send any waveform through the sound channels, at
any volume and of any duration. ‘

The audio device can be opened using the following:

#define AUDIO LEN (ULONG) sizeof (struct IOAudio)
struct IOAudio *Audio Request=0L;

Open_A Device("audio.device", OL, Audio_ Request, OL,
AUDIO_LEN);

The I0Audio device block through which the command is given and
developed looks like the following:

Offsets struct IOAudio
------- {/* defined in "devices/audio.h" */

0 0x00 struct IORequest ioa_Request; /* IORequest to
begin */

32 0x20 WORD ioca_AllocKey;

34 0x22 UBYTE *ioa_Data; /* Data pointer */

38 0x26 ULONG ioa_Length; /*size data field*/

42 0Ox2a UWORD ioca_Period; /* Frequency */

44 0Ox2c UWORD ioca Volume; /* volume */

46 Ox2e UWORD ioa_Cycles; /* cycles */

48 0x30 struct Message ioa_WriteMessage;

62 0x3d }

The audio device supports the following commands:

ADCMD_ALLOCATE (32) allocate sound channel

ADCMD_FINISH (11) end sound output
ADCMD_FREE (9)  unlock sound channel
ADCMD_LOCK (13) clean up before channel "stolen”
ADCMD_PERVOL (12) adjust period and volume

ADCMD_SETPREC (10) change channel precedence
ADCMD_WAITCYCLE (14) wait for end of cycle

CMD_FLUSH (8 clear all write commands
CMD_READ (2) find current writeIO block
CMD_RESET (1) reset audio hardware registers
CMD_ START (7) start output

CMD_STOP (6) stop output

CMD_WRITE (3) initialize sound output
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The audio device supports the following flags:

ADIOF_PERVOL (16) set period and volume using
ADCMD_ALLOCATE

ADIOF_SYNCCYCLE (32) synchronize action with cycles

ADIOF_NOWAIT (64) don't wait for ADCMD_ALLOCATE

The audio device supports the following errors:

ADIOERR_NOALLOCATION (-10) AllocKey not understood

ADIOERR_ALLOCFAILED (-11)  channel allocation failed

ADIOERR_CHANNELSTOLEN (-12) channel stolen by another
user

4.11.1

Audio channel
allocation:
Method one

146

Allocating audio channels

The audio channels must be allocated for sound transmission. The audio
device has two methods of allocating the audio channels through which
the sound can be sent.

OpenDevice () provides the first method. First the IOAudio
structure (the I/O block of the audio device) must be initialized.
Initialization through CreateExtIO () alone isn't enough here—the
IOAudio structure must be opened as well. Next an attempt is made
to allocate the channels by calling OpenDevice () (Exec function).
This audio device block requires the address of your channel allocation
map, your audio channel reservation mask:

struct IOAudio *AudioReq;
char Channel Map[...] = {...};

AudioReq = (struct IOAudio *) GetDeviceBlock (AUDIO_LEN);
AudioReq->ioa Data = Channel Map;

AudioReq->ioa Length = sizeof (Channel Map);

Open_A Device("audio.device", OL, AudioReq, OL, AUDIO_LEN);

A typical channel allocation map consists of up to 16 bytes, with
which you can determine channel allocation. The four lowest bits (the
low nibble) test for one of each of the bytes of the channels to be
allocated. If you want to send your waveform to a left and a right sound
channel, your allocation map would look like the following:
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#define Left Channel 0 1 /* Bit for first left channel */
#define Right Channel 1 2 /* Bit for first right channel */
#define Right_Channel 2 4 /* Bit for second right channel */
#define lLetf Channel 3 8 /* Bit for second left channel */
UBYTE Channel Map[] = {Left_Channel 0 | Right_Channel_1,

Left_Channel 0 | Right Channel_2,

Left _Channel 3 | Right_Channel 1,

Left Channel_3 | Right_Channel_ 2};

The channel_map array contains four entries (sizeof

(Channel Map) == 4)that test a right and a left sound channel for
allocation. This array appeared in the previously initialized T0Audio
structure (see the ioa_data pointer). The number of entries in this
array is given through the ioa_Length pointer. In this particular
case the length is four bytes. The following sequence is needed for the
allocation of the channels using OpenDevice ():

#define Left Channel 0

#define Right_Channel_1

#define Right Channel 2

#define Letf Channel 3

#define Precedence -40

#define AUDIO_LEN sizeof (struct IOAudio)

UBYTE Channel Map[] = {Left Channel 0 | Right_Channel 1,
Left Channel 0 | Right_Channel 2,
Left_Channel 3 | Right_Channel_1,
Left_Channel 3 | Right_Channel 2};

struct IOAudio *AudioReq;

@ N

AudioReq = (struct IOAudio *) GetDeviceBlock (AUDIO_LEN);
AudioReg->ioca_Data = (UBYTE*)Channel Map;
AudioReg->ioca_Length = (ULONG)sizeof (Channel Map); /* 4 */
AudioReqg->ioa Request.io Message.mn Node.ln pri = Precedence;
Open_A Device("audio.device", 0L, &AudioReq, 0L, OL);

Since we used GetDeviceBlock to take the audio block ourselves,
this does not have to be done through Open_A_Device (). This is
why we assign Open_A_Device () a value of zero as the size of the
audio device block.

Now the supplied audio channels are ready for use (in case
OurSounds->ioa_Request.io_Error == 0). You may have
been wondering what the following variable does in this device:

AudioReq->ioa_Request.io_Message.mn Node.ln Pri

The above line controls the precedence of your sounds. The higher the
precedence number, the less chance of your channel being "stolen” by
another user. Stealing refers to another program allocating a sound
channel you already have allocated. If your channel has a high
precedence, a program trying to allocate your sound channel will be
rejected. If the other program has a precedence number higher than
yours, your channel must be released as soon as possible. Commodore-
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Amiga recommends the following precedence numbers for certain types

of sounds:

Precedence Sound

number: type

128 This precedence number is for the lazy programmer.
When your sounds run at a level of 127, no one can
access your allocated channels. You also don't have to
free the channels before leaving the program. Use this
number only when absolutely necessary!

90 - 100 Emergency sounds. These sounds occur when a problem
occurs in an application (e.g., the application cannot
access a library).

80-90 Announcements (e.g., the <Ctrl><G> bell).

75 Narrator device data (i.e., speech).

50-70 Informational sounds or sonic cues.

-50 - +50 Music program data.

-710-0 Sound effects (e.g., explosions).

-100 - -80 Background music and ambient sounds.

-128 Total silence.

The second method works through an audio device command. We have
placed this command (ADCMD_ALLOCATE) in an audio device support

function which

looks like the following:

/***************************************************************

*
*

* Function: Allocate sound channels or audio device block
Prepare for allocation (OpenDevice)

Audio Allocate() (Audio_Support)*
*

Channel Map:
Size:
Precedence:
Wait:

Input - Parameter:
Audio Device Block: Device-Block for allocation

Channel-allocations-mask

Size of the allocations-mask (BYTES)
Sound precedence (-127 - 128)

Wait for the desired channel to open?

* Ok % % % O % X H F

Return value:
Error in command execution

% % % % * % % % X % *

**********i************************ii*iii**********************/
BYTE Audio Allocate

(Audio_Device Block,Channel Map, Size,Precedence,Wait)

struct IOAudio *Audio Device Block;
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UBYTE *Channel Map;

ULONG Size;

BYTE

Precedence;

BOOL

Wait;

{
Audio_Device Block->ioa Data = Channel Map;
Audio_Device_Block->ioa_Length = Size;

Audio Device Block->ioca Request.
io_Message.mn Node.ln Pri = Precedence;

if (!Wait) /* wait until channel is free? */
Audio Device Block->ioa Request.io Flags |= (UBYTE)
ADIOF_NOWAIT;
if (Audio_Device Block->ioa_Request.io Device != OL)

Audio_Device Block->ioca Request.io Command = (UWORD)
ADCMD_ALLOCATE;
if (Wait) DoIO (Audio_Device Block);
else
{
SendIO (Audio_Device Block);
if (CheckIO(Audio_Device Block) == 0) return
(ADI(ERR_ALIDCFAILED);
}
return (Audio Device Block->ioa Request.io_Error);
}
return (0x00);

}

This routine sets the io_Data pointer (Channel_Map) and the
ioa_Length variable (size of the Channel_Map) as well as the
user assigned sound precedence. The NOWAIT flag (Wait = FALSE) is
also set to the user-assigned value. To allocate channels contained by a
higher precedence request while the NOWAIT flag is set, give
OpenDevice () and ADCMD_ALLOCATE the error
ADIOERR_ALLOCFAILED as the return value or error flag
(AudioReg->ioa_Request.io Error).

The unset NOWAIT flag waits until the request containing our channels
releases them. A small problem can occur when you use the NOWAIT
flag in conjunction with ADCMD_ALLOCATE, it cannot be used for
channel allocation with OpenDevice (). You might think that by
returning the set NOWAIT flag ADCMD_ALLOCATE to the called
program, the channels can be allocated. This is done in case the
supplied channels are inaccessible, but unfortunately they wait for
ADCMD_ALLOCATE.

We got around this error with the help of the SendI10 () and
CheckIO () commands. If channels should be released without delay,
we send a asynchronous request (SendIO () ) and check it immediately
to see if the sent command is executing, or if it was already processed.
If CheckIO () returns the value 0, that is one character for us that the
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channels contain from others. Because we do not want to wait for the
channels to be released, the routine exits with the error
ADIOERR_ALLOCFAILED.

If the channels could not be allocated, you get the bit combination of
the allocated channels in *Audio_Device_Block-
>ioa_Request.io_unit. Itis important to know which channels
were actually allocated (more on this later). With multiple statements
of the channels to be allocated in the Channel_ Map (up to 16),
ADCMD_ALLOCATE searches for the combination that requires the
least wait time.

If in the meantime some other program releases its sound channels,
ADCMD_ALLOCATE or OpenDevice () checks to see if some
successful allocation can be executed. This check results only when the
system is instructed to wait for released channels. Should the allocation
fail, the error variable of the Audio_Device_Block sets the
ALLOC_FATILED flag:

/i**i**i*******t**t*tt*********************tt****t*****t***t**t*

Audio_NoAlloc() (Audio_Support) *
*

Function: Allocation succesful?

Input - Parameter:

Audio_Device_Block: Device-Bock to be tested

Return value:

TRUE: No allocation
FALSE: Allocation successful
************************************************it*************/
BOOL Audio_NoAlloc (Audio_Device Block)
struct IOAudio *Audio_Device Block;
{
if ((Audio Device Block->ioa Request.io Error &
ADIOERR NOALLOCATION) == ADIOERR NOALLOCATION)
return (TRUE);
else
return (FALSE);

* % % 4 F % % ¥ * * ¥ %
* % % A ¥ ¥ ¥ ¥ * *

}

The AllocKey variable contains information about how many users
exist on the audio device when the computer is turned on (or reset).
When this AllocKey does not agree with the internally stored value
when an audio device command is executed, each audio device command
sends a NOALLOCATION error.

To avoid generating this error when you want to use a copy of the
original device block, this A11ocKey is also copied when copying the
andio device block. Before we get to that, let's take a closer look at the
allocation. You can save work when allocating by using
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OpenDevice (). When the ADIOF_PERVOL flag is set, the period
(frequency) and volume are also set. You can also do this for each
period with the help of an audio command.

4.11.2 Audio period and volume

The following routine demonstrates volume seiting for the audio

device:

/*****************i*********************************************
* Audio _Pervol () (Audio_Support) *
* Function: Set volume and frequency *
* *
* Input - Parameter: *
* *
* Audio Device Block: Audio-Device-Block should be set for *
* volume and frequency *
* Period: Sample frequency *
* Volume: Volume *
* *
* Return value: *
* *
* *

Error encounter during commnad execution
L T T T e T ey

BYTE Audio Pervol (Audio Device Block, Period, Volume)

struct IOAudio *Audio_Device Block;
UWORD Period;
UWORD Volume;
{
Audio_Device Block->ioa Request.io Flags = (UBYTE)

ADI OF_SYNCCYCLE;
Audio Device Block->ioa Period
Audic_Device Block->ioca Volume

Period;
Volume;

if (Audio Device Block->ioa Request.io Device != OL)
{ /* setting of volume and frequency */
Audio Device Block->ioa_Request.io_Command = (UWORD)
ADCMD_PERVOL;
DoIO (Audio Device Block);
return (Audio Device_Block->ioca Request.io_Error);

}

Audio Device Block->ioa Request.io_Flags |= ADIOF PERVOL;
/* ADIOF_PERVOL must be set for OpenDevice() */
return (0x00);

}

This routine can tell whether the volume should be set before or after
OpenDevice (). The io_Device pointer as well as all unset
variables should equal zero before calling OpenDevice (), because
the allocation of the audio device block (GetDeviceBlock ()) has
been executed through AllocMem () with the MEMF_PUBLIC and
MEMF_CLEAR parameters.
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Three options exist for setting the volume and period. The
ADIOF_PERVOL flag, used in conjunction with CMD_WRITE (sound
output) has the same function as when used in conjunction with
OpenbDevice (). Before we get to the sound output itself, let's take a
closer look at the period and the volume.

We mentioned that the word period refers to the frequency of the sound.
The period measurement requires a few simple calculations. For
example, a period value of 20000 means more than just an output of
20000 bytes per second. You can calculate the period from two items:

1.) The number of bytes (samples) on which the waveform is
based.

2) The frequency at which the note(s) should be played.

Look at the following equation:

1
Sampling rate * 28 * 1078

Period =

The sampling rate is constructed from the number of bytes to be played
and the frequency at which these should be played.

Here's an example:. You want to play a waveform created from 40
bytes, and you want this waveform played at 440 cycles per second.
This means that you want the waveform to sound at 440 Hz, or "A-
440" as it's called in the music dictionaries. To get the sampling rate
you do the following:

Sampling rate = 40 * 440 (40 bytes * 440 Hz)
The period is then calculated as follows:

1
Period = 8 = 202.922 = 203
40 * 440 * 28 * 10

The following routine performs period calculation. We wanted to
minimize floating point arithmetic, so we multiplied the above fraction
by 10"8 (28*10/8seconds = 280 nanoseconds [the time in which one
byte can be output]), and we get the following routine:

J 3 3 3 sk ok ok ok 3k ok 3k ok 3k 3k ok ok Sk ok 3k 3k ok 3 3k 3k ok 3k 3k sk ok ok ok 3k ok 3 Sk 3k ok ok ok ok 3 S 3 o e ok ok ok ok ke ok kb

Audio Period () (Audio_Support) *
*

the frequency needed for it.

/
*
*
* Function: Calculate the number of bytes to play and
*
*
* Input - Parameter:

*

* % * % * %

* Bytes: Number of bytes to play
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Hz: Frequency, at which the byte samples should be played *
*

Return value: *
*

Calculated period *

*x*******i****i*i*********************iii*iiii****iiii*********/

* % % % *

UWORD Period (Bytes, Hz)
UWORD Bytes, Hz;
{
return ((UWORD) (1000000001 / (Bytes * Hz * (UWORD)28)));

}

Remember that this routine returns only variables of type UWORD.
The value region ranges from 0 to 65535. If the period is larger than
65535, only the lower 16 bits of the calculation are used. The top 16
bits are truncated (see hardware register). In certain cases this can be
done to very small values that lie outside of the allocated region. The
period may not be smaller than 124. The frequency with which the
bytes are displayed is found as follows:

Period
<=> Hz

100000000L/ (Bytes*Hz*28)
100000000L/ (Bytes*Period*28)

Assuming that our waveform only consists of one byte, this is then
given as the highest frequency:

Hz = 10000000L/(1*124*28) = 28800 s~-1;

We need a little more arithmetic to set the volume. The volume can
range from zero (soft) to 64 (loud). The volume curve is linear.

Set the period and volume to zero before using CMD_WRITE for the
first time. If you don't do this, data displayed through CMD_WRITE
may also play over the sound channels as blips.

4.11.3

Play it

Now we come to the frequently mentioned CMD_WRITE command. We
have also included this in a short routine:

/********************************************i******************

* Audio Write() (Audio_Support)*
* *
* Function: Output data through channel *
* *
* Input - Parameter: *
* *
* Audio_Device Block: Device-Block *
* WaveForm: Addess of the waveform array *
* Wavelength: Number of bytes to play *
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Cycles: Number of waveform repetitions
ComeBack : Wait until end of CMD WRITE (FALSE) ?

*
*
*
* Return value:
*
*

* % ¥ ¥ ¥ %

Error during command execution
***********t***************************************************/

BYTE Audio_Write (Audio Device Block, WaveForm, Wavelength,
Cycles, ComeBack)
struct IOAudio  *Audio Device Block;

UBYTE *WaveForm;
ULONG Wavelength;
UWORD Cycles;
BOOL ComeBack;
{
Audio_Device Block->ioa_Data = WaveForm;
Audio Device_ Block->ioa_Length = Wavelength;
Audio_Device_Block->ioca_Cycles = Cycles;
Audio_Device Block->ioa_Request.io Flags = (UBYIE) 0;
Audio_Device Block->ioca Request.io Command = (UWORD)

CMD_WRITE;

if (ComeBack) SendIO (Audio Device Block);
else DoIO (Audio_Device Block);

return (Audio Device Block->ioca_Request.io_Error);

}

We must provide the device block with which the device was opened, as
with all of the audio_support routines.

WaveForm and WaveLength designate the waveform to be
displayed. WaveForm contains the starting address of the byte array in
which the waveform is located. WaveLength contains the number of
bytes needed to describe the waveform, rather than the wave length of
the resulting sound.

Cycles designates the repetition rate of a waveform. For example, if
you want the given waveform to play only once, you must state the
value 1 for Cycles. The higher the value for Cycles, the more
times the waveform repeats.

When you want unlimited repetitions, enter the value zero for
Cycles. Then your waveform plays for eternity, assuming that your
channels aren't stolen. A change in the waveform can occur when the
indicated location is displayed. Please remember that the sound data in
the chip memory must be released. As you know, the address bus of the
custom chips (Blitter, Paula, Agnus, Denise, Copper) contains only 19
address connections. This addresses the bottom section of memory (or
the bottom 512K).
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4.11.4

Additional audio device features

Now you can produce sound on your Amiga. You can allocate the
necessary channels, determine the frequency and volume and make the
data audible. Suppose you're working with your audio device and
suddenly you don't hear anything anymore, or you don't hear what you
expected to hear. The solution: You've been robbed of your channels.

What can you do? You can either leave the program, or reset the
computer if you cannot leave the program. One possibility exists for
consistently stealing channels, which involves the ADCMD_LOCK
command:

#define AUDIO LEN (ULONG) (sizeof (struct IOAudio))

VOID *GetDeviceBlock();
/*****t*********i***************t*******ti*ii*****i************
* Audio_Lock () (Audio_Support) *
Function: Protect channel before new access *

Input - Parameter:
Audio_Device Block: Device-Block of the channels that
should be protected.

Return value:

Addess of the Lock
i*i***t****tt*****tt******t********i**tt**********t******ii*t*t/

*
*.
*
*
*
*
*
*

* % % % % X *

struct IOAudio *Audio Lock (Audio Device_Block)
struct IOAudio *Audio_Device Block;
{

struct IOAudio *Lock;

Lock = (struct IOAudio *)GetDeviceBlock (AUDIO LEN);

Audio Copy (Audio_Device Block, Lock);
Lock->ioa_Request.io Command = (UWORD)ADCMD_LOCK;

SendIO (Lock):
return (Lock);
}

ADCMD_LOCK is a command that executes first when the allocated
channels are stolen. That means that as long as ADCMD_LOCK
executes, everything is OK. If you want to use your audio channels,
you should make sure you have access rights. The following routine
should help you:

/****************t*******ii**************tiiiii*****************

* Audio_Channel Stolen() (Audio_Support)*
* *
* Function: Was channel stolen? *
* *
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Input - Parameter:

Lock: Device-Block of the Lock, that should be tested.

TRUE: Channel was stolen => Exit progra

FALSE: Channel is under your control
***************************************************************/

* % % % ¥ ¥ X H*

*
*
*
*
* Return value:
*
*
*

BOOL Audio_Channel Stolen (Lock)
struct IOAudio *Lock;
{

if (CheckIO (Lock) != 0)
return (TRUE);
else

return (FALSE);
}

This short routine tests if the LOCK command has ended (CheckIO ()

1= 0) or if the access right consists of the allocated channels. You
may be wondering how you can output the data if you locked the audio
channels. The ADCMD_ LOCK command ends these channels when the
channels are stolen. Processing the two device commands with the
device block cannot be done at the same time.

A second device block must come into play. This is configured the
same as other device blocks, using GetDeviceBlock (). Then it
must ensure that you can also use the new device block. For this we
have developed a copy function that also copies the AllocKey that is
necessary for identifying the user of the audio device:

/*********************i*iii*iii*iiiiii******************tt******
* Audio_Copy () (Audio_Support) *
* Function: Device-Block copy *
*. *
* Input - Parameter: *
* Old Audio Block: Original *
* *

New_Audio Block: Copy
e T

VOID Audio_Copy (Old Audio Block, New_Audio Block)
struct IOAudio *Old Audio_Block,*New_Audio Block;
{
New_Audio Block->ioa Request.io Device =
0ld Audio_Block->ioa_Request.io Device;

New_Audio Block-d>ioa Request.io Unit =
Old_Audio Block->ioca Request.io_Unit;

New_Aiudio Block->ioca_AllocKey =
0ld Audio Block->ioca_AllocKey;

When you want to leave the program, you cannot simply exit and leave
the locked channels locked. In certain cases this would hinder every
other sound output, because only channel applications with a lower
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precedence are executed. To prevent this from happening you must
release the locked channels again, as shown in the following routine:

/***************************************************************

Audio Free() (Audio_Support)*
*

Function: Remove protection from channels

* % * % %

*

*

Input - Parameter: *
* *
*

* Lock: Device-Block of the freed lock
***************************************************************/

VOID Audio_Free (Lock)

struct IOAudio *Lock;

{
Lock->ioa_Request.io_Command = (UWORD)ADCMD FREE;
DoIO (Lock);

FreeDeviceBlock (Lock) ;
}

This routine frees the channels from your exclusive access and frees the
previously allocated device block. Another, less elegant option exists
for protecting channels from outside access: Set the precedence at 127.
You can do this during allocation, or using the ADCMD_SETPREC
command:

/*******t***********************t*******************************

* Audio_SetPrecedence () (Audio_ Support)*
* Function: Chaneg precedence *
* *
* Input - Parameter: *
* *
* Audio Device Block: Device-Block *
* *

Precedence: New precedence
***************************************************************,
VOID Audio_SetPrecedence (Audio_Device Block,Precedence)
struct ICAudio *Audio_Device Block;
BYTE Precedence;
{

Audio Device Block->ioa Request.io Message.mn Node.ln Pri
(BYTE) Precedence;

Audio Device Block->ioa Request.io Command =
(UWORD) ADCMD_SETPREC;
DoIO (Audio_Device Block);

}

Each call of ADCMD_SETPREC allows the check of ALLOCATE
commands whether or not the new precedence is less than the old
precedence. If this is the case, ALLOCATE can address the supplied
channels for you.

When setting the precedence at 127 (the highest precedence possible)
there is no chance for other ALLOCATE commands to get access to
your channels. This occurs because the precedence of the channels that
might steal them must be less than yours.
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You now have the software means of writing your own sound
programs. The following example is an example sound program.
Combine the Audio_Support routines to form the Audio_Support.c
file, don't forget the proper include files. Be careful of the order of the
routines since Audio_Lock calls Audio_Copy.

/iiiiii***i******************i********iii*ii**i***t************i

* SoundEditor.c *
* (c) Bruno Jennrich *
* August 1988 *

ii***********************************************ii*iii**t*i***/
/ii****ii*iii***ii**i**********i*ii********iiiiiiiii************

* Compile-Info: *
* cc SoundEditor *
* 1n SoundEditor.o Audio_Support.o Devs_Support.o -lc *

iii***********i********************************i**i*i********ii/

#include "exec/types.h"

#include "exec/memory.h"

#include "exec/devices.h"

#include “"intuition/intuition.h"
#include "intuition/intuitionbase.h"
#include "graphics/gfxbase.h®

#include "graphics/gfxmacros.h"
#include "devices/audio.h"

#define ScreenHeight 200L /* Editor-Screen */
#define ScreenWidth 3120L

#define ScreenDepth 2L

#define ScreenMiode OL

#define ERROR 100

#define AUDIO_LEN (ULONG) (sizeof (struct IOAudio))
VOID *OpenLibrary();

VOID *OpenScreen() ;

VOID *OpenWindow () ;

VOID *AllocMem();

VOID *GetDeviceBlock ()

VOID *Audio Lock();

struct Screen *Screen=01;

struct Window *Window=01;

struct NewScreen NewScreen;

struct NewWindow NewWindow;

struct GfxBase *GfxBase=01;
struct IntuitionBase *IntuitionBase=01;
/* Audio-Device relevant structures */
#define Left Channel 0 1

#define Right Channel 1 2

#define Right Channel 2 4

#define Left Channel 3 8

#define SoundPrecedence (BYTE) -40

struct IOAudio *lLeft Side =01,
*Right_Side =01,
*Left_Lock =01,
*Right_Lock =01;

BYTE *Waveleft = 01; /* Wave form definition (signed) */
BYTE *WaveRight = 01;
UBYTE Left_Channels(] {Left Channel 0, Left_Channel 3};
UBYTE Right_Channels[] = {Right_Channel 1, Right_Channel 2};
/* Channel Map */
/* allocate right and left */
/* channels *x/
#define CHANNELS LEFT (ULONG) sizeof ( Left_Channels)
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#define CHANNELS RIGHT (ULONG) sizeof (Right_Channels)

/* Mask size */
P T T T T T e T e Y

* CloseIt () (User) *
* Function: Close and free everything *
* *
* Input - Parameter: *
* String: Error-String *

L LY
VOID Closelt (String)

char *String;

{
UWORD 1i;
UWORD *dff180 = (UWORD *)Oxdff180;
UWORD Error;

if (strlen (String) > 0)
for (i=0;i<Oxffff;i++) *dffl180 = i;
puts (String);

if (Window != OL) CloseWindow (Window);

if (Screen != OL) CloseScreen (Screen);

if (GfxBase != OL) Closelibrary (GfxBase);

if (IntuitionBase != OL) CloseLibrary (IntuitionBase);
if (Left_Lock != OL) Audio Free (Left Lock);

if (Right_lLock != 0OL) Audio_Free (Right_Lock);

1f (Left_side != OL) Close A Device (Left Side);
if (Right_Side != 0L) FreeDeviceBlock (Right_Side);
if (Waveleft != OL) FreeMem (WavelLeft,

(ULONG) ScreenWidth) ;
if (WaveRight != OL)
FreeMem(WaveRight, (ULONG) ScreenWidth);

exit (10);
}

/***************************************************************

* InstallScreenWindow () (User) *
* Function: Editor Window and Screen initialization *
***************************************************************/

VOID InstallScreenWindow ()

{
NewScreen.LeftEdge = 0;
NewScreen.TopEdge = 0;
NewScreen.Width = ScreenWidth;
NewScreen.Height = ScreenHeight;
NewScreen.Depth = ScreenDepth;
NewScreen.DetailPen =1;
NewScreen.BlockPen = 0;
NewScreen.ViewModes = ScreenMode;
NewScreen. Type = CUSTOMSCREEN;
NewScreen.Font = (struct TextAttr *) 01;
NewScreen.DefaultTitle = (UBYTE *) " (c) Bruno Jennrich";
NewScreen.Gadgets = (struct Gadget *) 01;
NewScreen.CustomBitMap = (struct BitMap *) 01;
NewWindow.LeftEdge = 0;
NewWindow.TopEdge = 0;
NewWindow.Width = ScreenWidth;
NewWindow.Height = ScreenHeight;
NewWindow.DetailPen =1;
NewWindow.BlockPen =0;
NewWindow.IDCMPFlags = 0;
NewWindow.Flags = BORDERLESS | ACTIVATE | RMBTRAP |
NOCAREREFRESH;
NewWindow.FirstGadget = (struct Gadget *) 01;
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NewWindow.CheckMark = (struct Image *) 01;

NewWindow.Title = (UBYTE *) " Waveform-Editor";

NewWindow.Screen = (struct Screen *) 01;

NewWindow.BitMap = (struct BitMap *) 01;

NewWindow.MinWidth = 0;

NewWindow.MaxWidth = 0;

NewWindow.MinHeight = 0;

NewWindow.MaxHeight = 0;

NewWindow. Type = CUSTOMSCREEN;
}*************************************************************t*
* OpenScreenWindow () (User) *

* Function: Screen and Window open *

***************************************************************/
VOID OpenScreenWindow ()

{

InstallScreenWindow () ;

Screen = (struct Screen *) OpenScreen (&NewScreen);

if (Screen == 0l1) Closelt ("Couldn4t get Screen !");

NewWindow.Screen = Screen;

Window = (struct Window *) OpenWindow (&NewWindow);

if (Window == 0l1) Closelt ("Couldn4t get Window !");
}
/*****************ii*i*i*****i**********************************
* CloseScreenWindow () (User) *

* Function: Screen and Window close *

************i*****i***************i****i*i*********************/
VOID CloseScreenWindow ()
{

CloseWindow (Window);

CloseScreen (Screen);

/% dek sk sk ke kv sk ke e ek ke ok sk ok ok ok ok ok Ak ke ok ok ok ok ok ok ok ok ok ok Ak ok ok ek ok ok ok ok ok ok ok ok ke ok

* OpenLibs () (User) *
* Function: Open libraries ol
****i**********************i*i***********i******************i**/
VOID OpenLibs ()
{

GfxBase = (struct GfxBase *) OpenLibrary
("graphics.library",0l);

if (GfxBase == 01) Closelt ("Couldn4t get Grahpics !%);

IntuitionBase =

(struct IntuitionBase *) OpenLibrary

("intuition.library",01);

if (IntuitionBase == 0l1) Closelt ("Couldn4t get Intuition
'";
}
/**i************i**********************************ii*****iiii**
* CloseLibs () (User) *
* Function: Libraries close *
*************i******ii******************i**********i*****i**i**/
VOID CloseLibs ()
{

Closelibrary (GfxBase);

CloseLibrary (IntuitionBase);
}

/****ii****************************************i****************

* The_Audio_Device () (User) *

* Function: Use Audio-Device *
**ii***********ii************************************ii*i******/
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The_Audio_Device ()
{
UWORD i, J;
Open A Device ("audio.device",0L,&left_Side, OL,AUDIO_LEN);
Right_Side = (struct IOAudio*) GetDeviceBlock (AUDIO_LEN);
Audio Copy (Left_Side,Right_Side);
/* allocate channel */
if (Audio_Allocate (Right_Side,
Right_Channels,
CHANNELS RIGHT,
SoundPrecedence,
FALSE) == ADIOERR ALLOCFAILED)
CloseIt ("Couldn4t get Right-Channel !");
if (Audio Allocate (Left_ Side,
Left_Channels,
CHANNELS_LEFT,
SoundPrecedence,
FALSE) == ADIOERR ALLOCFAILED)
CloselIt ("Couldn4t get Left-Channel !");
/* secure channels before foreign access */
Left_Lock = Audio_Lock (Left_Side);
Right_Lock = Audio_Lock (Right_Side);
if (Right_Lock == 0l1) CloseIt ("Right_Lock failed !");
if (Left_Lock == 01) CloseIlt ("Left Lock failed !%);
/* No sound output */
Audio Pervol (Left Side, (UWORD)O, (UWORD)O);
Audio_Pervol (Right_Side, (UWORD) 0, (UWORD)0) ;
/* Begin data output */
Audio_Write (Left Side,Waveleft, ScreenWidth,
(UWORD) 0, (BOOL) TRUE);
Audio Write (Right_ Side,WaveRight, ScreenWidth,
(UWORD) 0, (BOOL) TRUE);
/* Increase volume */
Audio_Pervol (Right_Side, (UWORD) 1500, (UWORD) 64) ;
Audio_Pervol (Left_Side, (UWORD) 1500, (UWORD) 64) ;

/*******t****************t*t******************************t*****

* Close_Audio_Device() (User) *

* Function: Free channels and close Audio-Device *
*******************************i*******************************/

Close_Audio_Device ()

{

Audio_Free (Left Lock);

Audio_Free (Right_Lock);

Close A Device (Left_side);

FreeDeviceBlock (Right_side);
;**********************i****************************i********i**
* Edit () (User) *

* Function: Wave form editor *

********************************t****************t*ii****i*****/

Edit ()

{
WORD 1i;
ULONG x,y;

UBYTE *LeftMouse = (UBYTE *) Oxbfe001;
UWORD *RightMouse = (UWORD *) Oxdff016;
Move (Window->RPort, OL,ScreenHeight/2L);
Draw (Window->RPort, ScreenWidth, ScreenHeight/2L);
for (i=0;i<ScreenWidth; i++)
{
Waveleft [i] = 0;
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WaveRight [1] = 0;
}
SetDrMd (Window->RPort, (ULONG) COMPLEMENT) ;
The_Audio Device();
while ((*RightMouse & 0x0400) == 0x0400)

if (Audio_Channel_Stolen (Left Lock) ||
Audio_Channel_Stolen (Right_Lock))
CloseIt ("Channel stolen");
/* In case challels were stolen! */
if ((*LeftMouse & 0x40) == 0)
{
X = Screen->MouseX;
y = Screen->MouseY;
if (WaveLeft[x] != (ScreenHeight/2-y))
{
Move (Window->RPort, x,ScreenHeight/2);
Draw (Window->RPort, x, ScreenHeight /2-Waveleft [x]);
Waveleft [x] = (ScreenHeight/2-y);
WaveRight [x] = WaveLleft[x];
Move (Window->RPort, x, ScreenHeight/2);
Draw (Window->RPort, x, ScreenHeight /2-Waveleft [x]);

}
}
Close_Audio_Device();
}

/*******i****************************i**i***********************

* main() (User) *
R L T e ey
main()
{

Waveleft = (BYTE*) AllocMem (ScreenWidth, (ULONG)
MEMF CHIP|MEMF CLEAR);

WaveRight = (BYTE*) AllocMem (ScreenWidth, (ULONG)
MEMF_CHIP |MEMF_CLEAR);

if ((Waveleft == 01) || (WaveRight == 01))

CloseIt ("No Wave Buffer !%);

OpenLibs();

OpenScreenWindow () ;

Edit();

CloseScreenWindow () ;

CloseLibs();

FreeMem (WavelLeft, ScreenWidth);

FreeMem (WaveRight, ScreenWidth);

}

The next program presents a novel method of sound generation. For
example, if you want to continuously play a sound, you know that
your Amiga simply hasn't enough memory for playing 30 minutes of
sampled sounds. Let's say you need a constant stream of background
sound. You can play multiple samples repeatedly, using
CMD_WRITES. For example:

Audio_Write (/* Sound 1 */);
Audio_Write (/* Sound 2 */);
Audio_Write (/* Sound 3 */);
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This has a disadvantage: You can hear blips between the end of the
previous sound and the start of the next sound. This is because the
audio DMA channels pause long enough to look for the next file. This
can be heard in the form of noise between the end of the old
CMD_WRITE and the beginning of the new one.

You can create a double buffer for holding data. Double buffers are most
often used in graphic programming. When you employ the technique of
double buffering, these disturbing noises are no longer heard. The sound
output results in the following scheme:

Play start sound
Loop:
calculate new sound (or load this from diskette)
send write command for the new sound
wait until the end of the old sound
(here the new sound is played)
calculate another sound
send write command for another sound
wait for the old sound
repeat loop

Write commands and copies from the device blocks are listed internally
and processed according to the order. For this reason the CMD_WRITE
command does not break out for the same channels. Here's the double
buffer program:

/***************************************************************
Double.c
(¢) Bruno Jennrich
August 1988
Compile-Info:
cc Double

1n Double.o Audio Support.o Devs_Support.o -lc
***************************************************************/

* % % * A
* H * % o *

#include “exec/types.h"

#include "exec/memory.h"

#include "“exec/devices.h"

#include "devices/audio.h™

#define AUDIO LEN (ULONG) (sizeof (struct IOAudio})
VOID *OpenLibrary();

VOID *AllocMem();

VOID *GetDeviceBlock () ;

VOID *Audio Lock();

/* Audio-Device relevant structures */

#define Left Channel 0 1

#define Right Channel 1 2

#define Right Channel 2 4

#define Left Channel 3 8

#define SoundPrecedence (BYTE) -40
#define Wavelengthl 3201

#define WaveLength2 6001

struct IOAudio *FirstPlay =01,
*SecondPlay =01,
*FirstLock =01,
*SecondLock =01;
char *FirstWave = 01; /* Wave form definition (signed) */
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char *SecondWave = 01;

UBYTE Channels[] = {Left_Channel 0, Left_Channel 3};
/* Channel Map */
/* link */

/* allocate channel */
#define CHANNEL SIZE (ULONG) sizeof (Channels)

/* Mask size */
/***************************************************************

* Closelt () (User) *
* Function: Close and free everything *
* *
* Input - Parameter: *
* String: Error-String *

*********************************************i*****************/
VOID CloseIt (String)
char *String;
{

UWORD i;

UWORD *dff180 = (UWORD *)0xdff180;

UWORD Error;

if (strlen (String) > 0)

for (i=0;i<Oxffff;i++) *dffl180 = i;
puts (String);

if (FirstLock != 0) Audio Free (FirstLock);

if (SecondLock != 0) Audio _Free (SecondLock);

if (SecondPlay != OL) FreeDeviceBlock (SecondPlay);

if (FirstPlay != OL) Close A Device (FirstPlay);

if (FirstWave != 0) FreeMem (FirstWave,WaveLengthl);

if (Secondwave != 0) FreeMem (SecondWave,WaveLength2);

exit (10);
}
/*i*********************************ti**************************
* The_Audio Device() (User) *
* *
* Funktion: Use Audio-Device *

***************************************************************/
The_Audio_Device ()
{
UWORD i, j;
UBYTE *bfe001 = (UBYTE*) Oxbfe001;
FirstPlay = (struct IOAudio *) GetDeviceBlock (AUDIO_LEN);
SecondPlay = (struct IOAudio *) GetDeviceBlock (AUDIO LEN);
FirstPlay->ioa Data = (UBYTE *)Channels;
FirstPlay->ioa Length = CHANNEL SIZE;
FirstPlay->ioa_Request.io Message.mn Node.ln Pri =
SoundPrecedence;
Open A Device ("audio.device",0L,&FirstPlay,01,01);
Audio Copy (FirstPlay,SecondPlay);
FirstLock = Audio Lock (FirstPlay);
SecondLock = Audio_Lock (SecondPlay);
/* No sound output */
Audio_Pervol (FirstPlay, (UWORD)O, (UWORD)O);
for (i=0;i<WaveLengthl;i++)

FirstWave[i] = 0;
for (i=0;i<WaveLength2;i++)
SecondWave [i] =0;

Audio_Pervol (FirstPlay, (UWORD)1500, (UWORD) 64) ;
for (i=0;i<Wavelengthl;i+=2) FirstWave[i] = 128;
for (i=0;i<WaveLength2;i+=4) SecondWave[i] = 128;
/* Calculate FirstWave (already done ) */
Audio Write (FirstPlay,FirstWave, (ULONG) 320,
(UWORD) 1, (BOOL) TRUE);
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while ((*bfe00l & 0x40) == 0x40)

{
/* Calculate SecondWave (already done) */
Audio_Write (SecondPlay,SecondWave, (ULONG) Wavelength2,

(UWORD) 1, (BOOL) TRUE);
WaitIO (FirstPlay);
/* FirstWave new calculation (not already done here!) */
Audio Write (FirstPlay,FirstWave, (ULONG) WaveLengthl,
(UWORD) 1, (BOOL) TRUE);

WaitIO (SecondPlay);

}

Audio Free (FirstLock);

Audio Free (SecondLock);

FreeDeviceBlock (SecondPlay);

Close A Device (FirstPlay);

}

/***************************************************************
* main () (User) *
***************************************************************/
main()
{

FirstWave = (BYTE *) AllocMem
(WaveLengthl, (ULONG)MEMF_CHIP |MEMF_ CLEAR);

SecondWave = (BYTE *) AllocMem
(WaveLength2, (ULONG)MEMF_CHIP IMEMF_CLEAR) ;

if (FirstWave == 0) CloseIt ("No Memory for Wave 1 !");

if (SecondWave == 0) CloseIt ("No Memory for Wave 2 !");

The Audio_Device();

FreeMem (FirstWave,WavelLengthl);

FreeMem (SecondWave,Wavelength2);
}

The audio device uses commands other than those described above.
These are not especially important, and you may never need them.
We'll list the rest for the sake of completeness, though:

/***************************************************************

* Audio_Read({) (Audio_Support) *
* Function: Find out actual Write-Device-Block *
*. *
* Input - Parameter: *
* ReadRequest: Device-Block *
* Channel: Channel (0,1,2,3) whose Write-Block should *
* be found *
* *
* Return value: *
* Addressof the Device-Block, for the output of the given *
* *

channel or -1 if no CMD_WRITE is in operation
***************************************************************/

UBYTE *Audio_Read (Read Request,Channel)
struct IOAudio *Read_Request;

ULONG Channel;
{
Read_Request->ioa_Request.io Unit = (struct Unit ¥)
Channel;
printf ("io Unit $%1d\n",Read Request->ioca Request.io Unit):;
Read Request->ioa Request.io Flags = (UBYTE)

ADIOF_SYNCCYCLE;
Read Request->ioa_Request.io Command
DoIO (Read Request);
if (Read Request->ica Request.io Error != 0)

(UWORD) CMD_READ;
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return ((UBYTE*)Oxffffffff);
return (Read Request->ioa Data);

}

This function gives you the address of the audio device block. The
device block is necessary for sound output on a specific channel. The
bit belonging to the channel is given in the channel and passed to the
unit element of the audio device block. After CMD_READ, either the
address of the audio device block that propels a CMD_WRITE command
to the given channel or the value zero is in ioa_Data when the given
channel is not currently described.

The CMD_READ function determines the sound precedence of another
audio device user. This helps improve your odds of getting a channel.

ADCMD_WAITCYCLE

ADCMD_RESET

CMD_FLUSH

CMD_FINISH
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The above routine syncronized the execution of the command with the
end of the sound output using the SYNCCYCLE flag. We can also
perform this synchronization through an audio device command:

Do_Comand (Audio_Device Block, (UWORD) ADCMD WAITCYCLE);

This command first returns to the program when the played cycle ends.

This command resets the audio device to exit status:

Do_Command (Audio_Device Block, (UWORD) CMD_RESET);

The CMD_FLUSH command is executed, the sound interrupt vectors are
initialized again, and a previous CMD_STOP command is executed.

This command stops all current write requests and all of the listed
(double buffering) write requests:

Do_Command (Audio Device Block, (UWORD) CMD_FLUSH) ;

This command ends the sound output:

/***************************************************************

* Audio Finish() (Audio_Support) *
* Function: Stop sound output *
* *
* Input - Parameter: *
* Audio_Device Block: Device-Block, whose sound should be *
* stopped *
* Sync: Is end of sound schronized with end of *
* cycle *

********i*i****************************************************/
VOID Audio _Finish (Audio Device Block, Sync)
struct IOAudio *Audio Device Block;
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BOOL Sync;
{

Audio Device Block->ioa Request.io Command =
(UWORD) ADCMD FINISH;

if (Sync) Audio_Device Block~>ioa Request.io Flags |=
(UBYTE) ADIOF SYNCCYCLE;

else Audio Device Block->ioa Request.io Flags &=
(UBYTE) ~ADIOF SYNCCYCLE;

DoIO (Audio Device Block);
}

If you want to synchronize the interruption of the actual sound with the
end of the sound output, you must give the value TRUE as the Sync
parameter in Audio_Finish (). Now the SYNCCYCLE flag is set.
This flag is responsible for the synchronization. ADCMD_FINISH
ensures that the listed write requests are acquired for execution. That is
the difference between this command and CMD_FLUSH.

CMD_START and CMD_STOP

These commands stop (Do_Command (Audio_Device_Block,
(UWORD) CMD_STOP) and start (Do_Command (Audio_Device
_Block, (UWORD) CMD_STOP) sound output.

4.11.5

Sound in the interrupt code

The following audio device commands cannot be used in conjunction
with interrupt level 5 or higher:

ADCMD_FINISH
ADCMD_FREE (not used in the interrupt code!)
ADCMD_LOCK (not used in the interrupt code!)
ADCMD_PERVOL

ADCMD_SETPREC (not used in the interrupt code!)
ADCMD_WATITCYCLE

CMD_FLUSH

CMD_RESET

CMD_START

CMD_STOP

CMD_WRITE

This appears to be completely logical since the interrupts that announce
that the DMA is done with sound output lies on level 4. The interrupts
with higher CPU priorities should be reserved by the system.
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The narrator device

Now we come to a derivative of the audio device: the narrator device.
The narrator device makes it possible for you to access the speech
synthesizer of the Amiga. Unfortunately this synthesizer only speaks
one form of English. If you want to output sentences in different
accents or even foreign languages, the speech comes out in plain, media
English.

Through some tricks you can get the synthesizer to speak a somewhat
understandable accent, or even a foreign language. The synthesizer's
speech system is constructed of phoneme codes. This means that each
sound has a specific phoneme code (e.g., "a", "t"). By assembling these
codes in the correct order, words and sentences can be made.

Because literal translation of words into phonemes can become very
complicated, Commodore supplied the translator library which contains
the translate () routine as a single command. This routine
translates all of the English words in your phoneme codes.
Translate () can translate most of the words in the English
language. Because there are also some irregularities in the English
language, t ranslate () also uses its own table to convert words.

Translate () also govemns the different phonetics. Take the phrases
"the car” and "the others". The word "the" in "the car" ends with a short
E sound because the following word begins with a consonant. The word
"the" as it appears in "the others" ends with a long E sound because the
next word begins with a vowel. The phonemes are: DHAX CAA3R
(the car) and DHIY AH2DHERRZ (the others).

After the translator library opens (TranslatorBase =
Openlibrary ("translator.library", 0)),
translate () is called with the string to be spoken, the string's
length and the address of the memory region for the phoneme as well as
its length:

char *String; /* Ends with a null */

char Phoneme [1000];

#define LEN sizeof (Phoneme)

Error = Translate(String, strlen(String), Phoneme, LEN);

If enough memory exists for the phoneme, Error contains the value
zero. If Error is unequal to zero, the absolute value of the error
(Error is given with a minus sign) gives the location in the input
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string that can no longer be translated because of insufficient phoneme
memory. The example above could have made out this location using
String[-Error]. If we add this data, we can find the error:

Error = Translate (&String[-Error], strlen (&String[-Error]),
NewMemory, Length);

You can then output the phoneme string that was created from
Translate through the narrator device. For this you must open the
narrator device:

#define NARRAT RB LEN sizeof (struct narrator rb)

struct narrator_ rb *WriteRequest = OL;

Open_A Device("narrator.device", OL, &WriteRequest, OL,
NARRAT RB LEN);

The narrator device block (narrator_rb) has the following
structure:

Offset Structure
------------- struct narrator_rb
{/* defined in "devices/narrator.h" */

0 0x00 struct IOStdReq message; /* as always ! */
14 Ox0e UWORD rate; /* Words per minute */
16 0x10 UWORD pitch; /* basic frequency */
18 0x12 UWORD mode; /* human//robotics */
20 0x14 UWORD sex; /* sex */
22 0x16 UBYTE *ch_masks; /* Channel Allocation Map */
26 Oxla UWORD nm_masks; /* sizeof (ch_masks) */
28 Oxlc UWORD volume; /* volume */
30 Oxle UWORD sampfreq; /* Sampling Frequency */
32 0x20 UBYTE mouths; /* Mouth form Flag */
33 0x21 UBYTE chanmask; /* Which channel was */

/* actually used */
34 0x22 UBYTE numchan; /* how many masks? */
35 0x23 UBYTE pad; /* for even address */
36 0x24 }

The narrator device uses the above device block mainly for output. For
reading it uses another block:

Offset Structure
—————————————— struct mouth_rb
{/* defined in "devices/narrator.h" */

0 0x00 struct narrator_rb voice;

36 0x24 UBYTE width; /* Mouth width */
37 0x25 UBYTE height; /* Mouth height */
38 0x26 UBYTE shape; /* internal ! */
39 0x27 UBYTE pad; /* even address */
40 0x28 )

As you can see from the name of this structure (mouth) and the
comments, this structure reads the mouth form created through the
spoken word.
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Now we come to the narrator device commands themselves. The most
important command is CMD_WRITE. This command allows the

phoneme code to be output:

#define MOUTH_RB_LEN (ULONG) sizeof (struct mouth_rb)
/**********************************************************/
/* Narrator_Write() (Narrat_Support) */
/* */
/* Function: Narrator-QOutput */
/* */
/* WriteRequest: IO-Block, through twhich the speech */
/* output should be directed x/
/* string: string to be output *x/
/* rate: Words per minute (40-400) */
/* pitch: Basic tone pitch (65-320) */
/* mode: robot (1) or natural (0) x/
/* sex: Sex (0 man//1 female) */
/* Channels: Channel-Map *x/
/* Size: sizeof (Channel-Map) */
/* vol: Vloume (0-64) */
/* freq: Output frequency (5000-28000) */
/* mouths: Generate mouth form (1) */

/***************i******i***********************************/

VOID Narrator Write

(WriteRequest, string, rate, pitch, mode, sex,Channels, Size,vol, freq,
mouths)

struct narrator_rb

*WriteRequest;
char *string;
UWORD rate, pitch,mode, sex;
UBYTE *Channels;
UWORD Size,vol, freq, mouths;

{
struct mouth rb *ReadRequest;/* Request for mouth form */

UBYTE SpokenString[1000]; /* Phonetic memory */
ULONG Mouth Rout Count; /* how often was */
/* Mouth Routine() called */
WriteRequest->rate = rate;
WriteRequest->pitch = pitch;
WriteRequest~->mode = mode;
WriteRequest->sex = sex;
WriteRequest->ch masks = Channels;
WriteRequest->nm masks = Size;
WriteRequest->volume = vol;
WriteRequest->sampfreq = freq;
WriteRequest->mouths = mouths;

if (Translate (string, (ULONG) strlen
(string),SpokenString,1000L) != 0)
Closelt ("TranslateError");
/* phonetic English string */

WriteRequest—>message.io_Data

WriteRequest->message.io_Length
(SpokenString) ;

WriteRequest->message.io_Command

(APTR) SpokenString;
(ULONG) strlen

(UWORD) CMD_WRITE;

if (mouths == 1) /* for Mouth form generation */
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{
ReadRequest = (struct mouth rb *) GetDeviceBlock
(MOUTH_RB_LEN) ;
Narrator Copy (WriteRequest, ReadRequest);
/* Prepare ReadRequest */

Mouth_Init();: /* Mouth-Routine initialization */
ReadRequest->width = (UBYTE) 0;
ReadRequest->height = (UBYTE) 0;

ReadRequest->voice.message.io _Command = (UWORD) CMD_READ;
ReadRequest->voice.message.io Error = (UBYTE) 0;
/* Prepare Read command */

if (SendIO (WriteRequest) != 0) Closelt ("SpeakError");
/* send Write command */

Mouth Rout Count = 0; /* Mouth-Routine called 0 times */

while (ReadRequest->voice.message.io Error != ND_NoWrite)
{
DoIO (ReadRequest);
Mouth Routine (ReadRequest->width, ReadRequest-
>height,Mouth_Rout_Count);
/* as long as it can be read, it is read */
/* and Mouth Routine() is called */
Mouth Rout_Count++;
}

FreeDeviceBlock (ReadRequest);
Mouth Expunge () ;
/* End Mouth _Routine */
}
else DoIO (WriteRequest);
/* no mouth form generation */
} /* only speech output */

The routine joins the speech output (CMD_WRITE) with the discovery
of the mouth form (CMD_READ). Next the necessary parameters are set
in WriteRequest, and in the speech output requirement. Parameters
like Channels, Size and Vol are self-explanatory, or were described
in Section 4.11. We'll look at the other parameters used in this routine.

The first parameter to be given from NarratorWrite () is the
narrator device block (for the writing or for the speech output)
initialized from Open_A_Device (). The string that should be
output follows in letters (not in phonemes).

Rate represents the number of words per minute output. The larger
rate is, the faster the words are spoken. Values for rate can range
from 40 to 400.

The pitch parameter represents the pitch at which the Amiga should
speak. Values for pitch range from 65 to 320.

A